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EXTRACTO 

 

Este trabajo describe las etapas y metodologías relacionadas al estudio e identificación 

de zonas inestables, ya que su ocurrencia en diversas situaciones puede generar un alto 

riesgo en las vidas humanas así como la falla de estructuras en obras civiles. 

 Se realiza una aplicación del programa Gslope, para evaluar las condiciones 

actuales y condiciones modificadas de los sitios inestables en sector de Guzho y en el la 

carretera Plan de Milagro - Indanza – Gualaquiza. 

 Para evaluar las condiciones de los sitios inestables se realizo la identificación 

de las propiedades índice mecánicas de los suelos, tales como densidad del material y 

resistencia al corte, para posteriormente analizar estos parámetros en la geometría de los 

perfiles del talud con sus condiciones hidrogeológicas (superficie piezométrica) y 

modelados en el programa Gslope. 

 En estas condiciones, haciendo uso de los resultados iniciales, se realiza una 

búsqueda del círculo de deslizamiento crítico y en función de las mismas, se adopta las 

soluciones para su estabilización.  

   

ABSTRACT 

 

This job describes steps and methodologists related to the studies and identification of 

the instable areas, because it’s events in different situations could generate a high risk 

on the human lives also finding mistakes on the structures from the civil building work. 

 We make and application from the program Gslope, to evaluate the actual 

conditions that have been modify from the instable sectors of the Guzho area and on the     

plan de Milagro- Indanza- Gualaquiza highway.  

 To evaluate the conditions from the instable areas, we made and identification of 

the index mechanic properties of the ground, which were density of the material and cut 

resistant, so after that analyze these parameters on the profile geometries of the slope 

with it’s hydrogeology conditions ( physometric surface ) and modeled on the Gslope 

program. 

  On these conditions using the first results, we do a finding of the circle of slide 

review and in the same functions we take the solutions for its stabilization. 
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CAPÍTULO I 

 

GENERALIDADES 

 

1.1 ANTECEDENTES 

 

Cuando se producen corrimientos inesperados en los taludes y vertientes naturales, los efectos que se 

producen son importantes, involucrando en mucho de los casos pérdidas de vidas humanas. 

 

A nivel mundial, en cuanto a daños se refiere, proviene de fenómenos individualizados, conocidos por la 

elevada magnitud de sus consecuencias, así por ejemplo el deslizamiento mas desastroso acontecido en la 

historia europea es el producido en el embalse de Vaiont, en 1963, que provocó una ola de agua. Esta ola 

sobrepasó la presa, y destruyó aguas abajo cinco poblaciones, provocando la muerte de entre 2000 y 3000 

personas. 

 

En nuestro país existen datos sistematizados a este respecto. No obstante no es extraño ver 

ocasionalmente noticias en los periódicos dando cuenta de fallecimientos como consecuencia de 

movimientos de tierra, desprendimientos, etc., fundamentalmente durante el período de construcción de 

las obras y épocas de invierno. 

 

Nuestro país, debido a la geología, se encuentra afectado por este tipo de movimientos de taludes, 

representando cifras de dinero importantes que se ven involucradas en tales eventos, uno de ellos es la red 

vial existente. Es importante notar la existencia de muchos sitios críticos para estabilización, 

encontrándose desprendimiento del material hacia la calzada, presencia de agua en el talud y pérdida 

parcial de la mesa de la vía.   

 

Por esta razón, muchos sitios localizados en las carreteras, presentan condiciones precarias de estabilidad 

y tienen el potencial para inducir a una obstrucción en la vía durante la época invernal.  
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Zonas donde existen sitios críticos de inestabilidad es parte directa de los trabajos de reconstrucción. Para 

el efecto se realiza el diseño de las obras de estabilización de estos sitios.     

 

CASOS HISTÓRICOS 

 

 

Nueva Vía Oriental de Quito: 

Resultado: Deslizamiento de talud, daños en la vía y pérdida de vidas humanas. 

Laderas del Pichincha: 

Resultado: Deslizamiento del talud, daños considerables en  viviendas cimentadas. 

Zona de Cuenca, deslizamientos grandes en Turi, Viola, Gapal, Cañaro, la Josefina y Guasuntos. 

Condiciones generales: Movimientos Traslacional y Rotacional de la masa de suelo. 

 

 

1.2 OBJETIVOS DEL ESTUDIO 

 

1.2.1  Objetivo general 

 

Analizar la estabilidad estructural de taludes y su aplicación práctica, mediante el uso del 

programa GSLOPE.  

 

1.2.2 Objetivos específicos 

 

Analizar la estabilidad global de los taludes a fin de conocer el factor de seguridad al deslizamiento en los 

sitios de inestabilidad.  

 

Analizar la estabilidad global de los taludes bajo condiciones modificadas, mediante modelos que 

permitan mejorar sus características ante el deslizamiento, empleando  correcciones  en la geometría 

del talud (bermas, abatimiento del nivel freático y suelos reforzados con geosintéticos).  

 

Determinar los parámetros residuales de corte en taludes y laderas fallados.       Proponer de obras 

de protección a fin de garantizar la estabilidad de los taludes. 
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1.3 IMPORTANCIA DEL PROYECTO 

 

El presente proyecto pretende  introducir una metodología aplicada al estudio de estabilidad estructural de 

taludes, seleccionando el método de análisis y cálculo más apropiado, por medio de una herramienta 

computacional para un diseño racional de las obras de sostenimiento y taludes que garanticen la estabilidad de 

las obras con el carácter de permanente o a largo plazo, preservando el medio ambiente, minimizando el 

potencial de riesgo y precautelando la integridad de las personas y de sus bienes. 

 

En la actualidad se cuenta con herramientas de análisis, con experiencias y conocimiento del comportamiento 

geomecánico de los suelos, con técnicas de construcción y mejoramiento del terreno, las cuales permiten 

considerar los elementos antes mencionados en la modelo de análisis del talud y de las obras a implementar 

en la estabilización de las mismas, siendo frecuentemente utilizadas en nuestro medio.  

 

Los deslizamientos constituyen uno de los riegos potenciales de gran incidencia en el país y las perdidas 

ocurridas en el pasado y las que podrían ocurrir en el futuro, son invalorables. 

 

 

1.4 JUSTIFICACIÓN DEL PROYECTO 

 

El alto riesgo de ocurrencia de movimientos de masa o deslizamientos en zonas en las cuales su relieve 

geográfico son identificadas como de alta pendiente, muy comunes en la Región Andina, requiere el 

desarrollo de programas de prevención. 

 

La imprevisión en la ejecución de los estudios necesarios para garantizar la estabilidad de las obras de 

contención y taludes, sumando a la no aceptación de las recomendaciones hechas en dichos estudios, han 

traído como consecuencia la falla de estas estructuras con las pérdidas de vidas humanas y materiales. 

 

Los problemas de inestabilidad de taludes a lo largo de la red vial de nuestro país son numerosos.  Hay 

varias causas fundamentales para los problemas de estabilidad de taludes, entre estas causas se pueden 

enumerar: (1) la presencia de taludes en corte demasiado empinados para la cohesión o ángulo de reposo 
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de los materiales que los componen; (2) la falta de implementación de medidas de estabilización durante 

la construcción de la vía; (3) pérdida de la capa superficial de vegetación durante construcción;  (4) 

existencia de zonas de roca altamente meteorizada y de zonas de materiales coluviales históricamente 

inestables; y (5) erosión progresiva desde la parte inferior de estructuras de drenaje hacia la mesa de la 

vía.   

 

Uno de ellos recientemente ocasionado es el deslizamiento ocurrido en la autopista Cuenca – Azogues 

(Marzo 2005) importante eje vial del Austro ecuatoriano en la cual desde su construcción ha 

experimentado serios problemas de inestabilidad en el sector de Nulti, mismos que han ocasionado en 

varias oportunidades la interrupción de la vía y daños en obras de arte mayor (Puente). 

 

Lamentablemente, en la ejecución de las obras de estabilización sucedió un corrimiento inesperado en la 

parte alta del talud, destruyendo la capa de protección de hormigón lanzado del talud, actualmente existe 

la controversia entre el constructor y el consultor ya que se evidencio que la zona activa no se encontraba 

donde  se realizó los estudios, diseños y correcciones.  

 

Su verdadera importancia y alcance sólo se adquiere y conoce mediante la experiencia. En la medida en 

que son las experiencias propias y ajenas (así como los fracasos propios y ajenos) las que más enseñanzas 

transmiten. 

 

Este tipo de conocimientos son los que se pretende transmitir con este proyecto de tesis, en la idea  de 

ofrecer, un instrumento de trabajo fundamentalmente práctico. 

 

 

 
 

CAPÍTULO II 

 

NOCIONES SOBRE ESTABILIDAD 

ESTRUCTURAL DE TALUDES 

 



Generalidades                                                                             ESPE – Carrera de Ingeniería Civil - 2007 

- 17 - 

2.1 INTRODUCCIÓN 

Este capítulo trata de la identificación de los tipos y causas de deslizamientos en laderas, de los conceptos 

de seguridad y de las principales técnicas de análisis de la estabilidad de taludes.  

 

La estabilidad de obras de ingeniería es definida usualmente en términos determinísticos, a través de un 

factor de seguridad (FS). La elección del método de análisis más adecuado es un aspecto relevante a ser 

considerado, siendo función tanto de la importancia de la obra cuanto de la calidad de los datos 

disponibles. En casos de taludes naturales, el análisis de la estabilidad puede hacer uso también de 

técnicas probabilísticas, considerando que la elección de los parámetros más relevantes está 

inevitablemente sujeta a incertidumbres. Así, el cálculo de la seguridad de un talud incluye errores y /o 

imprecisiones que son relativos no sólo a los parámetros relevantes al problema, pero también al método 

de análisis adoptado. 

 

2.2 OBJETIVOS 

 

El principal objetivo del análisis de estabilidad es verificar la condición de seguridad de un talud existente 

y la eventual necesidad de medidas preventivas o correctivas, tales como obras de contención. En el caso 

de taludes en proyecto, los análisis de estabilidad permiten definir la geometría más adecuada o 

económica para garantizar un nivel mínimo de seguridad, bajo las diferentes condiciones de solicitaciones 

naturales (ejm: lluvia, vegetación) o resultantes de la acción del hombre (ejm: sobrecarga, excavación, 

drenaje). Estudios de estabilidad de laderas pueden, por lo tanto, envolver análisis paramétricos de 

taludes, verificándose la sensibilidad del factor FS para variaciones impuestas a los parámetros 

geométricos y geotécnicos del problema. 

 

También, se puede retroanalisar deslizamientos ya ocurridos, de modo de obtenerse informaciones sobre 

los mecanismos de ruptura y calibración de los parámetros geotécnicos relevantes al estudio. En un 

retroanálisis de ruptura, se sabe que FS = 1,0 y se consideran las condiciones originales de geometría y 

presión de poros, determinándose los parámetros medios de resistencia del material. Encontraste, en los 

análisis usuales de estabilidad, los parámetros de resistencia son normalmente estipulados con 

conservadurismo, de forma a estimarse el valor del factor FS mínimo existente. 
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2.3 CLASIFICACIÓN DE LOS DESLIZAMIENTOS 

 

Las tablas siguientes presentan clasificaciones de deslizamientos según la forma o tipo de movimiento 

(Tabla No.2.1), en cuanto a las condiciones de hundimiento del suelo (Tabla No. 2.2) o en cuanto a las 

condiciones de presión de poros (Tabla No.2.3). 

 

Tabla No.2.1 Clasificación de los deslizamientos de acuerdo al tipo de movimiento. 

 

1- Desprendimientos (falls): resultantes de la acción de la gravedad, ocurren con velocidades 

elevadas. 

 

2- Vuelcos (toppling): rotación con basculamiento de placas de material rocoso; causado por 

la acción de la gravedad o presión de poros en fisuras. 

 

 
3- Deslizamientos (slides): 

movimientos con superficies 

de ruptura bien definidas. 
 

 

 

3.1- Rotacionales: en general 
ocurren con materiales 

homogéneos; la masa 

inestable es considerada 
rígida. 

 

3.1.1- Simples: una 
superficie de ruptura, plana o 

profunda. 

 

3.1.2- Sucesivos: más de una 

superficie de ruptura; pueden 

ser progresivos o 

retrogresivos. 
 

3.2- Traslacionales: Superficie de ruptura plana, relacionada 

con zonas de discontinuidades (fallos, contacto suelo/roca, 
estratificación); movimiento continuo. 

 

3.3- Compuestas: ocurren en taludes naturales de suelos no 

homogéneos, con superficies de ruptura no lineales. 
 

 

4- Coladas (flows): 

movimientos continuos de 
suelos, rocas y /o detritos con 

zona de ruptura bien definida; 

material con comportamiento 
viscoso.   

 

 

4.1- Lentos (creep): también 

denominados fluencia, ocurre 

en materiales con 
comportamiento plástico; 

movimientos continuos sin 

superficie de ruptura definida, 
bajo tensiones totales 

constantes. 

 

4.1.1- Plano: profundidad de 

la masa en movimiento 

inferior a 5m. 

4.1.2- Profundos: 

profundidad de la masa en 

movimiento superior a 5m. 

4.1.3- Progresivos: 

movimientos con aceleración 

gradual con el tiempo 
4.1.4- Pos-ruptura: la masa 

permanece en movimiento 

después del deslizamiento; 

movimientos usuales en taludes 

y materiales coluviales.  

4.2- Rápidos (corridas): en 
forma de lengua con 

prolongamiento en la base; 

usuales en taludes suaves; 

4.2.1- Corridas de tierra 
(flow slides): colapso de 

estructuras blandas de suelos 

arenosos y siltosos, con 
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material con comportamiento 

de fluido poco viscoso y bajo 

condiciones no drenadas. 

aumento de presión de poros 

debido a vibraciones o 

saturación. 

4.2.2- Corridas de barro 

(mudflow): movimientos 

rápidos en suelos blandos 
sensibles. 

4.2.3- Corrida de detritos 

(debris flow): avalanchas de 
grandes volúmenes de masas 

de bloques de roca, suelos y 

detritos vegetales 

5- Complejos: envuelven 
varios tipos de movimientos; 

comunes en laderas 

inclinadas 
 

  

 

 

Tabla No. 2.2. Clasificación de los deslizamientos de acuerdo a alas condiciones de deformación. 
 

Deslizamientos 

vírgenes 

Ocurren en general en material indeformado, con parámetros de 

resistencia asociados a la condición de pico de la curva tensión-

deformación. 

Deslizamientos 

reactivados 

Ocurren con material abollado, en superficies pre-existentes, que 

sufrieron deslizamientos anteriores. La resistencia del material tiende 

para la condición residual. 

 

 

 

Tabla No. 2.3. Clasificación de los deslizamientos de acuerdo a las condiciones de presión de poros. 
 

Condiciones drenadas 

(largo plazo) 

Presión de poros asociada a flujo permanente en el material. 

Disipación total de las presiones de poros generadas por el 

cizallamiento. 

Condiciones parcialmente drenadas 

(plazo intermedio) 

Parte de la presión de poros generada por el cizallamiento es 

disipada. 

Condiciones no drenadas 

(corto plazo) 

Materiales con bajo valor de coeficiente de consolidación Cv. 

Generación de excesos de presión de poros asociados al 

cizallamiento del material. 

 

 

2.4 CAUSAS DE LOS DESLIZAMIENTOS 

 

Los deslizamientos o los movimientos de un talud son inducidos por factores que contribuyen para el 

aumento de la solicitud (tensiones cizallantes) o para la reducción de la resistencia del macizo. En el 

primer caso, el aumento de las tensiones cizallantes es en general debido a: sobrecarga en el tope 

(terraplenes), alivianamiento en la base (cortes o erosiones), vibraciones (terremotos, máquinas), 
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remoción de soporte de subsuperfície (erosión por piping, cavernas etc.). En el segundo caso, los factores 

más comunes para la reducción de la resistencia son: intemperismo físico-químico de los minerales, 

modificaciones estructurales (fisuración, deformación), aumento de la presión de poros (en los vacíos de 

suelos o en fisuras de rocas). 

 

2.5 TIPOS DE ANÁLISIS DE ESTABILIDAD 

 

Existen dos formas de conducir un análisis de estabilidad de taludes. La primera es en términos de 

tensiones totales, correspondiendo las situaciones de corto plazo (final de construcción), en suelos 

saturados, bajo condiciones no drenadas. La segunda es en términos de tensiones efectivas, pudiendo 

corresponder las situaciones de largo plazo (condiciones drenadas) o de corto plazo (condiciones no 

drenadas).  

 

En el caso de estabilidad de laderas, se recomienda la realización de análisis en términos de tensiones 

efectivas, con criterios de evaluación de las condiciones de presión de poros. En particular, débase atentar 

para el nivel freático a ser alcanzado cuando ocurra la lluvia máxima prevista en proyecto. 

 

2.6 DEFINICIÓN DEL FACTOR DE SEGURIDAD (FS) 

 

Existen varias definiciones posibles para el factor de seguridad, cada una pudiendo implicar valores 

diferentes de FS. Las definiciones más usuales de FS en análisis de estabilidad de taludes son: 

 

(a) Factor de guarda jurado relativo al equilibrio de momentos: aplicado usualmente en análisis de 

movimientos rotacionales, considerándose superficie de ruptura circular, 

 

,
a

r

M

M
FS   

 

Donde Mr es la sumatoria de momentos de las fuerzas resistentes y Ma es la sumatoria de momentos de 

las fuerzas activas (o solicitantes). 

 

(b) Factor de guarda jurado relativo al equilibrio de fuerzas: aplicado en análisis de movimientos 
traslacionales o rotacionales, considerándose superficies planas o poligonales, 
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a

r

F

F
FS   

 

Donde Fr es la sumatoria de fuerzas resistentes y Fa es la sumatoria de fuerzas activas. 

 

Con estas definiciones, se considera que un talud es inestable para valores de FS inferiores a la unidad. 

Sin embargo, casos con taludes inestables y FS > 1,0 no son raros en la práctica de la ingeniería debido a 

las simplificaciones de los principales métodos de análisis y a la variabilidad de los parámetros 

geotécnicos y geométricos envueltos en los análisis. La definición del valor admisible para el factor de 

seguridad (FSadm) va a depender, entre otros factores, de las consecuencias de una eventual ruptura, en 

términos de pérdidas humanas y /o económicas.  

 

La Tabla II.4 presenta una recomendación para valores de FSadm  y los costos de construcción para 

elevados factores de seguridad. Se debe resaltar que el valor de FSadm debe considerar no solamente las 

condiciones actuales del talud, pero también el uso futuro del área, preservándose el talud contra cortes en 

la base, deforestación, sobrecargas e infiltración excesiva.  

 

Para taludes temporales, el valor de FSadm debe ser el mismo recomendado en la Tabla II.4, 

considerándose, aún, las solicitudes previstas para el periodo de construcción.  

 

Para deslizamientos inminentes o pre-existentes, la definición de las medidas de remediación más 

adecuadas es función de la historia del deslizamiento. Son necesarias investigaciones geológicas y 

geotécnicas detalladas (reconocimiento del subsuelo, datos pluviométricos locales, datos de seguimientos 

del área etc.) para la identificación de la historia del deslizamiento. La Tabla II.5 sugiere valores de 

FSadm para estos casos. 

 

En los casos en que la definición de los parámetros de resistencia del suelo es imprecisa, es usual la 

adopción de un factor de reducción directamente aplicado a los parámetros de resistencia al lo largo de la 

superficie de ruptura: 

 

i - en términos de tensiones efectivas:  

21

'
'

'

F

tg

F

c
N


   
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ii - en términos de tensiones totales:  

3F

Su  

 

Donde c’ y  ’ son los parámetros efectivos de resistencia, Su es la resistencia no drenada (suelos 

arcillosos saturados) y F1, F2, y F3 son los factores de reducción. Estos factores dependen de la calidad de 

las estimativas de los parámetros de resistencia y pueden variar entre 1,0 y 1,5. 

 

Tabla II.4. Recomendaciones para factores de seguridad admisiblesModificado de GEO, 1984) 

 

FSadm 
 

Riesgo de perdidas de vidas humanas  

  despreciable  medio  elevado  

R
ie

sg
o
 d

e 
p
er

d
id

as
 e

co
n
ó
m

ic
as

 

d
es

p
re

ci
ab

le
  

1,1  1,2  1,4  

m
ed

io
  

1,2  1,3  1,4  

el
ev

ad
o
  

1,4  1,4  1,5  

i) Factores de seguridad para un tiempo de recurrencia de 10 

años.  

ii) Para condiciones de riesgos elevados y subsuelo blando, el 

valor admisible de FS puede ser mayorado en hasta un 10%   

 
 

 

Tabla II.5. Factores de seguridad recomendados para remediación de deslizamientos existentes GEO, 

1984 

 

Riesgo de perdidas de vidas humanas 

despreciable medio elevado 

FS > 1,1 FS > 1,2 FS > 1,3 

Obs.: Factores de seguridad para un tiempo de recurrencia de 10 años. 
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2.7 TECNICAS DE ANÁLISIS 

 

Las técnicas de análisis son divididas en dos categorías: métodos determinísticos, los cuáles la medida de 

la seguridad del talud es hecha en términos de un factor de seguridad; y métodos probabilísticos, en que la 

medida de seguridad es hecha en términos de la probabilidad o del riesgo de ocurrencia de la ruptura. 

 

2.7.1 MÉTODOS DETERMINÍSTICOS 

 

2.7.1.1  Equilibrio Límite 

 

En este tipo de análisis, están incorporadas las siguientes hipótesis: la superficie potencial de falla es 

previamente conocida o arbitraria; la masa de suelo se encuentra en condiciones inminentes de ruptura 

generalizada (es decir, equilibrio límite); el criterio de ruptura de Mohr-Coulomb es satisfecho al lo largo 

de toda la superficie de ruptura; y el factor de seguridad es único al lo largo de la superficie potencial de 

ruptura. Una revisión crítica de los principales métodos de análisis por equilibrio límite fue presentada 

por Whitman y Bailey (1967). Estos métodos pueden ser divididos en dos grupos principales: 

 

(a) Métodos de las tajadas: la masa inestable de suelo es dividida en tajadas verticales, pudiendo la 

superficie potencial de falla ser circular o poligonal. Ejemplos de métodos con superficie circular: 

Fellenius (1936), Taylor (1949) y Bishop (1955). Ejemplos con superficie cualquiera: Janbu (1973), 

Morgenstern y Price (1965) y Spencer (1967); 

 

(b) Métodos de las cuñas: emplean la técnica de dividir el material en cuñas con inclinaciones variables 

en las interfaces y superficie de ruptura poligonal. Ejemplos: métodos de Sultany Seed (1967), Martins et 

al. (1979), Kovari y Fritz (1978) y Sarma (1979). 

 

En el caso de laderas naturales, el mecanismo de ruptura es controlado por las características geológicas 

del material. Tratándose de rocas alteradas de origen granito-gnáissica, los fallos, juntas y /o superficies 

de estratificación son dominantes para la imposición de rupturas según superficies planas o poligonales. 
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El mismo se da cuando la capa superficial de suelo es poco espesa, favoreciendo la ocurrencia de la 

ruptura a lo largo de la superficie de contacto suelo-roca. En el caso de taludes en colúvios o en suelos 

residuales maduros de gran espesor, las características estructurales del material son en general poco 

relevantes, siendo las rupturas usualmente inducidas a lo largo de superficies circulares. 

 

En el caso del deslizamiento de un talud, la resistencia disponible depende de la distribución de las 

tensiones normales (σ) a lo largo de la superficie de ruptura. La influencia sobre el valor de FS de las 

varias hipótesis de distribuciones de σ fue estudiada en detalle por Frölich (1955), que sugirió la 

existencia de un límite inferior y de un límite superior para los valores posibles de FS. Si se usa el 

teorema del límite inferior, se observan las ecuaciones de equilibrio y el criterio de ruptura, siendo las 

condiciones de contorno especificadas en términos de tensiones. El análisis basado en el límite inferior 

puede definir un campo de tensiones admisibles no realista. En el caso del teorema del límite superior, 

débase considerar las ecuaciones de compatibilidad del problema, siendo las condiciones de contorno 

especificadas en términos de desplazamientos y admitiéndose que el trabajo externo sea igual a la 

disipación de energía interna. El análisis basado en el límite superior puede definir de forma incorrecta el 

mecanismo de ruptura. Hoek y Bray (1981) sugieren que la solución por el límite inferior suministra un 

valor de FS situado bien próximo al valor real. Taylor (1948), usando el método del círculo de roce, 

concluyó también que la solución por límite inferior es suficientemente precisa para problemas prácticos 

envolviendo ruptura circular en taludes homogéneos. 

 

La Tabla II.6 presenta un resumen de los principales métodos de equilibrio límite normalmente usados  en 

la práctica de la ingeniería para análisis de la estabilidad de taludes. 

 

Análisis de estabilidad pueden ser realizadas de manera simple y rápida con el auxilio de ábacos y 

gráficos, siendo particularmente útiles para fases preliminares de proyecto o para evaluaciones 

paramétricas. Por cuestión de simplicidad, los ábacos son usualmente producidos para taludes 

homogéneos con inclinación superficial constante. En el caso de un talud con más de una capa de suelo, 

valores medios de los parámetros geotécnicos deben ser estimados, conociéndose la posición aproximada 

de la superficie crítica de ruptura. 
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Ábacos de HOEK & BRAY 

 

Una serie de ábacos para obtener el valor de FS en taludes, considerándose varias posiciones posibles para un 

nivel de agua, es presentada en las Figuras 2.3 a  2.7 (Hoek e Bray, 1981). En estos ábacos la superficie crítica  

es considerada circular, pasando por el pie del talud, con una grieta de tracción existente en su extremidad 

superior. Fueron consideradas cinco situaciones distintas de línea freática, definidas geométricamente por la 

razón Lw / H, donde H es la altura del talud y  Lw es la distancia entre el pie del talud  y el punto donde la línea 

freática alcanza la superficie del terreno. La situación correspondiente a un suelo saturado (Figura 2.7) es mas 

desfavorable para la estabilidad, pues admite una ocurrencia típica de lluvia intensa, con flujo de agua 

paralelo a la cara del talud.   

 

Ejemplo. 

 

Este ejemplo ilustra la utilización de los ábacos de Hoek y Bray (1981) presentados en este capítulo. Sea un 

talud a analizar con 15 m de altura e inclinación de 60 grados, conforme indica en la Figura 2.1. Los 

parámetros de resistencia adoptados en este ejemplo son: c’ = 20 kpa y  ’ = 30 grados. El peso específico del 

material es 18 kN/m3, arriba o abajo del nivel del agua, o igual a lo representado en la Figura 2.2. Este caso 

corresponde a la Figura 2.4.  

 

 
Figura No. 2.1. Ejemplo de análisis de estabilidad. 

Un análisis de estabilidad consta de los siguientes pasos: 
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1. Seleccionar un ábaco que más se adopte al caso de la línea freática en la ladera; en este caso, es un 

ábaco de la Figura 2.4. 

2. Figura ábaco de la figura 2.4 (línea freática con Lw = 8H). 

 

3. Calcular un valor de la siguiente razón adimensional:  

 

13.0
30tan1518

20

tan





H

c
 

 

 

4. Entrar al ábaco seleccionado (Figura 2.4) con un valor arriba de la línea radial, determinándose un 

punto que corresponde al talud con β = 60 grados. Obteniéndose: 

 

58.0
tan


FS


 ; FS = 1.00 

 

 

5.  El valor encontrado para un FS es muy bajo. En este caso, será verificada una solución de 

estabilización por abatimiento, suavizando la inclinación del talud (Figura 2.2). 

 

6. Entrando nuevamente al ábaco, con valores del ángulo β del talud, obtenemos: 

 

Talud con β = 45 grados: 

52.0
tan


FS


; FS =  1.11 

 

Talud con β = 40 grados: 

 

44.0
tan


FS


; FS = 1.31 

 

 

7. Entonces adoptamos un talud de 40 grados de inclinación media, implantándose una berma a media 

altura para facilitar el drenaje y mantenimiento (Figura 2.2)     
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Figura No. 2.2. Ejemplo de solución de abatimiento de la pendiente  para estabilización de taludes. 

 

 
 

Figura No. 2.3. Ábaco de estabilidad de Hoek y Bray (1981): línea freática profunda. 
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Figura No. 2.4. Ábaco de estabilidad de Hoek y Bray (1981): línea freática con Lw = 8H. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Generalidades                                                                             ESPE – Carrera de Ingeniería Civil - 2007 

- 29 - 

 
 

Figura No. 2.5. Ábaco de estabilidad de Hoek y Bray (1981): línea freática con Lw = 4H. 
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Figura No. 2.6. Ábaco de estabilidad de Hoek y Bray (1981): línea freática con Lw = 2H. 
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Figura No. 2.7. Ábaco de estabilidad de Hoek y Bray (1981): suelo saturado. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Método de BISHOP 
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El método de BISHOP supone la superficie de deslizamiento circular.  

 

Bishop (1955) presentó un método utilizando Dovelas y teniendo en cuenta el efecto de las fuerzas entre 

las Dovelas. 

 

Supone la masa deslizante dividida en n fajas verticales. En la Figura 2.8 se presentan las fuerzas actuantes 

sobre la faja i.  
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Figura No. 2.8. Dovela interior y polígono de fuerzas. 

 

 

El Esfuerzo Normal en una superficie de falla esta dada por la expresión: 

 



N
  
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El Esfuerzo de Corte “s” en la superficie de falla esta dado por: 

 

 

    tan
1

uc
F

s  

 

 

Substituyendo por  se tiene: 
 

 


















 tan

1
u

N
c

F
s


 

 

 

La Fuerza de Corte esta dada por: 

 

 

 sS  

 

 

Tomar los momentos en punto O. Considerar W y las fuerzas actuando en la superficie de falla. 

 

 

+ 
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Substituyendo por s 

 

 

Ru
N

c
F

xW 
















  tan




 

 

    tan uNc
F

R
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



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R
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N = uN  
 

 





 tanNc
xW

R
F              (1-1) 

 

 

Sumar las fuerzas en dirección vertical. Referido al polígono de fuerzas de la figura 2.8.   

  0
o

M
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             (1-2) 

 

 

Sustituir la ecuación (1-2) en la ecuación (1-1) 
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En el segundo elemento de la sumatoria dividir el numerador y denominador  por  cos  
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La Ecuación (1-3) es usada para el cálculo del factor de seguridad F. El procedimiento usando la ecuación (1-3) 

es asumir una superficie de falla con un centro de rotación O. La cuña de falla esta dividida en varias dovelas 

verticales. 

 

Los parámetros siguientes son determinados para cada dovela: b,, W, c,  y u. 

 

= Angulo del radio y la vertical en cada dovela 

W = Peso total de cada dovela. 

 

u = Presión de poros en la base de cada dovela = w x hw 

 

w  Peso específico del agua 

 

wh = Altura de la napa de agua o nivel freático (N.F) 

 

b = Ancho de la Dovela 

 

C’, = Parámetros de resistencia del suelo.

 

Método de JANBÚ 

 

Janbú (1973) presenta un método de Dovelas para superficies de falla curvas, no circulares. 

De acuerdo con Janbú (ecuación modificada): 
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Donde fo depende de la curvatura de la superficie de falla (figura 2.9). 
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Figura No. 2.9. Diagrama para determinar el factor fo para el método de Janbú 

 

2.7.1.2  Taludes infinitos 

 

Son comunes las situaciones en que la ladera se presenta con una capa superficial de suelo con pequeño 

espesor, sobre una capa más rígida de suelo residual joven o de basamento rocoso. En tales situaciones, la 

superficie crítica es paralela al talud, conforme ilustrado en la Figura 2.10, y el talud es considerado 

infinito. 
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Línea
Línea

 
 

Figura No. 2.10. Talud infinito: fuerzas actuantes en una tajada genérica. 

 

Segundo Duncan (1996), el factor de seguridad de taludes infinitos puede ser expresado por:   

 

 

H

c
BAFS
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Donde los parámetros A y B son obtenidos en los ábacos presentados en la Figura No. 2.11. 
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Figura No. 2.11. Ábacos de Duncan (1996): talud infinito. 

 

 

2.7.1.3  Análisis de tensiones y deformaciones 

 

Son satisfechas las ecuaciones de equilibrio y de compatibilidad y las relaciones entre tensión, 

deformación y resistencia del suelo. Las condiciones de contorno son especificadas en términos de 

desplazamientos y / o tensiones. Para la solución de estos problemas, es necesaria la utilización de 

técnicas numéricas, siendo el método de los elementos finitos de más común. Otras técnicas numéricas, 

como las diferencias finitas y los elementos de contorno, pueden también ser utilizadas para el cálculo de 

FS. Este tipo de análisis requiere datos sobre perfil geotécnico y determinación detallada de los 

parámetros de deformabilidad y resistencia de los materiales envueltos. Estos análisis son en general 

sofisticados, siendo más comunes en obras de gran envergadura. Las principales aplicaciones son en 

estudios paramétricos, retroanálisis asociadas a datos de instrumentación en el campo e investigaciones 

sobre el mecanismo probable de ruptura. Pueden ser realizados análisis bidimensionales (estado plano de 
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deformación) o tridimensionales, siendo estas últimas más caras y menos usuales. Un ejemplo de 

aplicación de este método es presentado por Lins y Celestino (1998). 

 

2.7.2 MÉTODOS PROBABILISTICOS 

 

Este tipo de análisis es relevante para la confección de mapas de riesgo de ruptura, mapas de ocupación y 

aprovechamiento de suelos etc. Los métodos probabilísticos son también aplicados en estudios de 

estabilidad de taludes, con el objetivo de cuantificar algunas incertidumbres inherentes al factor de 

seguridad FS obtenido por métodos determinísticos. Es decir en general hecho a través de un análisis de 

confianza relativa, en la cual se determina el índice de confianza () del factor de seguridad. 

 

Con base en el valor de  y de una hipótesis sobre la distribución de la frecuencia del factor FS, puédase 

computar la probabilidad de ruptura (Pr) del talud. La consideración de una distribución normal para el 

factor de seguridad es más simple y conduce a resultados satisfactorios en análisis de la estabilidad de 

taludes (Avanzi y Sayão, 1998). Detalles del método de cálculo de la probabilidad de ruptura están 

presentados por Christian et al. (1994) y Guedes (1997). 

 

Con estos análisis, se obtienen estimativas del valor relativo de  o Pr, pues son consideradas sólo las 

incertidumbres posibles de cuantificarse, o sea, aquellas relacionadas con los parámetros geotécnicos y 

geométricos considerados como variables del problema. Para cada uno de estos parámetros, son 

determinados estadísticamente el valor medio y el respectivo patrón de desvío. No existen normas o 

recomendaciones generales para definición de valores admisibles para  y Pr, los cuales deben ser 

estipulados caso a caso, en función del método adoptado y de las consecuencias de eventuales rupturas 

(Guedes, 1997).Una descripción detallada de los métodos probabilísticos puede ser encontrada en Harr 

(1987). 
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Tabla II.6. Principales métodos de análisis de estabilidad de taludes en suelos (continua). 

 

 

Método Superficie Consideraciones Ventajas Limitaciones Factor de Seguridad Aplicación 

Taylor (1948) 
 

Circular 

Método del círculo de 
fricción. Análisis en 

términos de tensiones 
totales. 

Taludes homogéneos. 

Método simple, 
con cálculos 
manuales. 

Aplicado solamente 
para algunas 
condiciones 
geométricas 

indicadas en los 
ábacos 

Determinación del valor de altura crítica Hc. 



c
NsHc               

H

Hc
FS   

 

Estudios 
preliminares. 
Poco usados en la 
práctica. 

Talud infinito Plana 

Estabilidad global 
representada por la 
estabilidad de una 
rebanada vertical 

Método simple, 
con cálculos 
manuales. 

Aplicado solamente 
para taludes con 
altura infinita en 

relación a la 
profundidad de la 

superficie de ruptura. 

AB
z

c
FS 

















 tan

'tan'
 

 

 ecB cossec  ;  2sec1  urA  

z

u
ru





 

 

Deslizamientos 
largos, con 
pequeño espesor 
de masa inestable; 
por ejemplo, una 

capa fina de suelo 
sobre un 
basamento 
rocoso. 

Método de las 
cuñas 

Superficie 
poligonal 

Equilibrio aislado de 
cada cuña, 

compatibilizándose 
las fuerzas de 

contacto entre cuñas 

Resolución 
analítica o 

gráfica, con 
cálculos 

manuales. 

Considera cuñas 
rígidas. El resultado 
es sensible al ángulo 
(δ) de inclinación de 

las fuerzas de 
contacto entre cuñas. 

Determinación gráfica de los errores en polígonos de fuerzas para 
factores F arbitrarios. Cálculo de FS por interpolación para error 
nulo. 

Materiales 
estratificados, con 
fallas o juntas. 

Bishop 
simplificado 

(1955) 
Circular 

Considera un 
equilibrio de fuerzas y 

momentos entre las 
dovelas. 

Resultante de fuerzas 

verticales entre 
dovelas es nula. 

Método simple, 

con cálculos 
manuales o en 

un computador. 
Resultados 

conservativos. 

Método iterativo. 
Aplicación imprecisa 

para suelos 
estratificados. 

   





 


mbuWbc
W

F /tan
sin

1
 

 








 


F
m




tantan
1cos  

Método muy 
usado en la 

práctica. Un 
método 
simplificado y 
recomendado para 
proyectos 
simples. 

Bishop y 
Morgenstern 

(1960) 
Circular 

Aplica el método 
simplificado de 

Bishop. 

Facilidad de 
uso. 

Limitado a suelos 
homogéneos y 

taludes superiores a 
27° 

Despejado directamente de ábacos 

Para estudios 

preliminares en 
proyectos simples 
de taludes 
homogéneos. 
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Tabla II.6. Principales métodos de análisis de estabilidad de taludes en suelos (continuación). 

 
Método Superficie Consideraciones Ventajas Limitaciones Factor de Seguridad Aplicación 

Spencer (1967) 

 
No Circular 

Método riguroso 
satisface todas las 

condiciones de 
equilibrio estático. 

Valores de FS 

más realísticos. 

Complejidad de los 

cálculos. 

Resultantes de fuerzas entre dovelas con inclinación 
constante en toda la masa. 
Determina factores de seguridad para equilibrio de 

momentos (Fm) y equilibrio de fuerzas (Ff). Calcula FS 
cuando Fm = Ff. 

Para análisis mas 
sofisticadas, con 
restricciones 

geométricas da 
superficie de 
ruptura. 

Hoek e Bray 
(1981) 

Circular 

Masa inestable 
considerada como un 

cuerpo rígido. 
Solución por el límite 

inferior. 

Uso simples. 
Taludes 

inclinados de 10° 
a 90° 

Para materiales 
homogéneos, con 5 

condiciones específicas 
de nivel freático en  el 

talud. 

 
 
 
 

Despejado directamente de ábacos 

 
 

Para estudios 
preliminares, con 
riesgos reducidos 
de deslizamiento. 

Janbu  (1972) No Circular 

Satisface el equilibrio 
de momentos en cada 
dovela, sin embargo 
desprecia las fuerzas 

verticales entre 
dovelas. 

Superficies de 
rotura realísticas. 

Implementación 
simple en 

computadores.  

Aplicado para suelos 
homogéneos. Puede 

subestimar un factor de 
seguridad. El método 
generalizado no tiene 

esta limitación. 

 
 
Puede ser calculado manualmente, como un auxilio de 
ábacos, o por programas de computador. 

Gran utilización 
práctica. 
Deben ser 
consideradas las 
limitaciones de las 
rutinas de cálculo 

Morgenstern y 
Price 

(1965) 
No Circular 

Satisface todas las 
condiciones de 

equilibrio estático. 
Resuelve el equilibrio 
general del sistema. 

Es un método 
riguroso. 

Consideraciones 
más precisas que 

el método de 

Janbu. 

No es un método 
simple. Exige cálculos 

en el ordenador  
Calculado por interacciones, con el uso de ordenadores 

Para estudios o 
análisis detallados 

(retroanálisis) 

Sarma 
(1973, 1979) 

No Circular 

Método riguroso, 

atiende las 
condiciones de 

equilibrio Considera 
fuerzas sísmicas 

(terremotos). 

Reducción en el 
tiempo de 
cálculo sin 
pérdida de 

precisión 

Método exige cálculos 
en ordenador. El 
método de Sarma 
(1973) puede ser 

resuelto manualmente. 

Calculado por interacciones, con el uso de ordenadores 

Es aplicado como 
una alternativa al 

método de 
Morgenstern y 

Price. 
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(a) Perfil de talud, con división en  2 cuñas (b) Polígono de fuerzas de 1 cuña(a) Perfil de talud, con división en  2 cuñas (b) Polígono de fuerzas de 1 cuña

 
Figura No. 2.12. Método de las cuñas con superficie de ruptura poligonal. 

 

 

 
Figura No. 2.13. Método de Bishop (1955) superficie de rotura circular. 

 

 

 

bhW    = peso de la dovela 

 

I

u
u   = presión de poros en la base 

 

h Altura media de la dovela 

 

 

H= altura del talud 
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α = inclinación de la base de la dovela 

 

 

i Inclinación del talud 

 

 

Comparación 

 

Al existir varios métodos es inevitable realizar una comparación entre ellos, fundamentalmente entre precisos 

y aproximados, para discernir cuáles son los más útiles en la práctica,  por su exactitud y economía. Esto 

ha sido realizado por varios autores, entre ellos WHITMAN y BAILEY (1967). 

 

El método más exacto y también el más complejo es el de MORGENSTERN y PRICE. Considerándolo 

como referencia los autores concluyen que el método de BISHOP presenta errores máximos del 7%, siendo 

lo más normal del 2%. En contraste, el método de FELLENIUS puede originar graves errores, hasta de un 

40%. 

 

De aquí se deduce que, al menos teóricamente, los cálculos de estabilidad siguiendo el método de BISHOP 

ofrecen suficiente precisión aunque debe tenerse en cuenta que los errores que se introducen pueden no 

quedar del lado de la seguridad. 

 

En la práctica, el método de MORGENS-TERN-PRICE resulta mucho más laborioso en su aplicación, 

por lo que su utilización se ve relegada a casos muy especiales o a temas relativos a la comprobación de 

otros métodos más simplificados. 

 

Los métodos más utilizados por los ingenieros geotécnicos en todo el mundo son los simplificados de 

Bishop y de Janbú, los cuales en su concepción teórica no satisfacen equilibrios de fuerzas o de 

momentos. Los valores de factores de seguridad que se obtienen por estos dos métodos generalmente, 

difieren en forma importante de resultados utilizando procedimientos que satisfacen el equilibrio, como 

son los métodos de Spencer y de Morgenstern-Price. 
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Aunque una comparación directa entre los diversos métodos no es siempre posible, los factores de 

seguridad determinados con el método de Bishop difieren por aproximadamente el 5% con respecto a 

soluciones más precisas, mientras el método simplificado de Janbú generalmente, subestima el factor de 

seguridad hasta valores del 30%, aunque en algunos casos los sobrestima hasta valores del 5%. Esta 

aseveración fue documentada por Freddlund y Krahn (1977). Los métodos que satisfacen en forma más 

completa el equilibrio son más complejos y requieren de un mejor nivel de comprensión del sistema de 

análisis. En los métodos más complejos y precisos se presentan con frecuencia problemas numéricos que 

conducen a valores no realísticos de FS. Por las razones anteriores se prefieren métodos más sencillos 

pero más fáciles de manejar como son los métodos simplificados de Bishop o de Janbú. 

 

2.8 ANÁLISIS DE ESTABILIDAD DE TALUDES 

 

2.8.1 Modos de ruptura 

 

Para la elección del método de análisis, débase considerar el modo de ruptura probable del talud. La 

profundidad de los deslizamientos es controlada principalmente por el espesor de la capa superficial de 

suelo y por las tasas de infiltración del agua de lluvia. Los deslizamientos en su mayoría son 

caracterizados como corrimientos de tierra, frecuentemente provocando daños (Amaral, 1992). Estas 

rupturas deben iniciarse como deslizamientos, transformándose en corrimientos de tierra, y eventualmente 

corrimientos de detritos, debido a la gran inclinación y a la abundancia de agua de lluvia que son 

condiciones usuales en las laderas. 

 

2.8.2 Datos de entrada 

 

Los principales datos de entrada para un análisis de estabilidad son: 

 

(a) Topografía: debe definir el área de estudio y dar condiciones para el trazado de los perfiles del terreno 

en las secciones críticas. 
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(b) Geología: debe dar condiciones para definición de la geología en los perfiles de las secciones críticas. 

Debe ser observado el perfil de estratigrafía, presencia de colúvios y terraplenes, contactos de materiales 

diferentes, afloramientos y planos de debilidad. 

 

(c) Parámetros del material: los materiales envueltos en la ruptura son normalmente caracterizados por su 

resistencia al cizallamiento de Mohr-Coulomb. Esta es usualmente expresa en términos de parámetros 

efectivos (c’ y ’) o totales (c = Su,  = 0). En el caso de arrinconas en suelos coluviales o residuales, los 

análisis son usualmente efectuados en términos de tensiones efectivas. Parámetros de resistencia en 

términos de tensiones totales son usados para suelos saturados bajo condiciones no drenadas. Los valores 

de los parámetros de resistencia deben ser determinados a partir de ensayos de laboratorio en muestras 

indeformadas y representativas del material del talud. Estos parámetros pueden ser eventualmente 

estimados a partir de ensayos de campo. 

 

(d) Agua subterránea: deben ser determinados los niveles de la presión de poros al largo de la masa 

envuelta en el estudio de la estabilidad. En solicitudes drenadas, esta determinación puede ser hecha a 

través de la instalación de piezómetros en el talud, observándose la variación de las presión de poros es 

asociadas a la precipitación de lluvia en el local. Un análisis, para ser confiable, debe considerar un 

tiempo de recurrencia para la precipitación máxima, compatible con la vida del proyecto. 

 

(e) Cargas externas: deben ser consideradas las sobrecargas más significativas, como por ejemplo: 

fundaciones, contenciones, terraplenes, pilas de stock o bota-fuera, torres de transmisión, tráfico, 

detonaciones, clavación de estacas etc. 

 

2.8.3 Elección del método de análisis 

 

Para proyectos preliminares y clasificados como de riesgo despreciable, el tiempo consumido en análisis 

detallados no es justificado. Se recomienda, en estos casos, el uso de métodos convencionales y 

simplificados, con superficies circulares de ruptura (ejm: Bishop simplificado). 
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Para proyectos clasificados como de riesgo pequeño a medio, se recomienda el uso de métodos 

simplificados con superficies de ruptura no circulares (ejm: Janbu), o métodos rigurosos (ejm: 

Morgenstern & Price). Sin embargo, análisis con superficies de ruptura circulares (Bishop) pueden ser 

aún ocasionalmente aplicadas en estudios preliminares. Para proyectos de riesgo elevado, son requeridos 

estudios geológicos y geotécnicos más detallados del área y análisis rigurosos de estabilidad (ejm: 

Morgenstern & Price, Spencer o Sarma). 

 

2.8.4 Software 

 

Existe en el mercado una gran variedad de software especializados para análisis automático de estabilidad 

de taludes en microcomputadores, con precios variando entre $500 y $5000 dólares americanos. Los más 

caros ofrecen más recursos de edición gráfica (ejm: G-SLOPE), mientras los más baratos están aún 

presentados en DOS. El uso de un programa de ordenador permite analizar casos complejos envolviendo 

capas de distintos materiales, cargamentos aplicados sobre el talud y varias condiciones de presión de 

poros, entre otras ventajas. 

 

2.9 RIESGOS Y DECISIONES 

 

2.9.1 Fases del Proyecto 

 

La realización completa de un proyecto de estabilización implica tres fases distintas: diagnóstico, solución y 

monitoreo (Figura 2.14).  

 

Diagnóstico Solución MonitoreoDiagnóstico Solución Monitoreo

 
 

Figura No. 2.14. Fases del Proyecto. 
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La primera incluye la identificación del movimiento de masa sumada a los estudios topográficos, 

geológicos, hidrológicos y geotécnicos (Figura 2.15). Al final de la fase de diagnóstico, el ingeniero posee 

todos los elementos que le permiten, entonces, decidir sobre la solución a adoptar. Estas Fases tienen por 

objetivo ser una guía preliminar para esta decisión. En la mayoría de los casos existe más de una 

alternativa de solución. La elección será decidida por aquella de menor costo. 
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DiagnósticoDiagnóstico

 
 

 

Figura No. 2.15. Fases de Diagnóstico. 
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2.9.2 Taludes en suelo 

 

Las diversas soluciones que son objeto de este trabajo constan de la Figura 2.16. El drenaje y la 

protección superficial son soluciones siempre presentes en la estabilización de taludes. Las demás pueden 

variar caso a caso.  

La Figura 2.17 presenta un flujograma para auxiliar la elección de la solución. 

 

Alternativas de 

Solución 
 

Taludes 

en suelo

Abatimiento

Drenaje y 

protección 

superficial

Muros

Pantallas 

ancladas

Refuerzo con 

geosintéticos

Micropilotes 

(Soil nailing)

Taludes 

en suelo

Abatimiento

Drenaje y 

protección 

superficial

Muros

Pantallas 

ancladas

Refuerzo con 

geosintéticos

Micropilotes 

(Soil nailing)

 
 

 

Figura No. 2.16. Fases de Solución: Alternativas para taludes en suelos. 

 

 

Claveteado 

(soil nailing) 
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Taludes en 

suelos

Cortes

Terraplenes

Abatimiento

Micropilotes 

(soil nailing)

Pantallas 

ancladas

Muros

Refuerzo con 

geosintéticos

Bermas o 

terrazas

Suavización

Drenaje y 

protección 

superficial

Taludes en 

suelos

Cortes

Terraplenes

Abatimiento

Micropilotes 

(soil nailing)

Pantallas 

ancladas

Muros

Refuerzo con 

geosintéticos

Bermas o 

terrazas

Suavización

Drenaje y 

protección 

superficial

 
 

Figura No. 2.17. Elección de la solución para taludes en suelos. 

 

 

Algunos aspectos también son relevantes para la elección de la solución en taludes en suelos. Entre las que se 

destacan son las siguientes: 

 

 Acceso a medios de transporte: si el acceso es difícil, como frecuentemente ocurre, medios no 

convencionales pueden ser utilizados por los propios trabajadores, como teleféricos, helicópteros o 

mulas. Por lo tanto, equipamientos y materiales de mayor tamaño son inadecuados; 

 Altura del Talud: los muros en general son económicamente eficientes para pequeñas alturas, hasta3 

m. Por encima de este valor, las soluciones de refuerzo de suelo tienden a ser más económicas; 

 Drenaje: solución presente en todos los taludes. 

Claveteado 

(soil nailing) 
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 Abatimiento: depende de la disponibilidad de área libre para la implantación de un nuevo corte y 

terrazas; 

 Pantallas ancladas: solución tradicional muy empleada por la flexibilidad de poder ser aplicada en 

cortes (método constructivo descendiente) y terraplenes (método constructivo ascendente). El sistema 

de contención con anclajes pre-tensados es suficientemente rígido para limitar los desplazamientos 

del terreno. Por eso es aconsejado también en casos en que se desea reducir efectos de 

desplazamientos en construcciones y fundaciones muy próximas; 

 Claveteado (soil nailing): en cortes o excavaciones es en general la que presenta el menor costo, pues 

los equipamientos de trabajos en las terrazas de corte, sin andamios. Es fácilmente aplicada a taludes 

inclinados, sin la necesidad de cortes adicionales para la verticalización de la pared; 

 Muros o taludes de suelo reforzado: en general la solución más económica para terraplenes con alturas 

mayores que 3 m y con extensiones mayores que 20 m. Se puede adoptar la solución de suelo 

compactado y envuelto con geosintético. La fachada puede ser ejecutada con elementos de hormigón 

armado, para dar paso al terraplén compactado, o una mampostería a posterior. El primer tipo puede 

ser aplicado en suelos de fundación de baja capacidad de carga, pues el muro resultante es muy 

flexible, con mayor capacidad de adaptación a asentamientos diferenciales. Y los muros en que la 

fachada de hormigón es ejecutada a medida que el muro es construido exigen una fundación 

competente. 

 

 

Tabla II.7. Resumen de las soluciones de estabilización 
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2.10 ANÁLISIS SÍSMICO DE TALUDES 

 

Los eventos sísmicos son capaces de inducir fuerzas de gran magnitud, de naturaleza cíclica, las cuales 

pueden producir la falla rápida de taludes y laderas. Además, la resistencia al corte de un suelo puede 

reducirse a causa de cargas oscilatorias que generan deformaciones cíclicas, o debido a la generación de 

presiones altas de poros. 

 

La combinación entre la acción de las cargas sísmicas y la disminución de la resistencia pueden producir 

una disminución general de la estabilidad. El caso mas crítico es el de materiales no plásticos de grano 

fino como son los limos o las arenas finas. 

 

En el análisis de estabilidad se requiere analizar los cinco factores que se indican a continuación: 



Generalidades                                                                             ESPE – Carrera de Ingeniería Civil - 2007 

- 55 - 

 

- Magnitud de la fuerza sísmica. 

- Disminución de la resistencia a causa de las cargas oscilatorias. 

- Disminución de la resistencia por aumento de la presión de poros. 

- Fenómeno de resonancia. 

- Amplificación de las cargas sísmicas por la presencia de suelos blandos. 

 

Se han propuesto el método de análisis seudoestático para la evaluación de la estabilidad de taludes y 

laderas, en el caso de eventos sísmicos; que busca por medio de un análisis de factor de seguridad, 

identificar la aceleración crítica y, después, la máxima aceleración del terreno bajo la cual ocurriría el 

desplazamiento. 

 

2.10.1  Análisis Seudoestático 

 

Método seudoestático en el cual las cargas del sismo son simuladas como cargas estáticas horizontales y 

verticales. 

 

El método utiliza el mismo procedimiento general de cualquiera de los métodos de equilibrio límite, con 

la diferencia de que se incluyen fuerzas seudoestáticas horizontales y verticales, debidas al evento 

sísmico. Estas fuerzas sísmicas se asumen, que son proporcionales al peso de la masa de deslizamiento 

potencial y de los coeficientes sísmicos kh y kv expresada en términos de veces la aceleración g, 

producida por el sismo. 

 

Generalmente, se recomienda analizar con carga sísmica seudoestática solamente la superficie más crítica 

identificada en el análisis estático. La mayoría de los análisis solamente tienen en cuenta la fuerza sísmica 

horizontal y kv se asume igual a cero. 

 

La magnitud del coeficiente sísmico debe simular la naturaleza de la fuerza del evento que depende de la 

intensidad o aceleración del sismo, duración del movimiento y frecuencia. Para un análisis muy 

conservador se puede asumir que el coeficiente sísmico kh es igual a la máxima aceleración pico esperada 
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de un evento sísmico en el sitio. Sin embargo, este análisis conservador puede producir dificultades 

numéricas para kh mayor que 0.4. 

 

 
 

Figura No. 2.18. Variación del factor de seguridad con el coeficiente sísmico horizontal Kh. 

 

 

Existen varias formas de plantear el problema de acuerdo al tipo de falla analizado y a los parámetros 

sísmicos utilizados. 

 

a. Cálculo del factor de seguridad para una superficie de falla finita plana y fuerzas sísmicas horizontal y 

vertical (Kramer 1996). 

Las magnitudes de las fuerzas seudoestáticas son: 
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Donde: 
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Fh y Fv = Fuerzas seudoestáticas horizontales y verticales 

ah y av = Aceleraciones máximas horizontales y verticales 

kh y kv = Coeficientes seudoestáticos 

 

 

 
 

Figura No. 2.19. Análisis sísmico seudoestático para una falla plana. 

 

 

 

El factor de seguridad para una falla plana de longitud L es igual a: 
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Donde: 

 

 

 

Cohesiónc   

 

L = Longitud del plano de falla 

 

friccióndeAngulo   

 

W = Peso de la masa deslizada 

 

 

b. Calculo de la aceleración máxima que produce una falla en un talud infinito 
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Es práctica corriente utilizar solamente un valor de aceleración máxima, sin diferenciar los valores de 

aceleración horizontal y vertical 

 

Un procedimiento seudoestático consiste en determinar la aceleración máxima necesaria para causar un 

deslizamiento durante un sismo amax la cual está dada por la siguiente expresión para el caso de un talud 

infinito: 
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Donde: 

 

 Ángulo de inclinación del talud 

 

  Ángulo de fricción 

 

c Cohesión estática 

 

dc Cohesión dinámica 

 

g Aceleración de la gravedad 
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H = profundidad de la falla 

 

 = peso unitario del suelo 
 

b = peso unitario sumergido 
 

 

c. Calculo del factor de seguridad para falla curva con un valor de amax 

 

Un procedimiento utilizado es presentado por Ishiara (1985). El factor de seguridad es calculado para 

diferentes valores de la aceleración máxima, de acuerdo a una fórmula modificada utilizando el 
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procedimiento original de Janbú (1955), dividiendo la masa deslizada en dovelas y realizando las 

respectivas sumatorias. 

 

 

 

 

 

 
 

 

 

 

 

 

Figura No. 2.20. Análisis sísmico seudoestático de equilibrio límite para una falla curva. 
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Determinación del valor de amax para el análisis 

 

La cuantificación de un valor de aceleración máxima para estabilidad de taludes debe tener en cuenta los 

siguientes criterios empíricos:  

 

a. Si la masa considerada para deslizamiento es rígida la aceleración inducida sobre la masa debe ser igual 

a la aceleración máxima esperada con sus respectivas amplificaciones por sitio y topografía. 

 

b. Si la masa de suelo no es rígida, como es el caso de la mayoría de situaciones y si se tiene en cuenta 

que la aceleración pico solo se presenta en períodos de tiempo muy pequeños no suficientes para producir 

una falla; se pueden utilizar valores entre 0.1 y 0.2g, dependiendo de la intensidad del sismo esperado. 

 

Marcuson (1981) recomienda utilizar valores entre 1/3 y ½ de la aceleración máxima esperada con las 

respectivas amplificaciones. 
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Limitaciones del método seudoestático 

 

El método seudoestático presenta algunas inconsistencias para modelar el efecto real de un sismo sobre 

un talud. Algunas de estas limitaciones son las siguientes: 

a. No es confiable en suelos que generan presiones de poros altas 

b. No tiene en cuenta que algunos suelos presentan degradación de la resistencia hasta en un 15% debido 

a la onda sísmica. 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAPÍTULO III 

MANUAL DEL USUARIO DEL SOFTWARE  

 

3.1 INTRODUCCIÓN  

 

GSLOPE usa el  Método de Bishop Modificado y el Método Simplificado de Janbu  (Janbu et al., 1956), 

estos  dos métodos son los más comúnmente usados en cuanto al  análisis de la estabilidad de taludes en 

equilibrio límite, permite encontrar el factor de seguridad de los mismos, tanto en materiales granulares y 

cohesivos.   

 

El uso de este programa se complementa para trabajar en diseños de Taludes (desniveles) con o sin el 

refuerzo geosintético.  El programa está conforme y de acuerdo a los términos de la licencia del software.  

Además, la atención del lector se indica al aviso legal que precede esta sección del manual.  
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El soporte técnico para GSLOPE está disponible  en Mitre Software Corporation Phone:(780)434-4452, 

Avenida  9636-51, info@mitresoftware.com Canadá T6E A5 www.mitresoftware.com 

  

3.1.1 CARACTERÍSTICAS  

 

GSLOPE pueden modelar taludes (desniveles) que contienen múltiples materiales del suelo con una 

variedad amplia de geometrías. Cada material del suelo puede tener su propia condición de presión del 

poro, o puede compartir la misma condición de  presión del poro.  El talud puede también ser sumergido 

parcialmente. Las condiciones de presión del poro se pueden especificar en términos de líneas 

piezométricas o como valores de Ru.   

 

Cada material del suelo presente en el talud se especifica normalmente en términos de unidad de peso 

total, cohesión eficaz, y ángulo eficaz de fricción.  El coeficiente de interacción del suelo-refuerzo de 

cada suelo puede también ser especificado.   

 

Hasta 20 tipos de materiales de suelo se pueden incluir en un análisis, junto con hasta 100 capas de 

refuerzo.  Proporciona métodos rápidos para agregar y ajustar las capas del refuerzo.   

 

Las cargas de la  sobrecarga se pueden simular definiendo un material con una unidad de peso elevada, 

pero con parámetro de cero fuerza.  

 

La carga sísmica considerada es la  aceleración horizontal para el análisis pseudo-estático.   

 

Genera gráficos en la pantalla que pueden mostrar las capas del suelo, superficies piezométricas, fuerzas 

externas, el refuerzo, y superficies potenciales de falla.  Se puede enfocar dentro de la superficie de falla 

del talud y examinar rebanadas individuales si es deseado.   

 

GSLOPE realiza la comprobación de los datos extensos y señala por medio de una ventana el error.   

http://www.mitresoftware.com/
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GSLOPE tiene tres tipos de búsqueda de la rejilla e incluso puede analizar una superficie de forma 

general.  Durante búsquedas, cada superficie de falla se dibuja en la pantalla de modo que el usuario 

pueda notar si está analizando y qué superficie.  

 

Los contornos del factor de seguridad se pueden mostrar en la pantalla y se actualizan mientras progresa 

el análisis.  Al proceder el análisis rápidamente, existe un botón (stop) que controla la velocidad y lo 

reanuda.  

 

El perfil superficial del terreno, los perfiles del suelo, las superficies piezométricas, las cargas externas, y 

las capas del refuerzo se pueden definir gráficamente usando un ratón.  Las coordenadas asociadas se 

pueden también corregir directamente.   

 

GSLOPE permite el uso de una "línea de la construcción" que simplifique la producción y la 

modificación subsiguiente de una sección representativa en una  estratigrafía detallada.  Algunas de las 

posibilidades que se despliega son la estratigrafía de seguimiento.  

 

El  área de la estratigrafía que se excavará se puede dibujar una sola vez, después utilizar como base para 

varios análisis y cada uno cortada con una diversa línea de la excavación.   

 

Para agregar una berma, contornearla con la superficie de construcción, y elegir el terraplén.   

 

Para sumergir el pie del talud (desnivel), inserte un material en la superficie del terreno, dibuje una línea 

horizontal en la elevación deseada, elija Other>Fill, e incorpore las características del material y las 

propiedades para el agua como el primer material.   

 

Los puntos en la geometría se pueden volver a poner gráficamente usando el ratón, o ajustar finalmente 

usando las teclas de cursor.  Cuando una superficie de falla especificada se modifica de esta manera, el 

factor de seguridad se actualiza continuamente para reflejar la forma actual de la superficie de falla.  El 

formato del archivo del GSL usado por GSLOPE para Windows es igual según lo utilizado por la versión 

del DOS de GSLOPE.   
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3.1.6 REQUERIMIENTOS DEL SISTEMA  

 

Para un correcto funcionamiento del software, se deben cumplir con los siguientes requisitos mínimos: 

 

REQUERIMIENTOS DE HARDWARE: 

 

 Computadora con microprocesador PENTIUM (ó 586) de 90 Mhz, o superior. 

 16 MB de memoria RAM o mayor. 

 Unidad de CD - ROM 4X o superior. 

 

 Mouse, o cualquier otro dispositivo de señalización. 

 Tarjeta de sonido (recomendable). 

 Monitor a colores, con resolución 640 x 480, 800 x 600 ó 1024 x 768 pixels. 

 Modem 28.8 Kbps o mayor. 

 

REQUERIMIENTOS DE SOFTWARE: 

 

 El presente software requiere, del sistema operativo Windows 95, 98 o superior. 

 

3.1.7 INSTALACIÓN 

 

La instalación del programa se iniciara desde el CD con el archivo ejecutable setup.exe seguidamente se 

copiará los archivos requeridos a su disco duro y configurará su sistema. 

 

Instalar la llave de seguridad es un Sentinel Pro, la misma que debería ser conectada hacia un puerto 

paralelo (LPT1) en su computador. 

 

Si es que la impresora u otro aparato están conectados dentro del puerto paralelo, apáguele  su sistema, 

desconecte el otro aparato, y conecte el Sentinel Pro directamente al puerto.  
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Para instalar el conductor, utilice Sentinel/setup.exe desde el programa del CD. La llave actual no 

necesita estar presente durante la instalación del conductor o driver. 

 

Una vez que el conductor esté instalado completamente, usted tendrá que reiniciar rápidamente su sistema 

de manera que el conductor sea activado. Tal vez usted desee no reiniciar el sistema y en lugar de ello 

apagar totalmente el sistema para que usted pueda reconectar su impresora. 

 

Como en cualquier instalación de Windows, nosotros recomendamos que ningún otro programa esté 

corriendo mientras hace el proceso de la instalación de este.  

   

3.1.8 BASE TEÓRICA DEL SOFTWARE 

 

El objeto de los análisis de la estabilidad de taludes es cuantificar el potencial para la deformación 

excesiva o colapso. La predicción exacta de la deformación requiere de la definición de muchos 

parámetros difíciles a evaluar  y del uso de los métodos analíticos complejos no disponibles para la 

mayoría de los ingenieros. Así, los análisis usando métodos de equilibrio  límite para predecir el 

funcionamiento de un talud asignando un factor de la seguridad, se utilizan lo más comúnmente posible.  

Un acercamiento al equilibrio  límite, asume Coulomb´s que el criterio de  falla será satisfecho a lo largo 

de la superficie de falla elegida. Se asume que la deformación será limitada requiriendo un factor de 

seguridad adecuado. 

 

La ecuación general de Bishop para el factor de seguridad en taludes sin reforzamiento es: 

 

 

 

 









ii

iiiii

SenW

mTanWxc
Fs



 /
                                                                (1) 

 

 

 

Donde:   FsTanSenCosm iiii /   
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La ecuación de Bishop Modificado, define el factor de seguridad de un talud reforzado como: 

 

Fs (modificado) = Fs (Bishop W/ó reforzado) + Mr / Md                              (2) 

 

 

 

 
 

Figura No. 3.1. Análisis de fuerzas en una dovela en talud reforzado. 

 

 
Donde: 

 

 

  

  







iiiii

iiiiiii

tsenW

msentWxc
Fs



 

cos

/tan
                                                   (3) 

 

 

 

i  Es el ángulo de la fuerza del refuerzo, determinado con la especificación de la figura 2. 
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Figura No. 3.2. Orientación de Tavailable en la superficie de falla. 

 

 

 

  tangential1cos  rorRTavailableMr  

 

Mr = Momento resistente 

 

Tavailable = Tensión disponible 

 

R = Radio del círculo de falla 

 

 
 

Cuando ror = 0, la fuerza del refuerzo esta horizontal y de esta contribución el factor de seguridad es el 

mas bajo. Cuando ror = 1, Tavailable es tangencial al círculo de falla y de esta contribución el factor de 

seguridad es el mas alto. 

 

  ii senWRMd   

 

 

Md = Momento volcador 

 

R = Radio del círculo de falla 

 

W = Peso de la dovela 

 
 

La ecuación 2 se resuelve usando un Fs = 1.0 para encontrar la suma de Trequered. Para el mismo círculo 

trazado, se da T available y de su suma también puede determinarse. El factor de seguridad es entonces: 

 

 

Trequired

Tavailable
Fs                                                                                             (4) 

 

 

 

GSLOPE, usa la ecuación (1) para calcular el factor de seguridad en el caso de taludes sinrefuerzo y la 

ecuación (3) para taludes con refuerzo. 

 

De la ecuación (4), Trequired  Tavailable / Fs; si Fs = 1.0 por lo tanto, Trequired  Tavailable 

Tallowable  

 

Entonces la Tensión requerida es la Tensión permisible (Tallowable) que usa Gslope para realizar los 

cálculos con refuerzos geosintéticos.   
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3.1.9 OPERACIÓN DEL PROGRAMA 

 

3.1.5.1   Inicio con Gslope 

 

Esta sección explica cómo definir un ejemplo de análisis de la manera más rápida y más simple posible. 

Muestra cómo dibujar la estratigrafía del suelo y la excavación de una sección transversal usando una 

línea de  construcción, reduciendo al mínimo el esfuerzo requerido para definir la geometría.   

 

3.1.5.1.1   Los datos principales y el sistema de unidades  

 

Inicie  GSLOPE, y eliga Edit>Header.  Incorpore la información según lo demostrado abajo:  

El artículo más importante en la pantalla del header (encabezamiento) es el peso de la unidad del líquido 

del poro.  Se utiliza para definir el sistema de las unidades usadas en el análisis. 

 

 

 

 
 

Figura No. 3.3. Encabezado de los datos principales y sistema de unidades. 



Generalidades                                                                             ESPE – Carrera de Ingeniería Civil - 2007 

- 68 - 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

LAS UNIDADES ASUMIDAS POR GSLOPE 

BASADAS EN EL PESO DE AGUA 

 

 
 

El ejemplo está en unidades inglesas, ingrese la unidad del peso de agua como 62,4 (libras por pie cúbico) 

y presione OK cuando ha terminado.  No hay necesidad de incorporar el número de materiales, debido a 

que estas entradas pueden ser realizadas automáticamente al dibujarlos en la pantalla.   

 

3.1.5.1.2   Defina los límites de la geometría 

 

Prepare para dibujar la estratigrafía eligiendo Set ▸ Extents.  Esto define la extensión lateral de la 

geometría en términos de X-coordenada, y provee un valor inicial de Y-coordenada para la base, utilizada 

para exhibir la geometría.  Incorpore la extensión deseada como sigue:   

 

X-coordenada del lado izquierdo    0  
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X-coordenada del lado derecho    280  

Y-coordenada de la base     190  

 

 
 

Figura No. 3.4. Ventana de definición de los límites de la geometría. 

 

Pulse el botón OK cuando ha terminado. Un sistema apropiado de la rejilla de coordenadas aparece.  Para 

hacer el dibujo más fácil, elegir Set ▸ Snaps y fijar X-Coordenada de ingreso y Y-Coordenada de ingreso 

a 1.  Esto asegurará de que todos los puntos que usted tenga en el dibujo las coordenadas sean  

redondeadas al número entero más cercano. 

 

 
 

Figura No. 3.5. Ventana para redondear las coordenadas. 
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3.1.5.1.3    Dibuje la estratigrafía  

 

Para dibujar la superficie del terreno, seleccione  Draw ▸ Soil Layer ▸ Material 1.  Observe que las 

coordenadas del cursor ahora están exhibidas en la esquina izquierda superior de la ventana de GSLOPE.  

El primer punto de cualquier material  siempre se encuentra en el borde izquierdo de la geometría, así que 

no se preocupe de X-coordenada para este primer punto.  Ajuste el cursor para exhibir Y-coordenada de 

256, y presione el botón de ratón izquierdo.  El primer punto en el material 1 (Igual a la superficie del 

terreno en este caso) se dibuja en X=0, Y=256. Mover el cursor a un punto más allá del derecho de la 

geometría (haga X-coordenada mayor de 280 o mover simplemente el cursor a la derecha de la pantalla) y 

dibujar un segundo punto, también en Y=256.  Una sección representativa simple del plano aparece, 

consistiendo en un solo material.   

 

Seleccione Draw>Soil Layers>Material 2 y dibuje una segunda superficie horizontal, en Y=250.  

Entonces agregue más superficies horizontales en las elevaciones siguientes:  

 

El material 3   Y = 242  

El material 4   Y = 202  

El material 5   Y = 195 

 

Seleccione Edit>Material e incorpore los nombres y las características de los varios materiales. 

No se preocupe de las otras columnas por ahora.  Cierre la digitación cuando termine. 

 

Asigne un nombre de fichero eligiendo   

 

File>Save as (Guardar como) y asignar el nombre SAM1.GSL.   

 

3.1.5.1.4   Excavar un talud 

 

Ahora crearemos un talud excavando la parte de la estratigrafía.  Elija la línea de Draw>Construction y 

escoja un primer punto cualesquiera sobre la superficie del terreno (Y>=256).  Elija los puntos 

adicionales como sigue:   
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Punto 2, X = 107, Y = 256  

Punto 3, X = 185, Y = 216  

Punto 4, X = 280, Y = 216  

 

Para el punto 4, X-coordenada final, cualquier valor sobre 280 será corregido a 280 para emparejar el 

límite de la geometría.  Si usted ha dibujado la superficie de la excavación correctamente, elija de 

Other>Excavate/All Materials y presione  Construct (construcción) para crear el talud (desnivel).  Elija 

File>Save para escribir los cambios a SAM1.GSL. Ponga encendido en la barra base de la ventana para 

forzar una pantalla prediseñada.  Esto quitará cualquier marca de la línea de la construcción.  Si de la 

construcción todavía hay restos de la línea, lo puede quitar eligiendo Set>Preferences y quitando la marca 

etiquetada en la opción Construction Surface (superficie de construcción).  

 

3.1.5.1.5   Dibuje una superficie piezométrica  

 

Elige la superficie 1 de Draw>Piezo Surfaces> Piezo Surface 1  y dibujar una sola superficie con las 

coordenadas siguientes:   

 

0, 247   50, 246   90, 244   120, 239  

151, 230  185, 216   280, 216  

 

Como cuando elige los materiales de dibujo, si usted incurrió en una equivocación, usted puede utilizar el 

botón del ratón derecho para sostener.   

 

3.1.5.1.6   Defina una rejilla de centros  

 

Elegir Draw>Grid of Centers (Grilla de centros), y precise la primera de las esquinas de la rejilla en 160, 

280 y 180, 300 en la esquina opuesta de la rejilla.   

 

3.1.5.1.7   Define una gama de tangentes 
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Elija Draw>Range of Tangents (Rango de tangentes), y designe dos elevaciones como sigue:  

Y = 206  

Y = 200  

 

3.1.5.1.8   Correr y analizar  

 

La función análisis de chequeo, se comprueba en el menú superficie de falla (Slip Surface) y la opción 

búsqueda regular de la rejilla (Regular Grid Search) es verificada.  Entonces elija Analyze>Calculate (o 

presione Shift-F9) para exhibir la pantalla de la selección de la rejilla.  Los parámetros requeridos de la 

rejilla se han completado de forma automática cuando la rejilla y las tangentes fueron dibujadas.  Se 

autoriza la digitación y se procede al análisis.   

 

 
 

Figura No. 3.6. Análisis del factor de seguridad y visualización del círculo de falla. 

 

 

Cada superficie de falla se exhibe en la pantalla mientras procede el cálculo.  Aparece una barra en la 

base de la información de exhibiciones de la pantalla sobre la superficie actual en el orden siguiente:   

 

 
 



Generalidades                                                                             ESPE – Carrera de Ingeniería Civil - 2007 

- 73 - 

 
 

Figura No. 3.7. Visualización de la información de análisis en barra inferior. 
 

 

 

M-alfa de seguridad se publica bajo ciertas condiciones inusuales, cuando las fuerzas normales calculadas 

en la base de una rebanada pueden llegar a ser poco realistas.  La información adicional sobre M-alfa se 

puede encontrar en las notas técnicas, que están disponibles por separado.   

  

Elija Set>Preferences para mostrar las preferencias de la exhibición seleccionadas actualmente.  

Compruebe los contornos y  autorice (OK).  Los contornos del factor de seguridad para el análisis apenas 

realizado aparecen en la pantalla.   

 

Para ampliar el área contorneada, presione Shift-F9 para traer hacia arriba la pantalla de la selección de la 

rejilla, y cambie los pasos en X y los pasos en Y de su valor prefijado de 2 a los valores de, por ejemplo, 5 

y 6.  Pulse  OK, y mire cómo aparecen los contornos mientras procede el análisis.   

 

Puesto que el centro crítico para este funcionamiento está en la esquina izquierda más baja de la rejilla 

definida, usted puede pretender intentar usar Draw>Grid of Centres (grilla de centros), para rediseñar la 

rejilla más baja y más lejos a la izquierda, a partir del 140, 260 a 190, 320.  Para ello, presione F9 para 

recalcular con la nueva rejilla.   

 

Para ampliar en la sección representativa exhibida elija View>Zoom>Window (o pulsando Ctrl-W), 

después defina una ventana tomando sus esquinas contrarias.  Obtenga de nuevo la visión de la pantalla 

completa usando View>Zoom>All o pulsando Ctrl-A.   

 

Para Imprimir la sección representativa completa, elija los gráficos de File>Print.  

 

3.1.6   ORGANIZACIÓN DE ARCHIVOS 
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La organización de archivos en GSLOPE es extremadamente simple;  toda la información sobre cualquier 

análisis dado se contiene en un archivo, con extensión (.GSL).  Cuando se lee un archivo usando la 

opción File>Load, la información se carga en RAM y se puede modificar, se puede realizar los cálculos, 

así como imprimir las secciones representativas, etc. sin afectar el archivo.   

 

Si usted hace modificaciones y grava usando la opción File>Save, usted sobrescribirá el archivo anterior.  

Si no requiere del anterior proceso, utilice File>Save as, y de un nuevo nombre de fichero bajo el cual los 

datos deban ser guardados.   

 

Si usted está realizando muchos análisis, lo más simple es hacer una carpeta separada para cada proyecto 

que usted está trabajando.  Cada vez que usted sale de GSLOPE, registra las localizaciones de los últimos 

archivos que usted trabajó, y los hace disponibles directamente en el menú de ARCHIVO y se abrirá la 

próxima vez en GSLOPE.   

 

3.1.7   UN EJEMPLO SIMPLE CON  REFUERZO EN TALUDES 

 

3.1.7.1   Definiendo la geometría 

 

La geometría podría ser creada dibujando con el cursor del ratón, según lo descrito en el primer ejemplo y 

es la manera más general para que los datos sean ingresados.  Sin embargo, para mostrar el procedimiento 

en este ejemplo la geometría será definida incorporando coordenadas.   

 

Antes de incorporar cualquiera de los datos, obtenga un dibujo o haga un bosquejo que muestre la sección 

representativa que usted desea analizar, y marque las coordenadas principales en ella. Una sección 

transversal del ejemplo se muestra a continuación:  
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Arena arcillosa

Limo arcilloso

Arena arcillosa

Limo arcilloso

Arena arcillosa

Limo arcilloso
 

 

Figura No. 3.8. Ejemplo de una sección transversal y sus coordenadas. 

 

 
 

La parte superior de cada material del suelo presente se define, mientras se activa una línea desde la 

izquierda a la derecha de la geometría.  El ancho real de la geometría usada no afecta el cálculo. Sin 

embargo, la salida gráfica de la sección representativa cabe generalmente lo mejor posible en la página 

cuando el ancho de la geometría es cerca de 5 a 10 veces el cambio de la elevación superficial del terreno 

a través de la geometría.  En este ejemplo, la geometría se extiende de X=-5 m. a X=40 m. Todos los 

materiales y las superficies piezométricas deben, por lo tanto, comenzar en X=-5 y terminar en X=40.  El 

primer material representa normalmente el que se encuentra inmediatamente debajo del perfil superficial 

del terreno.  En el ejemplo, el primer material, arena arcillosa, tiene 4 puntos como sigue:   

 

 

 
 

 

 

Los puntos se arreglan en el orden del aumento de las X-coordenadas, y cada punto que se consigue en un 

material dado debe tener un mayor valor en la X-coordenada.  La diferencia entre los puntos que se 

consigue se fija generalmente en 0,05 unidades o más.  Los Taludes (ó desniveles) pueden fallar de 

izquierda a derecha o de derecha a izquierda, aunque el defecto que fija para la opción del segmento 

(véase la sección 3.8.5) se satisface mejor a los taludes (desniveles) que fallan de izquierda a derecha 

como en este ejemplo.   
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En este ejemplo simple, el segundo material representa el suelo de fundación. El perfil que representa la 

superficie de este material tiene apenas dos puntos como sigue:  

 

 

 
 

 

 

3.1.7.2   Incorporando los datos del header (encabezamiento) 

 

Todos los datos se pueden iniciar y ser corregidos ya que existe un fichero de datos.  Para comenzar, elija 

File>New, a continuación Edit>Header, después complete los datos apropiados en los cinco campos 

superiores según lo demostrado abajo.  Esta información superior aparecerá en diagramas y listado, pero 

no toma ninguna parte directa en el análisis.   

 

 
 

Ancho Máximo de la rebanada 

 

El ancho máximo de la rebanada (slice) afecta el número de las rebanadas verticales en las cuales el talud 

será dividido para los propósitos del cálculo. Se puede dejar este espacio en blanco y el programa asumirá 

un valor de 1,0. También puede regresar y cambiar el valor más adelante en caso de necesidad.   
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Número de las capas del suelo  

Es necesario incorporar el número correcto de los materiales en la geometría del talud, introduzca el 

número 2 en este campo.  Es posible agregar, suprimir, e insertar los materiales más adelante.   

 

Aceleración sísmica  

La carga sísmica no se considera en este ejemplo, así que introduzca cero para el coeficiente sísmico o 

deje este espacio en blanco del campo.   

 

No.  de fuerzas externas  

No hay fuerzas externas en este ejemplo, así que introduzca cero aquí.   

 

Las superficies piezométricas  

El ejemplo tienen solamente una superficie piezométrica para todos los materiales, así que introduzca 1 

para el número de superficies piezométricas.   

 

Unidad del peso de agua  

El valor que ingresa en este campo define el sistema de las unidades que se utilizarán en el análisis.  Si el 

ejemplo está en unidades métricas, incorpore el valor 9,81 como el peso de unidad de agua en kN/m3.  

Esto significa que toda unidad de peso debe estar en kN/m3, las coordenadas deben estar en metros, 

cohesiones en kPa,  fuerzas externas y fuerzas del refuerzo en kN por metro de ancho.  Si el ejemplo 

hubiera utilizado unidades inglesas, usted habría introducido 62,4 como la unidad de peso del líquido en 

lb/ft3.  En este caso, todas las unidades de pesos se encuentran en  lb/ft3, las dimensiones en pies, la 

cohesión en psf y fuerzas del refuerzo en  libra por pie de ancho.   

 

Para utilizar las unidades de kilogramo fuerza (kp), incorpore el valor 1000 como el peso de unidad de 

agua en kp/m3.  Todas las unidades de peso tendrán que estar en las mismas unidades, las coordenadas en 

metros, la cohesión en kp/m2 y fuerzas en kp por metro de ancho.   
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El número (No.)  de las capas del refuerzo, es el número de capas del refuerzo geosintético en la sección 

representativa.  Usted puede dejar este valor en cero por ahora, pues agregaremos el refuerzo 

gráficamente más adelante.  

 

FoS contra Reinf.  Pullout (Desgarramiento) 

El factor de seguridad contra el desgarramiento del refuerzo, incorpora un valor de 1,5.  Observe que esto 

no está aplicado a la fuerza del refuerzo, pero afecta en algo  el control en la cual la tensión se asume para 

acumularse con la distancia del final del refuerzo.  Cuando ha terminado con la ventana del header, pulsar 

en la opción Materials (materiales) e ir directamente a la ventana Material Properties (propiedades del 

material).   

 

3.1.7.3   Ingresando propiedades de los materiales 

 

Los valores de la unidad de  peso representan la unidad total de peso de cada uno de los materiales bajo 

condiciones previstas, es decir los valores incluyen el peso de cualquier humedad presente en el suelo.   

 

En este ejemplo, ambos suelos asumen tener las mismas condiciones piezométricas, así que introduzca 1 

para la superficie piezométrica aplicable de cada suelo.   

 

 

 
 

Figura No. 3.9. Ventana de datos y propiedades de los materiales. 
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3.1.7.4   Ventana de la geometría  

 

Dar click en Geometry (geometría), a continuación se  exhibe una ventana e ingresar las coordenadas del 

material de la capa superior, arena arcillosa, como (-5, 5), (20, 5), (25, 0), y (40, 0).   

 

 
 

Figura No. 3.10. Ventana coordenada de la geometría de los materiales. 

Dar click  en siguiente (next) e incorporar dos coordenadas para representar el segundo material, limos 

arcillosos (Silty Clay).  Las coordenadas son (-5, 0) y (40, 0).   

 

Ingrese las coordenadas de la superficie piezométrica  después de ser activada la etiqueta en la opción 

"Piezo Surface No. 1" de lista de propiedades de los materiales.  Ingrese las coordenadas siguientes: (-5, 

3), (10, 2), (15, 1), (19, 0), (40, 0).  Presione OK. 

 

Usted puede mejorar la vista de la geometría seleccionando Set>Extents y fijando Y-coordenada de la 

base a -2.  

 

También, comprobar la caja etiquetada "Suprimir coordenada de la base por defecto".  En este punto, es 

importante guardar su trabajo ya que no se ha definido ningún nombre para este archivo, elija File>Save 
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as..., entonces edite la actual especificación del archivo para guardar los datos en un archivo llamado 

RE1.GSL.   

 

 

 
 

Figura No. 3.11. Ventana límites de extensión de la geometría. 

 

 

 
 

Figura No. 3.12. Visualización gráfica de la geometría y propiedades mecánicas de los materiales. 
 

 

 

3.1.7.5   Especificaciones  del refuerzo  
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Draw>Reinforcement, seleccione  y dibuje una sola capa del refuerzo de 6 m de largo en la elevación 0.2.  

No se preocupe  si lo hace a la derecha de la elevación exactamente, o de marcar el refuerzo al final de la 

cara del talud, concentrando justamente en conseguir a la derecha de la longitud.  Podría por ejemplo ser 

dibujada en la elevación 0.2, extendiendo de X=20 a X=26.   

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 
 

Figura No. 3.13. Visualización gráfica del refuerzo geosintético y nivel piezométrico. 

 

 

 

Usted podría ahora dibujar más capas del refuerzo, pero es más fácil y más exacto utilizar la ventana que 

corrige el refuerzo. Elija Edit>Reinforcement para exhibir el cuadro que corrige el refuerzo.  Mostrar la 

posición izquierda y derecha, y la elevación para la primera capa del refuerzo que usted acaba de dibujar.  

Dependiendo de los ajustes rápidos actuales (véase la sección 3.3.2) usted puede corregir la elevación 

para conseguir Y = 0,2.   
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Figura No. 3.14. Ventana ingreso de datos y propiedades admisibles del geosintético. 

 
 

 

Pulse Add, para agregar una capa del refuerzo.  GSLOPE asume para comenzar que tiene el mismo X1 y 

X2 coordenadas como capa 1, y adopta una  diferencia en Y-coordenada de 0,9 m, es decir en Y = -0,7. 

Corrija la coordenada Y de la segunda capa del refuerzo para mostrar un valor de 0.6.  Ahora arrastre el 

refuerzo con la opción edit reinforcement de modo que la mayor parte del mismo, se encuentre del lado 

izquierdo de la pantalla. Ahora usted puede ver las dos capas del refuerzo exhibidas en la sección 

representativa.   

 

De click en Trim para mover las capas del refuerzo que interceptaran con la cara del talud (desnivel).   

 

Presione agregar (Add) cuatro veces las capas del refuerzo.   

 

Si deseamos agregar seis capas con una  longitud de 5 m. La manera más fácil de hacerlo es pulsar en 

agregar (Add) dos veces más, pulsar (cliqueamos) en la caja de chequeo  etiquetada   "Mostrar las 

longitudes", y cambiamos las longitudes de las capas 7 y 8 a partir de 6 m a 5 m. Entonces pulsar en 

ajuste (Trim) una vez más y el tecleo agrega cuatro veces más las cuatro capas finales.   
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Como se ha visto, si solamente una capa del refuerzo está presente, el boton agregar por defecto para un 

espaciamiento del refuerzo de 3 pies o de 0,9 m, dependen del peso de unidad de agua detallado en el 

cuadro del encabezado (Header).  Si dos o más capas del refuerzo están presentes, agregue a las 

aplicaciones el mismo espaciamiento que las dos capas anteriores.   

 

El refuerzo se especifica actualmente con una tensión permisible de 1 kN por metro de ancho.  Para la 

primera capa del refuerzo, cambie el valor permisible de la tensión a 6,7 (kN/m), que representa por 

ejemplo el tejido HP500.  Copie el valor a las otras capas del refuerzo pulsando repetidamente once 

veces.  

 

 Cierre la ventana que edita el refuerzo.   

 

3.1.7.6   Especifique una búsqueda de rejilla. 

 

 Seleccione Draw>Grid of Centres (rejilla de centros) y defina una rejilla pulsando en aproximadamente 

(22, 6) y (27, 11).  Utilice Draw>Range of Tangents para definir un rango de tangentes de Y=0 a Y=-2. 

Press Shift-F9 o seleccione Analyse>Calculate para ver las coordenadas de la rejilla elegida.  Cambie el 

X-incremento y el Y-incremento a 1, y en la opción número de pasos digite el valor de 5 en X y Y. Click 

OK para calcular.  

 

Usted puede presionar Ctrl-W y definir las esquinas opuestas de una ventana ampliada para una vista más 

cercana de la superficie de falla.  Usted puede también seleccionar View>Preferences y agregar límites de 

la rebanada (slice) y contornos del factor de seguridad para ser visualizados.   

 

Presione Ctrl-A para volver a visualizar la geometría completa.   

 

3.1.7.7   Opción de Henry: Los círculos a través de un punto dado  
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Si usted desea limitar una búsqueda particular a las superficies de falla que pasan a través de un punto 

dado tal como el pie de un talud (desnivel) o quizás del final de la capa más baja del refuerzo enterrado, 

usted puede utilizar la opción Henry’s.   

 

Seleccione el punto con la opción de Draw>Henry’s y de click en el pie del talud en X=25, Y=0. Presione 

Shift-F9 para obtener la caja de diálogo de la rejilla, y observe que el programa ha comprobado la caja de 

chequeo de la opción Henry’s.   

Click en OK para calcular y proceder con el análisis.   

 

Si ha presionado F9 en vez de Shift-F9, el análisis habría procedido inmediatamente. 

 

3.1.7.8   Agregando una sobrecarga  

 

Intente agregar una sobrecarga del 10 kPa a la geometría existente.  Seleccione de Edit>Material 

Properties (Propiedades del material), compruebe que en la tabla la celda actual se encuentra en la línea 

superior, y seguido pulse la opción Duplicate Material (material duplicado) para agregar un material 

adicional en la superficie del terreno.   

 

Para el nuevo material adicional, cambie el nombre  "arena arcillosa" a "sobrecarga de 10 kPa", fije la 

unidad de peso a 100 kN/m3, la fricción y la cohesión a cero.  Para evitar cualquier confusión, fije el 

número de la superfice piezométrica también a cero, aunque no afectará el cálculo en este caso.  

 

De click en la opción geometría > para visualizar la ventana correspondiente a esta opción.   

 

Para el material de la sobrecarga, cambie la primera coordenada de (-5, 5) a (-5, 5.1) y mueva el enfoque 

a la segunda coordenada, (20, 5).  De click en el punto del relleno para insertar un punto adicional y 

corrija el punto No. 2 , para convertirse en  (19,9, 5,1).  Usted ha creado con eficacia una capa pesada fina 

con la fuerza cero, equivalente a una sobrecarga 10 KPa.  Pulsar (OK) para cerrar la ventana de la 

geometría. 
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3.1.7.9   Inmersión del pie  

 

Modificaremos la geometría para representar una situación donde la profundidad de un metro del agua 

cubre el pie del talud (del desnivel).  Primero, insertamos el agua como el material de más alta posición.  

En  Edit>Material Propiertes (Propiedades del material), seguidamente la opción Duplicate Material 

(Material Duplicado). Cambie el nombre del material del nivel mas alto por agua, con un peso de unidad 

de 9,81 kN/m 3,  = 0°, y c = 0 kPa.  Fije el número superficial piezométrico y el valor del Ru para este 

material a cero.   

 

Usted ahora ha insertado el agua como el material en el nivel mas alto, pero tiene espesor cero en todos 

los puntos a través de la geometría. Para hacer una superficie libre del agua en la elevación Y = 1, dibujar 

una línea de construcción horizontal en Y = 1, es decir lo dibuja de (-5, 1) a (40, 1).  Después elija el agua 

de Other>Fill/ únicamente Material 1 y presione Construct (Construir) para crear la superficie libre del 

agua. 

 

La superficie piezométrica existente No. 1 representa una situación donde la filtración del backslope 

(contra desnivel) es interceptada por un dren cerca de la parte posterior del refuerzo, y no es probable que 

sea compatible con la existencia de un metro de agua acumulada en el dedo del pie.  Para hacer las 

condiciones piezométricas más realistas, cambie las coordenadas de la superficie piezométrica No. 1 al 

siguiente:   

 

 

 
 

 

 

Usted puede hacer esto por cada uno de la siguiente manera:   
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(a) Seleccione Edit>Geometry para visualizar la ventana de la geometría.  De click en Next (siguiente) 

varias veces para exhibir las coordenadas de superficial piezométrica No. 1. Corrija las 

coordenadas existentes según lo demostrado arriba.   

(b) Seleccione Draw>Piezo Surfaces>Piezo No. Superficial No. 1.  De click en cada uno de las 

coordenadas según lo demostrado arriba.  Usted tendrá que fijar el snap (ingreso) para Y-

coordenada a 0.5 para poder especificar las coordenadas del primero y del tercero exactamente.  

Alternativamente, puede ser más simple conseguir todas las coordenadas correctas al número 

entero más cercano, después corrige los valores del primero y  tercero  de Y-coordenada según lo 

requerido.   

(c) Utilice Point/Move seguido por medio del mouse o las teclas del cursor, según lo descrito en la 

sección 2.5.  Fijar el ingreso de Y-Coordenada  a 0.5 para que sea exacto.  

 

Si usted activa un análisis con esta geometría, observará que la superficie de falla pasa verticalmente a 

través del agua.  Lo anterior  conduce a una fuerza horizontal  debido a la presión del agua contra el 

límite expuesto de la rebanada.  Usted no necesita tener en cuenta ninguna situación especial para esta 

fuerza, pues es considerada por el programa.   

 

3.1.8   MODIFICANDO LA GEOMETRÍA  

 

3.1.8.1   Moviendo, suprimiendo, o insertando un punto  

 

Es posible cambiar la posición de un punto respecto de una superficie de material, superficie piezométrica 

o superficie especifica de falla, seleccionando Edit/Geometry y después manualmente modificando las 

coordenadas mencionadas.  De igual forma, puede insertar o suprimir un punto, insertando y suprimiendo 

una línea en la tabla de coordenadas.  Sin embargo, es mucho más fácil utilizar Point/Move, Point/Delete, 

o Point/Insert y realizar estas operaciones gráficamente.  El uso de estas características se describe en la 

sección 3.6.   

 

3.2 LAS OPCIONES PRINCIPALES DEL MENÚ  
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Esta sección proporciona una lista de referencia de las funciones principales del menú.   

 

3.2.1   El menú de ARCHIVO  

 

 
 

Figura No. 3.15. Ventana de la barra de Menú Archivo. 

 

 

 

3.2.1.1  File> New 

 

Esta opción despeja el actual análisis y los reajustes de la mayoría de los parámetros del programa a sus 

valores prefijados.  Por supuesto cualquier cambio del archivo que usted requiera conservarlos debe ser 

guardado antes de seleccionar la nueva opción. 

 

3.2.1.2  File>Load  

 

Esta opción se utiliza para leer un fichero de datos del disco existente en GSLOPE.  Los ficheros de datos 

de GSLOPE se identifican con la extensión .GSL.  Esta extensión se agrega a cualquier nombre de las 

fuentes del usuario.  La versión del DOS de GSLOPE utiliza el mismo formato de archivo.   
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Una vez que se haya cargado un archivo, puede ser modificado de cualquier manera y el análisis puede 

proceder sin el acceso adicional al archivo en disco.  Esto significa que usted puede invertir a la versión 

guardada pasada del archivo simplemente recargándolo.   

 

3.2.1.3  File>Save  

 

La opción de guardar escribe el análisis actual al disco, incluyendo todo lo corregido.  Para prevenir un 

accidental renombramiento  de un archivo existente, se solicita confirmación de la operación de la 

escritura.  Si usted desea guardar a un nuevo nombre de fichero, utilice como opción guardar como según 

lo descrito abajo. 

 

Observe que los resultados de un análisis no están guardados normalmente al disco, pues pueden ser 

reconstruidos rápidamente cargando y funcionando el fichero de datos del cual los resultados fueron 

producidos.  

 

3.2.1.4  File>Save As  

 

Est opción permite que  guarde su trabajo bajo un nuevo nombre de fichero, o que defina un nombre si 

aun no existe todavía.  Se agrega la extensión .GSL si usted no la especifica.  Si existe un archivo del 

mismo nombre será sobrescrito.   

 

3.2.1.5  File>Graphics to Clipboard 

 

Esto copia al portapapeles de Windows todos los elementos gráficos demostrados actualmente en la 

pantalla.  El gráfico que resulta se puede entonces pegar en otro uso tal como un procesador de textos.  

Esta operación es realizada típicamente seleccionando la "pegado especial" y eligiendo pegar un cuadro.   

 

3.2.1.6  File>Export  Metafile 
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Esencialmente representa la misma operación de copiar los gráficos al portapapeles de Windows, excepto 

que la información está escrita a un metafile de los gráficos de Windows.  Se utiliza esto principalmente 

cuando el destino está en otra  máquina.   

 

3.2.1.7  File>Print Input 

 

Esta opción permite visualizar una ventana que muestra los datos de entrada como una tabulación para el 

análisis actual. Puede examinar los datos o imprimirlos.  La fuente usada para el listado está según lo 

definido bajo tabulaciones de Set>Font>Printer.  Si necesita más control sobre el aspecto de la salida, 

elija copiar y después pegue el texto en un procesador de textos.  Se recomienda un ancho de fuente para 

la alineación apropiada del listado.   

 

3.2.1.8  File>Print Graphics 

 

La opción imprime la geometría actual.  Las preferencias actualmente seleccionadas de visualización son 

incluidas.  La fuente usada es la que esta definida debajo de los gráficos de Set>Font>Printer.  Un campo 

opcional se proporciona para indicar un dibujo o un número de figura, que se indica en la esquina 

inferior-derecha de la salida impresa.  No es normalmente visible en la pantalla,  puede ser visto al 

realizar una reducción de la imagen con la opción  (ctrl. -O).  

 

3.2.1.9  File>Print Results 

 

Exhibe una tabulación de los resultados del último cálculo realizado.  La tabla puede ser examinada, ser 

copiada al portapapeles, o ser impresa.  La fuente usada para el listado es la que esta definida bajo 

tabulaciones de Set>Font>Printer.  Se recomienda que una fuente de paso fijo tal como (guía) esté 

utilizada, caso contrario las columnas en la tabla aparecerán desiguales.   

 

3.2.1.10  File>Exit  
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Esta opción sale del programa.  Antes de parar el programa, le piden confirmar que usted haya guardado 

cualquier cambio a su fichero de datos.  

 

3.3 PREPARAR (SETIANDO) EL MENU  

 

 

 
 

Figura No. 3.16. Ventana de la barra de Menú Preparar (Setiar). 

 

 

 

3.3.1  Set>Extents  

 

Si en sistema no se carga  ningún set de datos válido, los valores incorporados a Set>Extents son usados 

para definir las coordenadas mostradas en la pantalla.  Esta opción se utiliza típicamente momentos antes 

de comenzar a dibujar una nueva estratigrafía.   

 

3.3.2  Set>Snaps  

 

Los valores de entrada se utilizan como una base para redondear las coordenadas creadas en el dibujo.  

Los valores entrada omiten 0.1 unidades en cada una de las coordenadas X y Y.   

 

3.3.3  Set>Preferences  
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Esto permite  seleccionar cuales aspectos deben aparecer en la pantalla y en gráficos impresos.  Estos 

ajustes están también conforme a ajustes automáticos en respuesta a ciertas opciones del menú.  Por 

ejemplo, si dibuja un punto con la opción Henry’s point, será asumido que usted requerirá que sea visible.   

 

3.3.4  Set>Contours  

 

Esto fija el intervalo del contorno utilizado al trazar contornos del factor de seguridad, y limita el rango de 

los contornos que se visualicen.  La caja de control de los contornos mostrada en esta ventana es idéntica 

a lo que muestra la ventana de la opción preferencias.   

 

3.3.5  Set>Font  

 

Especifica las fuentes que se utilizarán para la exhibición de la pantalla y la salida de impresora.  Se 

recomienda que las exhibiciones tabulares y el listado utilicen una fuente de paso fijo tal como Courier 

New para evitar columnas irregulares.   

 

3.3.6  Set>Method  

 

Esta opción permite que usted especifique el método de análisis.  El método de Bishop Modificado se 

aplica como defecto.  El método simplificado de Janbu es similar al método de Bishop  Modificado; en el 

cual el esfuerzo de corte se asume  cero entre las rebanadas (slices) adyacentes.  Esto significa que las 

tensiones verticales en las bases de la rebanada son similares en ambos métodos.  La diferencia entre los 

dos métodos se presenta en el cálculo del equilibrio total.  El método del Bishop hace uso del momento de 

equilibrio  sobre un centro de rotación, mientras que el método de Janbu se basa en el equilibrio de fuerza 

horizontal.  

El factor (fo) refleja una corrección propuesta por Janbu (1956), basado en la relación de la profundidad 

respecto a la longitud de la superficie de la falla y principalmente si los materiales son  fricciónales o 

cohesivos. GSLOPE calcula la relación de la profundidad respecto de la longitud, d/c, según lo 

demostrado abajo.  El factor (fo) entonces se calcula como:   
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Esto es un acuerdo entre los valores propuestos por Janbu para los materiales cohesivos y fricciónales, y 

se asemejan al acercamiento usado por Fredlund (1978).  El valor del fo nunca es menos de 1,0 y excede 

raramente de 1,1.  Observe que el método simplificado de Janbu (sin factor del fo) es funcionalmente 

equivalente al método de la cuña.  

 

 

 

 

 
 

Figura No. 3.17. Relación de la profundidad respecto de la longitud, d/c, para el factor fo (Janbu). 

 

 

 

 

3.3.7  Set>Advanced  

 

Esta opción permite cambiar el límite de M-alfa y el número máximo de las rebanadas (slices) usadas 

para el análisis.   M-alfa se menciona en la sección 3.11.7.  

 

 

3.4 MENÚ VISTA  
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Figura No. 3.18. Ventana barra de Menú Visualizar. 

 

3.4.1  View>Zoom  

 

View>Zoom>Window define una porción de la geometría que se desplegará hasta ocupar la ventana 

llena.   

 

View>Zoom>Previous invierte a la visión inmediatamente anterior.   

 

View>Zoom>In centra la atención sobre un punto que usted escoge y dobla la escala actual de la 

exhibición.   

 

View>Zoom>Out reduce la escala actual de la exhibición por el 20%.   

 

View>Zoom>All restablece la exhibición por defecto, donde el ancho completo de la geometría se exhibe 

junto con las etiquetas del eje.   
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3.4.2  View>Pan  

 

Permite escoger dos puntos.  El primer click elige un punto arbitrario en la geometría.  El segundo click 

indica en la pantalla la localización donde va a  ser exhibido el primer punto.   

 

3.4.3  View>One Material  

 

Esta selección se limita únicamente a la exhibición del primer material, ya sea suelo, agua, o sobrecarga.  

En ocasiones es útil para encontrar errores en la geometría.  Para agregar cada material alternadamente 

pulsar click en la barra inferior de la pantalla.   

 

3.5 MENÚ DIBUJAR  

 

 
 

Figura No. 3.19. Ventana barra de Menú Dibujar. 

 

De las operaciones de dibujo descritas a continuación, también se puede  corregir directamente las 

coordenadas con la opción EDIT del menú principal. Es frecuente  primero dibujar aspectos de manera 

aproximada, luego corregir las coordenadas resultantes si se requieren  valores exactos. 

 

3.5.1  Draw>Soil Layers  
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Dibuje las capas del suelo en el orden 1, 2, 3, etc.  El primer punto en cada capa del suelo debe tener la 

misma X-coordenada, correspondiendo al borde izquierdo de la geometría.  Cada punto en una superficie 

dada del suelo debe tener una X-coordenada mayor que la anterior.  Ningún punto en cualquier superficie 

del suelo  se debe situar sobre la línea que define la cubierta de la capa anterior del suelo.    Si usted 

dibuja las superficies en orden consecutiva, las reglas antes dichas son cumplidas por el programa 

mientras se dibuja cada punto.  Si usted comete un error, usted puede deshacer el punto anterior haciendo 

click  el botón derecho del mause.   

 

3.5.2  Draw piezo surfaces 

 

Las superficies piezométricas deben obedecer las mismas reglas que las capas del suelo, excepto que 

están permitidas cruzarse unas a otras.  Pueden por lo tanto ser dibujadas en cualquier orden.   

 

3.5.3  Draw>Specified slip surface 

 

La superficie especificada del deslizamiento no tiene que comenzar en el borde izquierdo de la geometría, 

sino que debe comenzar sobre la superficie de tierra.  La X-coordenada debe permanecer creciendo con 

cada punto sucesivo.  El punto final en la superficie especificada del deslizamiento también debe estar 

sobre la superficie de tierra.  Después de dibujar el punto pasado, presione el botón derecho del mause 

para indicar al programa que la operación de dibujo está  completa.   

El dibujo de una superficie especificada del deslizamiento apaga a la exhibición de la rejilla de centros, 

rango de tangentes y el punto de la opción Henry’s.   

 

3.5.4  Draw> Línea de Construction  

 

La línea de construcción está conforme a las mismas reglas que las superficies piezométricas, esto se debe 

a que puede cruzar el ancho completo de la geometría, también extenderse sobre varias superficies de  

materiales, incluyendo la superficie de tierra.  La superficie de construcción se fundamenta para una 

última construcción, excavación, o relleno (véase la sección 3.9), simplificando así la creación de una 

geometría compleja con muchos puntos de  intersección.  
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3.5.5  Draw>External Forces 

 

Puesto que el análisis es de dos dimensiones, las “Fuerzas Externas” efectivamente significan “línea de 

cargas”.  Cuando dibuja una fuerza externa, el primer punto elegido es el punto del uso de la fuerza (la 

extremidad de la flecha).  El siguiente punto define la dirección desde el cual la fuerza se origina (la cola 

de la flecha).  La magnitud de la fuerza se ingresa desde el teclado.  Las unidades de la fuerza dependen 

del sistema de unidades en uso (véase la sección 3.1.5.1.1).  Observe que todas las magnitudes de la 

fuerza se puede exhibir en gráficos comprobando la opción apropiada debajo de Set>Preferences.  Si 

usted desea exhibir las magnitudes solamente de algunas fuerzas, vea el primer párrafo de la sección 3.6.  

 

3.5.6  Draw>Reinforcement  

 

Esto opción permite dibujar una capa del refuerzo.  Las capas del refuerzo se asumen para ser 

horizontales, con la elevación fijada por el primer punto dibujado.  Los taludes (desniveles) reforzados 

tienen típicamente varias capas del refuerzo en intervalos regulares.  Después de que la primera capa haya 

sido dibujada, es más fácil y más exacto definir cualquier capa adicional usando las funciones para 

construir  el refuerzo con la opción Edit  Reinforcement.   

 

3.5.7  Draw>Grid of Centers 

 

Define los centros de esquinas de una rejilla que se utilizarán en una búsqueda para el factor de seguridad 

más bajo.  La solicitación de esta opción también apaga  la exhibición de la superficie especificada.  

 

3.5.8  Draw>Range of Tangents 

 

Permite escoger un rango de elevaciones para utilizar como líneas de  tangente en la limitación del rango 

de los radios usados en una búsqueda regular de la rejilla para el factor de seguridad más bajo.  El uso de 

esta opción apaga la exhibición del punto de la opción Henry’s.  
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3.5.9 Draw>Henry’s Option Point 

 

Esta opción permite escoger un punto a través del cual todas las superficies circulares deban pasar.  El 

punto de la opción Henry’s  se visualiza como la forma de un diamante.  El uso de esta opción apaga  la 

exhibición del rango actual de tangentes.   

 

3.6 MENÚ PUNTO  

 

 

 
 

Figura No. 3.20. Ventana barra de Menú Punto. 

 

 

 

3.6.1  Point>Move 

 

Esta opción proporciona la manera más fácil de modificar una geometría existente.  Para mover un punto 

en un material de superficie, primero elija la opción  Point>On a Material y verifique una marca de 

chequeo junto a esta opción.  Después seleccione Point>Move y utilice el mause para cliquear el punto 

que desea moverse.  Cuando se elige un punto, se resalta una casilla negra pequeña.  Si no hay un punto 

próximo al cliquear, no aparecerá resaltado.  Si sucede esto, mueva el cursor más cercano al punto 

deseado, y de click  otra vez.  Una vez que se haya seleccionado un punto, usted puede indicar la nueva 

posición deseada chascando respecto a la nueva posición deseada del punto y/o usando las teclas de 

cursor para ajustar su posición.  El movimiento producido presionando una tecla de cursor es controlado 

por los valores rápidos para las direcciones de X y de Y.  Estos valores pueden ser cambiados usando 

Set/Snaps.  Observe que las coordenadas actuales del punto seleccionado, junto con los gradientes de las 
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líneas a los puntos vecinos se muestren en la caja que aparece en la parte superior de la pantalla.  Presione 

ESC (salida) o el botón derecho del ratón cuando  se ha terminado el ajuste de la posición.   

 

3.6.1.1  Usando ctrl.  

 

Se utiliza para aumentar el tamaño de paso. Presionando Ctrl-Up, Ctrl-Down, Ctrl-Izquierda y Ctrl-

Derecha el punto seleccionado causa movimiento en incrementos de cinco veces los valores fijados 

actualmente en la opción snaps en las direcciones de X y de Y.   

 

3.6.1.2  Usando Shift 

 

Se utiliza para cambiar a un punto diferente; no necesita usar el mause para seleccionar cada punto que se 

mueve.  Una vez que un punto se haya resaltado para moverse, se puede cambiar el enfoque a otros 

puntos como sigue a continuación:   

 

Shift – Left   El punto cambia a la anterior posición izquierda en el mismo material.    

Shift – Right   El punto cambia a la siguiente posición derecha en el mismo material.  

Shift – Up  El punto cambia de posición a un sitio más cercano del material superior. 

Shift- Down  El punto cambia de posición a un sitio más cercano del material inferior.   

 

Estos  dos métodos (las teclas del ratón o de cursor) permiten mover el punto a cualquier parte, incluso las 

posiciones que estén sobre la superficie del material sobrepuesto, o debajo del material subyacente.  Es 

posible  recibir más adelante un mensaje con respecto a los errores de las coordenadas cuando se  ejecute 

el análisis o al utilizar la opción Edit/Check Data.  Los errores (menores) que se consiguieron asociar al 

redondeo son corregidos automáticamente por el chequeo de datos que ocurre antes de cada  análisis.  Los 

errores grandes pueden ser racionalizados seleccionando Edit/Resolve Crossovers.  Si algún material se 

encuentra para resaltar sobre un material sobrepuesto, el material más bajo se ajusta. 

 

3.6.1.3  Usando  Alt  
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Cuando los materiales comparten un punto común a menudo el punto seleccionado tiene coordenadas 

idénticas en más de una superficie del material.  Si selecciona el punto directamente con el ratón, el punto 

real seleccionado es el que está en el más importante de los materiales que comparten un punto común en 

esa misma posición.  Si usted entonces mueve el punto con teclas de cursor o un click del ratón, todos los 

materiales que comparten ese punto común serán afectados.  La regla es que los puntos más últimos en 

materiales numerados siguen normalmente el movimiento de puntos en materiales anteriores.   

 

Si hubiera tres materiales (1, 2 y 3) presentes en un punto, y desea bajar los materiales 2 y 3, dejando el 

material 1 imperturbado, primero seleccione el punto triple con un click en el ratón, después presione 

Shift – Down para cambiar el enfoque al material 2, después presione  Ctrl-Down para mover los 

materiales 2 y 3.   

 

Si  desea levantar únicamente el material más superior, puede dejar detrás los materiales más últimos  

presionando la tecla  Alt junto con la tecla ascendente.   

 

Observe que una vez que ha empezado a cambiar de posición un punto particular usando las teclas de 

cursor, puede " despejar hacia arriba"  puntos de los materiales superiores-numerados (pero no los 

materiales inferiores- numerados).  Esto significa que si desea mover un punto del material 1 y un punto 

del material 2 a un punto diverso pero común, debe comenzar usando las teclas de cursor para mover el 

punto del material 1 simultáneamente sobre la posición del punto deseado en el material 2.   

 

En resumen, cuando los puntos se mueven:  

 

Set>Snaps. 

Hace controles de movimientos rápidos por la pulsación. 

Ctrl-cursor. 

Marca el movimiento de los puntos en incrementos largos de 5x. 

Shift-cursor. 

Cambia el enfoque a partir de un punto o de un material a otro. 

Alt-cursor. 
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Separa y mueve únicamente el punto actualmente seleccionado.  

Shift-Delete. 

Anula el punto actual.  

 

3.6.2  Point>Insert  

 

Para insertar un punto adicional, elija la opción Point>Insert, seguido pulsar el botón en la superficie 

superior del material donde el punto será insertado. Un nuevo punto es creado y destacado por una 

pequeña casilla negra.  El nuevo punto está situado en la línea que usted seleccionó, excepto que sus 

coordenadas están redondeadas y apagadas en caso ser reflejados los valores rápidos de X y de Y.   

 

Sí no aparece una casilla negra, probablemente al pulsar no se encontraba muy cercano a una línea 

existente, así que intente pulsar el botón  otra vez.   

 

Si varios materiales son coincidentes a lo largo de la línea seleccionada, el nuevo punto se inserta 

únicamente en el más importante de estos materiales.  Cuando un punto se inserta de esta manera, el 

nuevo punto se trata como si acabara de ser seleccionado usando Point/Move.  Utilice las teclas del cursor 

o el ratón para mover el punto deseado. Presione ESC (salida) o el botón derecho del ratón para finalizar.  

 

3.6.3  Point>Delete  

 

Para suprimir un punto, elegir la opción Point>Delete y presionar en el punto que  desea suprimir.  Si 

varios materiales comparten el mismo punto, sólo el punto del material más importante se suprime.  Los 

puntos restantes pueden por supuesto ser suprimidos repitiendo el procedimiento.   

 

Si tiene más de un punto a suprimir, una mejor manera de eliminar es seleccionando el punto usando la 

opción Point>Move, y entonces suprimir el punto con la opción Shift – Delete.   

 

Puede continuar suprimiendo puntos presionando Shift – Delete repetidamente.  Recuerde presionar ESC 

(salida) o el botón de ratón derecho para finalizar.   
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3.7 MENÚ EDITAR  

 

 

 
 

 

Figura No. 3.21. Ventana barra de Menú Editar. 

 

 

3.7.1  Edit>Header  

 

Los primeros seis campos muestran la información del  proyecto en análisis; número de trabajo, fecha, y 

título del proyecto.  Esta ventana también define las características principales del análisis.  Observe que 

en los quinto y sextos campos usted puede insertar un código para mostrar el valor de una fuerza externa 

usando el formato F#xx, donde xx es el número de la fuerza externa.  Esto es útil cuando se varía fuerzas, 

por ejemplo para estimar la fuerza en una estructura de retención.  Esto es una alternativa de exhibir los 

valores de todas las fuerzas comprobando la opción "magnitudes de la fuerza" debajo de Set/Preferences.   

 

De los aspectos restantes en esta ventana, el más importante es el peso de unidad del agua, que es 

normalmente 9,81 o 62,4. Esta entrada determina el sistema de las unidades usadas por GSLOPE:   

Pesos de la unidad de agua  Unidades requeridas en el análisis 



Generalidades                                                                             ESPE – Carrera de Ingeniería Civil - 2007 

- 102 - 

 

 

 9.81 kN/m3    Distancia en metros 

      Cohesión en kPa 

      Pesos unitarios en kN/m3 

      Tensión permisible del refuerzo en kN/m 

 

 

 62.4 lb/ft3    Distancia en pies (ft) 

      Cohesión en psf 

      Pesos unitarios en pcf 
      Tensión permisible del refuerzo en lb/ft 

 

 

1000 kp/m3    Distancia en metros 

      Cohesión en kp/m2 

      Pesos unitarios en kp/m3 

      Tensión permisible del refuerzo en kp/m 

 

 

Max Slice Width  (ancho máximo de la rebanada) se utiliza para influenciar el número de las rebanadas 

usadas en el análisis - cuanto mayor es la anchura máxima, menos es el número de rebanadas.  La técnica 

por la cual los límites de la rebanada son elegidos se explica en la sección 3.11.  

 

No. Of Soil Layers (número de capas de suelo) muestran el número de los materiales presentes en la 

geometría.  Si el talud (desnivel) se sumerge parcialmente, el agua debe ser el primer material definido,  

exactamente con el mismo peso de unidad según lo definido en lo anterior,  cero  cohesión y fricción.  Las 

fuerzas  debido a la presión del agua en un cuerpo del agua libre se aplican automáticamente.  Si el agua 

libre no está presente, no debe ser incluida como material separado.  La presencia de las condiciones 

artesianas del agua se modela usando superficies piezométricas que puedan extenderse sobre la superficie 

de tierra y no requiere el agua como material separado.   

 

Earthquake Acceleration (aceleración del terremoto) se refiere a la aceleración sísmica, como un decimal 

de la gravedad, (ej: 0.05g) para ser utilizada en el análisis pseudo-estático del talud (desnivel).  Las 

fuerzas sísmicas se aplican horizontalmente, a través del centro de gravedad de cada rebanada (slices), en 

una dirección que reduzca el factor de la seguridad para la superficie de falla que es considerada y 

teniendo en cuenta cualquier carga aplicada.   

 

Piezometric Surface  (superficies piezométricas) definen el número de las superficies piezométricas que 

se considerarán.  Éste no necesita ser igual que el número de materiales en el análisis.  Cada material 
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puede tener su propia superficie piezométrica, una superficie piezométrica se puede compartir por 

cualesquiera o todos los materiales, o las superficies piezométricas se pueden omitir del análisis en 

conjunto.  La información adicional sobre la  presión del poro se explica en la sección 3.11.4.  

 

Unit Weight of Water  (peso de la unidad del agua)  es el peso de unidad que se utilizará en el cómputo 

las fuerzas  debido a las grietas de tensión llenas de fluido y las fuerzas  debido a la submergencia del 

talud (desnivel) y  eficazmente define el sistema de unidades que se utilizará en el análisis.  También se 

utiliza conjuntamente con las condiciones de cero cohesión y cero fricciones para identificar las 

condiciones sumergidas que exigen permitir una fuerza horizontal hidrostática para en el análisis.  Por 

esta razón es importante utilizar exactamente el mismo peso de unidad para el líquido del poro como para 

el agua que sumerge el pie de un talud (desnivel).   

 

Reinforcement Layers  (capas de refuerzo) indican cuántas capas de refuerzo están presentes en el 

análisis.  Esto es independiente en cuanto si el refuerzo tiene algún efecto en el resultado.   

 

FoS against Pullout (factor contra la extracción) factor usado en la determinación del enlace disponible 

entre el suelo y el refuerzo, según lo discutido en la sección 3.11.6.  No afecta directamente la fuerza 

máxima en el refuerzo.  Afecta a la longitud requerida para la fuerza máxima a ser desarrollada.   

 

3.7.2  Edit>Material Properties 

 

Las características de esta ventana es enumerar los nombres de los varios materiales (agua libre, 

sobrecarga, y capas del suelo) que forman la geometría del talud.  También muestra para cada material el 

peso de unidad total, el ángulo de  fricción, cohesión, el número de la superficie piezométrica que se 

aplica al mismo, su valor del Ru, y el coeficiente de la interacción del suelo-refuerzo.  Observe que el 

material 1 (en la parte superior de la lista) debe ser el material más alto de la geometría.  Si una superficie 

de agua libre está presente, el agua debe ser especificada como el material más alto, caso contrario sino 

presenta esta superficie de agua no se debe ser especificada como un material.  
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Si el material más alto es tratado como un líquido, únicamente su unidad de peso no es exactamente igual 

que  lo mostrado para el agua en el encabezado principal, sin efectuar nada se puede tener el material 

tratado como líquido incluyendo la secuencia "líquido" en el nombre del material.  La cohesión y el 

ángulo de  fricción del material debe ser también cero para que la condición líquida sea aplicada.  

Observe que las superficies de falla pasan verticalmente a través de líquidos.   

 

Si un material tiene su peso de unidad incorporado como -1, éste lo marca por medio de una capa dura o  

material " inferior duro", debajo del cual las superficies de falla no pueden pasar.  Un material "inferior 

duro"  se puede también utilizar para simular una capa débil, si una capa débil fina se pone simplemente 

sobre el.   

 

Ninguna parte del material 1 puede sumergir abajo del material 2, ninguna parte del material 2 puede 

sumergir debajo del material 3, etcétera.  Una comprobación para estas condiciones se hace cada vez que 

se realiza un nuevo análisis.   

 

Si el número de superficie piezométrica está cero o en blanco, el programa asume que no hay superficie 

piezométrica para este material.  Se asume que la presión del poro  debido a ninguna superficie 

piezométrica no puede ser negativa.  

 

El Ru es el coeficiente de la presión de poros ante el esfuerzo vertical total de la sobrecarga en cualquier 

punto.  Las contribuciones de la presión del poro de la superficie y del Ru piezométrico apropiados se 

agregan para el análisis, aunque sería inusual utilizar los dos métodos en combinación para el mismo 

material.  En el caso de un material que tiene la fricción cero y la cohesión cero, el campo del Ru se 

utiliza para denotar la magnitud al cual las grietas se llenan de agua (véase también la sección 3.11.2).  El 

principal uso del Ru está en estudios teóricos de la estabilidad del talud. Para el análisis de taludes 

(desniveles) reales, el Ru no es a menudo muy útil, principalmente porque la superficie piezométrica 

equivalente varía con la localización del plano de falla. 

 

3.7.3  Edit>Geometry  
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La ventana de la geometría muestra una tabulación de las coordenadas del perfil de la superficie superior 

de cada superficie de material y piezométrica, junto con la superficie especificada y la superficie de la 

construcción.  Las superficies del suelo no pueden cruzarse sobre uno mismo sino que pueden ser 

coincidentes.  Las superficies pueden no doblar detrás, (X-coordenadas deben aumentar siempre).   

Los taludes (desniveles) pueden fallar a izquierda o a derecha.  Todas las superficies deben comenzar en 

el mismo X-coordenadas y deben terminar en el mismo X-coordenadas.   

 

No hay problema de cómputo si la geometría se hace extremadamente ancha, pero el escalamiento 

automático usado para trazar proporcionará un cuadro demasiado pequeño del talud si se eligen las 

coordenadas ampliadas indebidamente.  De la misma manera, si el rango de X-coordenada usado es muy 

pequeño, y el talud (desnivel) sale como demasiado grande en los diagramas, la X-coordenada  puede ser 

extendida para hacer de la geometría un mejor juego con la página.  Todos los materiales y todas las 

superficies piezométricas se deben extender al mismo mínimo y máximo valor de las X-coordenadas.  

Una buena regla es hacer el ancho de la geometría 5 a 10 veces la altura del talud (desnivel).   

 

El programa asume que la geometría continúa horizontalmente más allá de los límites del rango dado de 

X-coordenada.  Esto significa que círculos demasiado grandes cuyas intersecciones superficiales de tierra 

del exterior de la capa y el rango dado de X-coordenadas todavía puede ser analizada a profundidad.   

 

3.7.4  Edit>External Forces 

 

Muestra el punto de la acción de cada fuerza externa, junto con sus  componentes horizontales (+ hacia 

abajo) y verticales (+ a la derecha).  Debido a que el análisis es en dos dimensiones, las fuerzas externas 

se expresan en  fuerza por unidad de ancho.  Esto corresponde a lb/ft de ancho si el peso de unidad de 

agua se ha ingresado como 62,4, y a kN/m de ancho si el peso de unidad de agua se ha ingresado como 

9,81.  Si el peso de unidad de agua se ha ingresado como 1000, las fuerzas externas se expresan en 

kilogramos fuerza por metro de ancho, o kp/m.   

 

3.7.5  Edit> Reinforcement Layers 
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GSLOPE permite  incorporar hasta 100 capas con refuerzo geosintético definiendo magnitudes 

horizontales, elevación y la tensión permisible (fuerza/unidad de ancho) en cada capa reforzada.  Se 

asume que todas las capas del refuerzo son horizontales.  X1 y X2 son X-coordenadas de los finales 

izquierdos y derechos del refuerzo.  Tallowable refleja la tensión permisible en el refuerzo y normalmente 

se asigna basado en valores promedios mínimos del rodillo de fuerza extensible con factores de reducción 

permitidos por arrastre, daño de la instalación, efectos del ataque químico y biológico sobre la vida de la 

estructura.   

 

Para facilitar la entrada de capas múltiples del refuerzo, la función Edit  incluye una facilidad de la 

interpolación.  Por ejemplo, asuma que usted desea ubicar el refuerzo geosintético en el espaciamiento 

vertical de 1,2 m entre la elevación de 94 m y de 100 m.  Primero, complete los detalles de la primera 

capa del refuerzo, es decir sus coordenadas horizontales X1 y X2, su elevación como 100 y la tensión 

permisible (Tallowable).  Entonces baje el cursor a la sexta línea y complete 94 para el valor de Y. Seguido 

pulsar  la tecla F8 e interpolará todas las zonas de informaciones que intervienen.  En este ejemplo, 

cualquier parámetro diferente a cero completado para el sexto refuerzo será utilizado como base para la 

interpolación.  Si cualquiera de las zonas de informaciones para el sexto refuerzo se indica como cero o 

en blanco, la función de la interpolación copiará simplemente los valores de la primera capa.   

 

El refuerzo que corrige la ventana Edit, está provisto de la función Trim, que ajusta la posición horizontal 

del refuerzo de modo que termine en la cara del talud y a su vez  agrega una capa del refuerzo 

extrapolando sus parámetros de las dos capas precedentes.  En cada caso, la presentación se actualiza 

inmediatamente con la nueva información, así que se puede visualizar exactamente lo qué está 

ocurriendo.   

 

El coeficiente de  interacción  suelo/geosintético para cada suelo se incorpora en la ventana características 

del material.  Si el análisis no incluye el refuerzo, esta columna no se utiliza y puede simplemente ir en 

blanco.  La información adicional sobre cómo el refuerzo se incorpora en el análisis se puede encontrar en 

las secciones 3.11.6 y 3.11.7.   

 

3.7.6  Edit>Check  
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Esta opción tiene tres etapas;  primero comprueba que todo el material y superficies piezométricas tengan 

como primera y última X-coordenada el material 1 y para el resto de las superficies las X-coordenadas 

aumente con cada punto subsiguiente. Si no se encuentran errores en X-coordenada, la etapa siguiente 

verifica intersecciones de  Y-coordenadas sobrepuestas, debido a que cada material subsiguiente debe 

quedar  completamente bajo el anterior.  Cualquier error detectado en las coordenadas se enumera.  Si el 

chequeo coordinado es acertado, las características de materiales se comprueban para considerar que 

estén dentro de un rango razonable y cualquier condición muy inusual se enumera en la pantalla.  El 

programa puede funcionar sin este chequeo de datos, pero definitivamente se recomienda su uso.  Si no se 

encuentran errores en el archivo de datos, la pantalla muestra la siguiente observación: 

 

 
 

Figura No. 3.22. Ventana Chequear Datos ingresados. 

 

 
Si el programa detecta errores geométricos tales como superficies que se cruzan encima o tenga X-

coordenadas qué disminuyen, rechazará y accionará un análisis hasta que se rectifique el problema.  Si la 

rutina del chequeo detecta los parámetros materiales que están fuera de los rangos normales, exhibirán 

una advertencia, pero siempre permitirán que proceda un análisis.  Los errores geométricos pequeños  
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debido al redondeo se corrigen probablemente automáticamente.  Cuando ocurre esto aparece el mensaje 

"ningún error incorregible es detectado en geometría".   

 

3.7.7  Edit>Resolve Crossovers 

 

Para un análisis válido, un material más bajo nunca debe levantarse sobre la cobertura de un material 

superior, es decir el material 2 no debe tener ningún punto que descanse sobre el material 1.  Las 

infracciones de menor importancia de esta regla ocurren con frecuencia  debido a los errores de redondeo 

causados cuando se insertan o se suprimen los puntos.  Tales infracciones de menor importancia son 

corregidas por la rutina del chequeo que funciona antes de cada análisis.  Las infracciones importantes 

pueden ocurrir cuando los puntos se levantan más allá del área ocupada por el material inmediatamente 

sobrepuesto.   

 

Si usted está conforme con la manera en que la geometría aparece en la pantalla pero se enfrenta con uno 

de estos errores al intentar accionar un análisis o chequeo de datos, usted puede utilizar la opción Resolve 

Crossovers (resolución de intersecciones sobrepuestas) para conseguir liberar las infracciones 

automáticamente.  La rutina asume que el material 1 tiene prioridad sobre el material 2, que 

alternadamente tiene prioridad sobre el material 3, etcétera.   

 

3.8 MENÚ DE ANÁLISIS  

 

3.8.1  Analyse>Calculate  

 

La opción calcular o  Shift-F9, al presionar se visualiza en la pantalla la selección de la rejilla para 

superficies circulares o compuestas: 
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Figura No. 3.23. Ventana Menú de análisis. 

 
El ejemplo mostrado ubica una rejilla de centros de 3 x 3 cuya esquina izquierda más baja está en X=160, 

Y=280.  El primer círculo que se analizará será tangente a Y=206, es decir tendrá un radio de 74.  Los 

círculos subsecuentes sobre el mismo centro serán  la tangente a 204 y 202.  

 

Al pulsar (OK) inicia el análisis.  Si se ha corregido el archivo de entrada puesto que hubo un 

funcionamiento pasado, entonces se produce un chequeo de datos que se lleva a cabo en la geometría del 

problema.  Esto es similar al chequeo realizado en el menú Edit, a menos que no sea incluida esa revisión 

de características de materiales.  Si no se detectan errores, el análisis procede.   

 

Establecer los trabajos de la rejilla como sigue: primero, fijar el tamaño de los incrementos del 

espaciamiento de la rejilla para X, Y, a su vez las localizaciones de la tangente se dividen en dos de sus 

valores anteriores.  Entonces el punto del origen de la rejilla se ajusta de tal forma que incrementa un 

nivel debajo y a la izquierda de la superficie más última del factor de seguridad mínimo.  La tangente 

también se ajusta para satisfacer esta superficie.  Esto trabaja lo mejor posible con una rejilla de 3 x 3, es 

decir con X(pasos)=2 y Y(pasos)=2  

 

3.8.2  Analyse>Recalculate  

 

Recalcule es igual que calcular, excepto que salta la exhibición de la ventana de la selección de la rejilla, 

y procede directo al cálculo.   
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3.9 MENÚ SUPERFICIES DE FALLA  

 

 

 
 

Figura No. 3.24. Ventana Menú búsqueda de superficies de falla. 

 

 

3.9.1  Slip Surface>Regular Grid Search 

 

Esta opción se fija como defecto cuando se comienza GSLOPE.  La rejilla de centros según lo definido en 

la ventana de la selección de la rejilla se utiliza exactamente según lo especificado.  GSLOPE procura 

utilizar cada punto de rejilla como un centro conjuntamente con cada tangente en el rango especificado.  

Las ventajas de esta opción son:  

 Genera un diagrama rectangular de contornos del factor de seguridad.  

 No es dispersado  por mínimas posiciones.    

 Debido a que el rango de radios esta contraído, hay más control sobre el rango de las superficies 

analizadas.  Por ejemplo, esta opción permite evitar el análisis de superficies de deslizamiento 

muy poco profundas en los materiales granulares que constituyen respuestas correctas pero que 

realmente no son de interés.   

 

3.9.2  Slip Surface>Grid/Radial Search 

 

Esta opción es igual que la búsqueda regular de la rejilla, excepto que el rango de los radios buscados 

sobre cada centro continúa más allá del rango especificado hasta que un factor mínimo de la seguridad se 

encuentre para el centro actual.   

3.9.3  Slip Surface>Stepwise Search 
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Esto comienza con una búsqueda radial, usando una rejilla de centros 3 x 3.  Si el factor más bajo de 

seguridad no corresponde a un círculo centrado en el centro de la rejilla, la rejilla es desplazada por un 

incremento en X, Y o ambas.  El proceso continúa hasta que el factor mínimo de la seguridad corresponde 

a un círculo cuyo centro esté en el centro de la rejilla.  Para taludes (desniveles) simples, este 

acercamiento tiende a encontrar el factor de seguridad mínimo muy rápidamente, pero sus desventajas 

incluyen lo siguiente:   

 

El resultado puede variar dependiendo del punto de partida.  Debido a que el método enfoca las 

pendientes locales en los contornos del factor de seguridad y puede pasar por alto totalmente los mínimos 

no inmediatamente adyacente al punto de partida.   

 

Sea especialmente moderado si se usa con los taludes (desniveles) reforzados.  El refuerzo por supuesto 

se pone con la intención expresa de "completar" áreas bajas en los contornos del factor de seguridad.  

Esto conduce a los diagramas del contorno del "plano" con muchos mínimos locales, que probablemente 

perderá este método.  La búsqueda regular de la rejilla o el método de la búsqueda radial es generalmente 

la mejor opción para tales situaciones.   

 

3.9.4  Slip Surface>Specified Surface  

 

Esta selección corresponde al uso de una superficie de falla de forma general, no basada en cualquier 

centro en particular.  Se activa si usted utiliza la opción Draw>Specified Surface, para dibujar una 

superficie potencial de falla de forma general, así que es raramente necesario seleccionar este artículo del 

menú directamente.   

 

3.9.5  Slip Surface>Segment Choice  

 

Para que cada superficie circular o compuesta sea analizada, el programa debe elegir los límites de la 

masa cuyo potencial se desliza.  Normalmente los puntos de  intersección con los primeros o el material 

superior proporcionan los límites del análisis.  Si la superficie de la falla interseca la superficie de tierra 
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en más de dos puntos, una pregunta se presenta en cuanto a qué superficie (es decir que segmento del 

círculo) debe ser analizado.   

 

 

 
 

 

 

 

 

Figura No. 3.25. Ventana segmento de círculo a ser analizado. 

 
 

 

Por defecto se utilizan los dos puntos extremos izquierdos como los límites del análisis.   

 

 

 

 

 

 
 

 

 
Si el talud falla de derecha a izquierda, se necesitará probablemente utilizar una opción diferente del 

segmento.   

 

Superficie con X-coordenadas inferiores (por defecto) 
Superficie con la diferencia de elevación máxima 
Superficie de elevación más alta 

Superficie de elevación más baja 
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3.10 OTHER MENÚ  

 

 

 
 

Figura No. 3.26. Ventana de Menú Otros. 

 

 

3.10.1  Other>Construct  

 

Esta opción le permite seleccionar un material cuyas coordenadas deben ser igual que aquellos que 

conforman la superficie a construir.  Utilizar con cuidado, debido a que los materiales sobrepuestos y 

subyacentes también se modifican para conformarse con la superficie nuevamente construida.  

 

3.10.2  Other>Excavate  

 

Como terraplén, esta opción es válida solamente si se ha definido la construcción de una superficie.  La 

estratigrafía existente "se excava" debajo del nivel de la superficie construida.  Puede ser utilizado en una 

variedad amplia de situaciones para reducir al mínimo la cantidad de trabajo implicada en definir una 

geometría compleja, pues evita cualquier necesidad de calcular puntos de la intersección.  Las 

coordenadas de los nuevos puntos generados por esta operación se redondean al corresponder a los 

valores rápidos actuales de X y de Y.   

 

3.10.3  Other>Fill  
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Esta opción es válida solamente si se ha definido la construcción de una superficie.  La estratigrafía 

existente "se llena" hasta el nivel de la superficie construida, usando generalmente el material más 

importante.  Es útil para agregar bermas a una sección representativa o para agregar el agua libre en el  

pie de un talud (desnivel).  Evita cualquier necesidad de calcular puntos de intersección.  Las coordenadas 

de los nuevos puntos generados por esta operación se redondean al corresponder a los valores rápidos 

actuales de X y de Y.  

 

3.10.4  Other>Choose Colors 

 

Esta opción permite que se disponga y exceptúe sus propios sistemas de colores que se utilizarán para 

exhibir la estratigrafía.  Según lo enviado, GSLOPE utiliza un sistema de colores definidos en un archivo 

llamado PASTEL.COL.  Se recomiendan los colores en color pastel, porque los colores saturados 

predominan en la pantalla.  En las impresoras de color, utilizan cantidades excesivas de toner, y pueden 

obscurecer algunas características del diagrama.  Para cambiar el color de un material, escoger los colores 

de Other>Choose Colors para generar la ventana de seleccionar el color, entonces en la columna del lado 

derecho de la ventana, registrar marcando el color que usted desea cambiar.  Escojer el color de la caja de 

diálogo selección de color.  Cualquier cambio que se realice se perderá cuando usted sale de GSLOPE, a 

menos que usted lo guarde paro lo cual use el botón de guardar el esquema de color.  Usted puede 

nombrar su propio sistema de colores y dejar PASTEL.COL intacto.  Cuando usted sale de GSLOPE, el 

nombre del sistema de colores será guardado por defecto.   

 

3.11 EL MENÚ DE AYUDA 

 

3.11.1  Help>About GSLOPE  

 

Muestra un mensaje de los derechos de propiedad literaria  y el número de versión del programa, junto 

con la información del contacto para Mitre Software Corporation.   

 

3.12 COMO TRABAJA EL ANÁLISIS 
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Esta sección proporciona una descripción de los pasos implicados en calcular el factor de la seguridad 

usando el Método de Bishop Modificado.   

 

3.12.1   Dividiendo la masa que se desliza en rebanadas (slices)  

 

Hay varios pasos implicados en el análisis para el factor de la seguridad, son: 

 

Para la superficie de falla (circular, compuesto o especificada), se hace un cálculo para encontrar los 

puntos de intersección de la superficie de falla con las superficies de materiales.   

 

Los puntos de intersección del deslizamiento emergen normalmente con el primer material superior o de 

los límites de análisis.  Si la superficie de la falla interseca la superficie del terreno en más de dos puntos, 

el segmento limitado por los dos puntos extremos izquierdos se utiliza para el análisis.  Si el talud 

(desnivel) falla de derecha a izquierda, se puede elegir un diferente segmento, vea la sección 3.8.5.   

 

Los límites de las rebanadas se asignan en las X-coordenadas de cada material el punto de intersección y 

también en las X-coordenadas de cada punto donde se definen las superficies de los materiales.  Esto 

significa que ninguna rebanada (slice) puede tener siempre más de un material en su base y ninguna 

rebanada (slice) contiene siempre una rotura en el talud, en la superficie de la tierra, o en un interfaz de 

material.  Si cualquiera  de las rebanadas (slices) que resultan tiene un ancho mayor que el ancho máximo 

de la rebanada especificada, se subdividen hasta que el ancho máximo de la rebanada no sea excedida.  Si 

este procedimiento da lugar a más de cincuenta rebanadas, el ancho máximo especificado se aumenta para 

permitir una reducción en el número total de rebanadas (slices).  Para las situaciones típicas, un total de 

veinte rebanadas (slices) generalmente se considera amplio.  El número máximo de rebanadas se puede 

ajustar usando Set>Advanced.  Si observa un mensaje en la base de la pantalla que dice “el ancho de la 

rebanada dobló para limitar el No. de rebanadas", es mejor aumentar manualmente el ancho máximo de la 

rebanada mostrada en el menú principal.   
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Controlando el ancho de la rebanada que el número total de rebanadas conduce a una consistencia más 

exacta a partir de un análisis próximo y ayuda así a un mejor trabajo de las rutinas de búsqueda.  También 

acelera el proceso de cálculo.   

 

Los puntos intermedios de las bases de la rebanada son entonces calculados.  Las X-coordenada se toman 

como el promedio del izquierdo y derecho de X-coordenada para cada rebanada y en la caja de las 

rebanadas compuestas, Y-coordenadas es el promedio de Y-coordenadas de las bases de los límites 

izquierdos y derechos.   

 

3.12.2   Grietas de tensión 

 

Los materiales en la base de cada rebanada  son determinados por la referencia al punto de la intersección 

de la superficie material con X-coordenada en cada centro de la rebanada.  La primera rebanada (slice) se 

comprueba para considerar si el material en su base tiene fuerza cero, es decir es un líquido o una zona de 

la grieta de la tensión.  Si éste es el caso, la rebanada se quita del cómputo y el chequeo procede a la 

rebanada siguiente hasta que un material con una fuerza finita se encuentre en la base de la rebanada.   

 

Las rebanadas quitadas se substituyen por una fuerza hidrostática, que se calcula siempre en base al peso 

de unidad del agua. Para los materiales que tiene fuerza cero, se ha encontrado conveniente utilizar el 

campo etiquetado del valor de Ru para controlar las fuerzas hidrostáticas de la presión para las rebanadas 

del extremo. Un valor de 1,0 en este campo se toma para expresar que la presión hidrostática existe sobre 

la altura completa del límite de la rebanada del extremo, y se podría por lo tanto simular el efecto de una 

grieta llena de agua de la tensión.  (La grieta media llena correspondería a 0,5). Un valor de cero en el 

campo del Ru para este material simularía el efecto de una grieta seca de tensión, con el material actuando 

como sobrecarga.  

 

3.12.3   Inmersión Parcial  

 

En este caso especial siempre es apropiado aplicar la fuerza hidrostática completa cuando el agua está 

presente en el límite de la rebanada del extremo.  Es decir, si la ultima rebanada quitada tenía por base un 
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material con el mismo peso de unidad como el agua y las características de fuerza cero, la fuerza 

hidrostática completa se aplica al límite de la rebanada del extremo, sin importar el valor en el campo del 

Ru.  Si no está interesado en grietas de tensión y no tiene ningún material en su estratigrafía que tiene 

fuerza cero, no debe hacer caso de estos efectos.  La información adicional sobre inmersión parcial se 

puede encontrar en la sección 2.6.2.   

 

3.12.4   Las presiones de poros  

 

Las condiciones de presión de poros se definen normalmente usando superficies piezométricas.  Cada 

material puede tener su propia superficie piezométrica, o una superficie piezométrica dada puede 

aplicarse a más de un material.  La presión de poro en la base de cualquier rebanada se asume por ser 

equivalente cresta del agua representado por la diferencia de la altura entre el punto medio de la base de la 

rebanada y de la correspondiente elevación vertical de la superficie piezométrica.  Si no se define ninguna 

superficie piezométrica para un material en particular, se asume tener un valor de cero en la presión de 

poro en todas partes, a menos que tenga un valor distinto a cero el Ru.   

Las presiones de poro no son ajustadas por el programa en respuesta a la operación de corte y relleno.  Si 

se va la respuesta de la presión de poro a la construcción o al descenso rápido del nivel de agua a ser 

incluida en el análisis, los cambios correspondientes a las superficies piezométricas deben ser provistos 

por el usuario.  Las condiciones artesianas se pueden representar por las superficies piezométricas que 

extienden sobre la superficie del terreno.  En caso del descenso rápido del nivel de agua, considere que el 

retiro del agua puede dar lugar a una respuesta de la presión del poro  debido a la descarga.   

 

3.12.5   El cálculo del factor de la seguridad  

 

En el Método de Bishop Modificado, el factor de seguridad se define como el factor por el cual la fuerza 

del suelo puede ser dividida antes de que el talud (desnivel) alcance un estado límite de equilibrio.  Se 

asume que el factor de seguridad es el mismo para todas las rodajas.  El método también asume que no 

hay fuerzas de corte en los límites verticales entre las rebanadas.  Esto significa que si asumimos un valor 

inicial del factor de la seguridad, podemos hacer uso de una ecuación de equilibrio vertical para cada 

rebanada que implique solamente lo siguiente:   
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El peso de la rebanada, incluyendo cualquier sobrecarga o agua libre, y la componente vertical de 

cualquier fuerza externa aplicada a la rebanada. 

 

La presión de poro a la base de la rebanada. 

 

La fuerza normal en la base de la rebanada. 

 

La fuerza de corte en la base de la rebanada. 

 

Los primeros dos aspectos en la lista ya se conocen.  Porque la fuerza de corte en la base de la rebanada 

se relaciona con la fuerza normal y con los valores conocidos de la fricción y la cohesión, reducida 

apropiadamente por el valor asumido del factor de seguridad. Las fuerzas normal y de corte en la base de 

cada rebanada se pueden calcular, basadas en el valor asumido del factor de la seguridad.  Observe que 

las fuerzas  debido al refuerzo no se incorporan todavía al cálculo, debido a se asumen ser horizontales.  

Podemos entonces sumar todos los momentos que actúan en la masa completa que se desliza.  Éstos 

incluyen los momentos  debido a lo siguiente:   

 

El peso de cada rebanada, incluyendo la sobrecarga y el agua libre. 

 

La fuerza normal en la base de cada rebanada. 

 

La fuerza de corte en la base de cada rebanada. 

 

Las fuerzas sísmicas pseudo-estáticas. 

 

Las fuerzas hidrostáticas debido al agua en las grietas de tensión. 

Las fuerzas hidrostáticas debido al agua libre contra una cara de la rebanada vertical. 

   

Las fuerzas de tensión en las capas del refuerzo.   
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Las fuerzas externas. 

 

Si los momentos en la masa deslizante no suman cero, un ajuste se hace al factor de seguridad hasta que 

el equilibrio se alcance.  La convergencia a tres lugares decimales se alcanza generalmente en tres o 

cuatro iteraciones.   

 

La fuerza de tensión en la capa del refuerzo se incorpora a la ecuación de equilibrio de momento total 

sobre la misma base en el peso del suelo, junto con cualquier sobrecarga y fuerza sísmica.  Esto significa 

que, en general, no se está aplicando ningún factor adicional de seguridad a la tensión en el refuerzo, más 

allá de los factores para el arrastramiento a largo plazo, el daño de la instalación y la degradación química 

etc. incluida ya en el valor permisible de la tensión.  Al mismo tiempo, el cálculo asume que el efecto que 

se estabiliza del refuerzo está limitado a la fuerza extensible que ejerce en la masa potencial corrediza y 

no toma ningún crédito para ningún aumento posible de la fuerza del suelo  debido a la acción que ocurre 

al rellenar.   

 

3.12.6   La interacción entre el suelo y el refuerzo  

 

Para cada capa de refuerzo, el programa primero encuentra la localización del punto en donde la 

superficie de falla interseca el refuerzo. Utilizando el esfuerzo vertical total y la presión de poro en ese 

punto para llegar a un valor para la fuerza de corte del suelo en el punto de  intersección, usando la 

relación:  

 

Fuerza de corte del suelo = cohesión + (esfuerzo vertical - la presión del poro N)Tan Ø.  

 

El programa determina la distancia del punto de  intersección más cercano al final del refuerzo.  Esto 

representa la longitud de anclaje disponible entre la capa del refuerzo y el suelo.   

 

La fuerza de extracción o Pullout disponible  se calcula como:  
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2 x coeficiente de interacción x fuerza del suelo x longitud de anclaje 

Factor de seguridad contra la extracción del refuerzo 

 

 

Para el cálculo total del momento según lo descrito arriba, la fuerza en la capa del refuerzo se toma como 

la menor de la ' tensión máxima por ancho de unidad ' especificada para el refuerzo y la fuerza de 

extracción disponible según lo calculado arriba.   

La fuerza para cada capa del refuerzo se calcula alternadamente.  Todas las fuerzas del refuerzo entonces 

se incorporan en el cálculo de estabilidad como si fueran fuerzas externas horizontales aplicadas a la masa 

que se desliza.  El programa selecciona automáticamente cuales capas del refuerzo son activas, y en qué 

dirección se aplican las fuerzas.  Un nuevo sistema de cálculos del refuerzo se realiza para cada superficie 

de falla analizada, puesto que la contribución de cada capa varía con la localización de la superficie de 

falla.   

 

El factor de la seguridad contra la extracción se ingresa mediante la opción en  Edit>Header.  Se debe 

observar que este factor está aplicado solamente a la fuerza requerida para la extracción y no afecta 

directamente la fuerza máxima que se puede generar en una capa del refuerzo.  

 

3.12.7   El parámetro de  M-alfa del equilibrio vertical 

 

La fuerza normal en la base de una rebanada se expresa mediante la ecuación propuesta por (Fredlund, 

1978) como:   

 

 

 




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Donde:   

 

W = peso total de la rebanada  
 

c = cohesión del material en la rebanada   

 

ø = ángulo de fricción del material en la rebanada 
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P = fuerza normal total en la base de la rebanada  

 

b = ancho de la rebanada  

 

 = el ángulo definido de la base de la rebanada con la horizontal.  Esto se toma como positivo para una 

rebanada que tienda a deslizar cuesta abajo hacia la derecha.  

j = la longitud de la base de una rebanada, para definir j sen= b 
 

M-alfa  (o m) esta definido como:  
 

 

 

F

Tansen
m





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Si la superficie de la falla es muy profunda, es posible que el ángulo de la base de la rebanada logre un 

valor negativo grande.  Esto puede conducir a un M-alfa con valores que se aproximen a cero, dando un 

valor grande y poco realista para la fuerza normal.  Si un valor de M-alfa menor que un valor límite 

(límite por defecto = 0,3) se encuentra en la iteración final del equilibrio total del momento, se observa 

una advertencia de M-alfa.  Los valores sobre 0,2 son generalmente de poca significación.  El valor límite 

de advertencia de M-alfa se puede cambiar usando Set/Advanced. 

 

3.12.8   Contribución con el refuerzo 

 

Según lo descrito en la sección 3.5, GSLOPE incorpora los momentos o las fuerzas  debido al refuerzo en 

la ecuación de equilibrio total.  Recuerde que la definición del factor de seguridad es el factor por el cual 

la fuerza del suelo se debe reducir para ocasionar en la masa del suelo un estado de equilibrio límite a lo 

largo de una superficie de falla dada y que el factor de seguridad asumido sea igual para todas las 

rebanadas.  En la aplicación del método de Bishop, por ejemplo, GSLOPE asume un valor inicial del 

factor de seguridad, F y después lo ajusta hasta que el equilibrio sólo se alcanza con 1/F veces que la 

fuerza disponible del suelo movilizó en la base de cada rebanada.   

 

Esto significa que más allá de varios factores de seguridad construidos en el valor de Tallowable (tensión 

permisible) (véase la sección 3,6), GSLOPE no aplica cualquier otro factor más que el de seguridad a la 
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fuerza en el refuerzo, pero asume que Tallowable esté realmente disponible para ser movilizado.  Así, el 

valor de Tallowable de la misma manera que otros parámetros de entrada tales como pesos de unidad del 

suelo, condiciones de la presión del poro, aceleración sísmica y los valores de cualquier sobrecarga o de 

otras cargas externas  puedan estar presentes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

CAPÍTULO IV 

 

APLICACIONES PRÁCTICAS  
 

 

 

4.1 DESCRIPCIÓN DE ALGUNOS PROYECTOS 

 

4.1.1    INESTABILIDAD SECTOR GUZHO AUTOPISTA CUENCA - AZOGUES  

 

4.1.1.1   ANTECEDENTES 

 

El Proyecto PRECUPA clasifica a la zona de Guzho como una 

zona de deslizamiento subestable con movimientos 

imperceptibles menores a 2 cm por año. 

 

En el Sector de Guzho de la ciudad de Cuenca, se produjo un deslizamiento que afectó 

las viviendas que se encontraban ubicadas en esta vertiente natural y un sector de la 
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Autopista Cuenca-Azogues en un ancho aproximado de 200 m. que pasa por su borde 

inferior. 

 

4.1.1.2   CARACTERÍSTICAS GENERALES DEL SITIO DE ESTUDIO 

 

4.1.1.2.1 Ubicación de la Ruta 

 

La Autopista Cuenca - Azogues con una longitud de 30,720 Km, es una vía existente localizada al sur 

región sierra del Ecuador, en Provincia del Azuay, Cantón Cuenca, Figura No. 4.1.  Está ubicada en el 

sector sur occidental de la ciudad de Cuenca capital de la provincia.   El área de los Estudios de 

Estabilización de taludes de la Autopista Cuenca - Azogues en el Sector del Guzho, se encuentra al inicio 

de la misma, al lado derecho, en un tramo de 400m, comprendido entre las abscisas 0+450 a 0+850, 

comprende 15,34ha (153.435m2), Mapa 1, Figura No. 4.1. 
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Figura No. 4.1. Localización del área de estudio al inicio de la Autopista Cuenca – Azogues  

 

4.1.1.2.2 Límites del Área 

 

Norte Autopista Cuenca – Azogues, en una longitud de 380m, 

Sur Vía a Guzho Grande, en una longitud de 300 y varios 

propietarios, en una longitud de 210m, 

Oeste Río Tarqui, en una longitud de 110m, y, 
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Este Varios propietarios en una longitud de 520m. 

 

4.1.1.2.3 Límites Geográficos del Área 

  
 

Coordenadas UTM 
 

Lí mi t e  Desde Hasta 
   

NORTE 
9´676.908N 

718.432E 
9´677.126N 

718.886E 

SUR 
9´676.860N 

718.468E 
9´676.606N 

718.918E 

OESTE  
9´676.908N 

718.432E 
9´676.860N 

718.468E 

ESTE 
9´677.126N 

718.886E  
9´676.606N 

718.918E  
 

 

4.1.1.3   OBJETIVOS 

 

Este componente comprende trabajos de campo, laboratorio y oficina direccionados para realizar el análisis 

geotécnico del sector Guzho. Sus objetivos específicos son los siguientes: 

 

 Determinar la naturaleza del subsuelo, por medio de la clasificación de los materiales encontrados y 

recuperados durante la ejecución de sondeos mecánicos a roto-percusión y excavaciones a cielo abierto. 

  

 Conocer las condiciones físicas y características geomecánicas del subsuelo del sector por medio de toma 

de muestras inalteradas y ensayos de laboratorio consistentes en clasificación, resistencia al esfuerzo 

cortante tipo triaxial. 

 

 Instalar las facilidades necesarias para las labores de instrumentación y monitoreo de desplazamientos de 

la ladera mediante el uso de inclinómetros y piezómetros. 

 

 Analizar la estabilidad global de la zona en las condiciones topográficas actuales a fin de determinar el 

factor de seguridad al deslizamiento. 
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 Emitir conclusiones y recomendaciones respecto al tipo de obras de protección y acciones para 

remediación si estas fueran necesarias 

 

 

4.1.1.4   CARACTERÍSTICAS DEL DESLIZAMIENTO 

 

El deslizamiento de la ladera ocurrido en el sector denominado Guzho compromete un área estimada de 12 

Ha, en al cual se produjo el desplazamiento de aproximadamente 750.000 m³ de suelo.  El deslizamiento de la 

masa de suelo ocasionó la destrucción de algunas estructuras de viviendas y la pérdida de serviciabilidad en 

otras.  Cabe señalar que al menos tres edificaciones menores y la iglesia del sector no experimentaron efectos 

por el deslizamiento de la masa de suelo pues se encuentran sobre suelo muy competente. 

 

4.1.1.5   TRABAJOS DE CAMPO 

 

Con el fin de conocer las características del subsuelo del terreno 

e instalar la instrumentación, se realizaron tres (3) sondeos 

mecánicos a roto-percusión, con pruebas SPT a diferentes 

profundidades. Las cotas de inicio y profundidad de los sondeos 

se indican a continuación: 

 

Tabla No. 4.1. Profundidad de los Sondeos Mecánicos 
 

SONDEO 

No. 

PROF. 

(m) 

COTA 

INICIO 

COTA 

FINAL INSTRUMENTACION 

S – 1 15.00 2567 2552.0 Piezómetro 

S – 2 23.50 2584 2560.5 Inclinómetro 

S – 3 20.35 2600 2579.7 Inclinómetro 
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Los sondeos se realizaron desde el nivel actual del terreno 

utilizando para el efecto una máquina perforadora marca 

ACKER Mountainer, montada sobre skis, con motor a gasolina 

de 19HP. Junto a esta máquina se utilizó tubería de perforación 

NW, NQ y AW, muestradores del tipo cuchara partida y de 

pared delgada (shelby), muestreadores tipo doble barril, brocas 

de widia, brocas de diamante y  herramienta menor. Ver las 

fotografías adjuntas en el Anexo D-I y el plano de ubicación de 

sondeos del Anexo D-VIII. 

 

Se realizaron pruebas SPT a diferentes profundidades. En 

estas pruebas se registraron el número de golpes (valores de 

"N") para 45 cm de penetración de un muestrador del tipo 

cuchara partida. Estos valores así como las características de 

los suelos encontrados se indican en los registros de 

perforación, adjuntos en el Anexo D-II. 

 

Paralelamente  a la ejecución de los sondeos se recuperaron muestras de los diferentes 

estratos de suelo investigados, las mismas que fueron identificadas y clasificadas en 

sitio por el Ingeniero Jefe de Campo, mediante el método de Clasificación Manual 

Visual propuesto por el SUCS. Las muestras fueron colocadas en cajas portatestigos 

identificando su longitud y profundidad. Adicionalmente se recuperaron muestras 

inalteradas utilizando para el efecto tubos muestreadores de pared delgada (Shelby). Las 
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muestras inalteradas fueron debidamente identificadas y selladas para transportarlas al 

laboratorio. 

 

Durante los trabajos de campo se realizaron dos (2) 

excavaciones a cielo abierto (trincheras) hasta 4 m de 

profundidad con el fin de observar la disposición estratigráfica 

de los materiales superficiales y recuperar muestras de suelo.  

La ubicación de las trincheras, profundidad, cotas de inicio y 

finalización se muestran en el Tabla No. 4.2. 

 

Tabla No. 4.2. Ubicación de Excavaciones a Cielo Abierto 
 

TRINCHERA 

No. 

PROF. 

(m) 

COTA 

INICIO 

COTA 

FINAL 

T – 1 4.05 2572 2567.95 

T – 2 4.00 2573 2569.00 

 

 

 

 

4.1.1.6   ENSAYOS DE LABORATORIO 

 

Con las muestras recuperadas durante el avance de los 

sondeos mecánicos, se realizaron los siguientes ensayos de 

laboratorio: Contenido de Humedad Natural (30 ensayos), 

Granulometría (30 ensayos), Límite Líquido (30 ensayos), 

Límite Plástico (30 ensayos).   
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Los resultados obtenidos sirvieron para clasificar a los suelos 

de acuerdo al Sistema Unificado SUCS lo cual permitió conocer 

la secuencia estratigráfica del subsuelo. Los reportes  de  los 

ensayos de laboratorio se presentan en el Anexo D-IV. 

 

Con las muestras inalteradas recuperadas mediante tubos de 

pared delgada tipo Shelby se realizaron ensayos tipo Triaxial 

UU (3 ensayos). Los resultados de estas pruebas permitieron 

conocer los parámetros de resistencia al esfuerzo cortante. 

 

4.1.1.7   CARACTERÍSTICAS DEL SUBSUELO 

 

Las observaciones realizadas durante los trabajos de campo, 

así como los resultados de las pruebas de laboratorio, 

permiten definir las condiciones que presenta el subsuelo. 

 

4.1.1.7.1   Naturaleza y Perfil del Subsuelo 

 

a)  Sondeo S-1; Cota de Inicio 2567; Instrumentación: Piezómetro 

 

Desde 0.0 m hasta 0.5 m de profundidad se observa suelo de cobertura o capa vegetal, mezclada con suelo 

arcilloso color negro. 
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A partir de 0.5 m hasta 3.7 m de profundidad se presentan arcillas de alta plasticidad color negro grisáceo, 

muy húmedas del tipo CH, con partículas de grava gruesas con diámetros desde de 1 ½” a 2”, color gris 

verdoso, consistencia media a blanda. 

 

Desde 3.7 m hasta a 9.9 m de profundidad se presentan limos inorgánicos de alta compresibilidad, muy 

húmedos a saturados, del tipo MH, color gris verdoso con grumos de suelo densos, se observan partículas 

de arena gruesa de hasta 4 mm de diámetro y partículas de  grava esporádicas de hasta ½ “ de diámetro, 

consistencia media a dura.  

 

A los 7 m de profundidad se observan gravas angulares color gris rojizo. 

 

Desde 9.9 m hasta 15.0 m, profundidad en al cual termina este sondeo se observan arenas limosa son 

plásticas del tipo SM, color habano claro grisáceo, de grano medio a grueso y partículas de grava con 

diámetros mayores a 4 mm en matriz arcillosa poco plástica, compacidad relativa densa a muy densa. 

 

b)  Sondeo S-2; Cota de Inicio 2584; Instrumentación: Inclinómetro 

 

Desde 0.0 m hasta 0.5 m de profundidad se observa suelo de cobertura o capa vegetal, mezclada con suelo 

arcilloso color negro y escombros. 

 

 

De 0.5 m hasta 3.0 m de profundidad se presentan arcillas de baja plasticidad color café grisáceo, 

húmedas del tipo CL, consistencia blanda. 

 

A partir de 3.0 m hasta 6.0 m de profundidad se observa un estrato de limos arcillosos inorgánicos de alta 

compresibilidad del tipo MH, húmedos a saturados, color café claro verdoso, con grumos de suelo densos, 

color gris y pintas de oxidación, con partículas de arena gruesa, consistencia blanda a dura. 
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Desde 6.0 m hasta 8.0 m de profundidad se presentan limos de baja compresibilidad, arenosos, del tipo 

ML, muy húmedos, color café claro verdoso, con partículas de arena gruesa. Compacidad relativa densa a 

suelta. 

 

De 8.0 m hasta 8.5 m de profundidad se presenta un lente de limos inorgánicos de alta compresibilidad 

del tipo MH, color café claro verdoso, muy húmedo a saturado, consistencia blanda. 

 

A partir de 8.5 m hasta 10 m de profundidad se presenta nuevamente un estrato de limos inorgánicos de 

baja compresibilidad del tipo ML, color gris verdoso con partículas de arena gruesa, compacidad relativa 

suelta a  muy densa. 

 

Desde 10.0 m hasta 17.5 m de profundidad se encuentra un estrato de limos inorgánicos de alta 

compresibilidad color gris verdoso, muy húmedo, del tipo MH, plasticidad media a alta, consistencia 

media a muy dura. 

 

De 17.5 m hasta 23.5 m, profundidad en la cual termina este sondeo se observa un estrato de arenas 

limosa no plásticas del tipo SM, color café claro grisáceo, muy densas, en matriz de arcillosa muy 

consistente y dura. Se observan partículas de arena fina a media.     

  

c)  Sondeo S-3; Cota de Inicio 2600; Instrumentación: Inclinómetro 

 

De 0.0 m hasta 0.5 m de profundidad se encuentra suelo de cobertura o capa vegetal, con raíces pequeñas 

y suelo arcilloso color negro. 

 

Desde 0.5 m hasta 6.5 m de profundidad se observan arcillas limosas de baja plasticidad color café 

grisáceo, del tipo CL, húmedas de consistencia dura a media, desde 4.1 m se presentan partículas dispersa 

de grava con diámetros mayores a 1 ½”, consistencia media. 
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A partir de 6.5m hasta 8.5 m de profundidad se encuentra un estrato de arcillas limosas de alta plasticidad 

del tipo CH, color café grisáceo, muy húmedas, hasta 7.1 m se observan partículas de grava dispersas, 

consistencia media  a blanda. 

 

Desde 8.5 m hasta 10.6 m de profundidad se presentan arcillas limosas de baja plasticidad del tipo CL, 

color gris verdoso, muy húmedas a saturadas, con partículas de arena gruesa, consistencia muy blanda. 

 

De 10. 6 m hasta 16.5 m de profundidad se encuentra un estrato de limos inorgánicos de alta 

compresibilidad color café grisáceo, del tipo MH, húmedos, consistencia blanda a dura conforme aumenta 

la profundidad del sondeo. 

 

A partir de 16.5 m hasta 20.35 m , profundidad en la cual termina esta perforación se encuentran arenas 

limosa no plásticas  del tipo SM, de grano fino a medio, en matriz arcillosa de plasticidad nula a baja, 

muy densas, consistentes, muy duras. 

 

d)  Trinchera T-1; Cota de Inicio 2572; Dimensiones: 6.03 x 1.20 m 

 

Se observa capa vegetal o suelo de cobertura desde el perfil actual del terreno hasta una profundidad de 

0.5 m, conformada por raíces pequeñas en suelo arcillosos color negro, blando, húmedo con piedras 

pequeñas y escombros. 

 

A partir de 0.5 m hasta 3.3 m de profundidad se aprecia un relleno mal compactado, compuesto por suelo 

limo arcilloso color negro, muy húmedo, de plasticidad alta, con escombros y desechos de construcción. 

 

De 3.3 m hasta 4.05 m, profundidad en la cual termina esta excavación se observa limo inorgánico de alta 

compresibilidad, muy blando, color negro, sin olor, muy húmedo a saturado con partículas pecunias de 

grava con diámetros menores a ½”. 

 

e)  Trinchera T-2; Cota de Inicio 2573; Dimensiones: 5.80 x 0.80 m 
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Se observa capa vegetal o suelo de cobertura desde el perfil actual del terreno hasta una profundidad de 

0.5 m, conformada por raíces pequeñas en suelo arcillosos color negro, blando, húmedo. 

 

Desde 0.3 m hasta 2.3 m, se encuentra suelo limo arcilloso de alta compresibilidad, del tipo MH, color 

café oscuro muy húmedo, consistencia blanda, plasticidad alta, con presencia de grumos de suelo densos 

y raíces pequeñas. 

 

A partir de 2.3 m hasta 3.6 m la coloración de estos limos de alta compresibilidad del tipo MH cambian 

su coloración a habano claro, se presentan húmedos, con grumos de suelo densos color gris y pintas de 

oxidación. Su consistencia varía de media a dura. 

 

De 3.6 m a 4.0 m, profundidad en al cual termina esta trinchera los limos arcillosos del tipo MH presentan 

un color amarillento, con partículas de grava (cantos rodados) meteorizados y pintas de oxidación. La 

consistencia de los limos a esta profundidad es muy dura. En ninguna de las dos trincheras se detectó la 

presencia de agua subterránea hasta la profundidad máxima de excavación. 

 

La descripción y características físicas de los materiales encontrados se presentan en los registros de 

perforación adjuntos en el Anexo D-II. 

 

En el Anexo D-VIII se presenta el perfil geotécnico 1-1 en el cual muestra la disposición estratigráfica de 

los suelos investigados. 

 

4.1.1.7.2   Agua Subterránea 

 

Durante la ejecución de los sondeos a rotación se detectó la presencia de agua subterránea a diferentes 

profundidades, las mismas que se muestran en resumen en el Tabla No.4.3 

 

Tabla No. 4.3. Ubicación del Agua Subterránea 
 

SONDEO 

No. 

PROF. 

(m) 

 

COTA OBSERVACIÓN 

S – 1 6.0 2561.0 DIA 1 
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S – 2 6.5 2577.5 DIA 12 

S – 3 9.5 2590.5 DÍA 17 

 

 

 

Cabe señalar que junto al sondeo S-1 existe un pozo cuya profundidad es del orden de 16 m del cual se 

obtiene agua mediante bombeo. 

 

4.1.1.7.3   Propiedades Mecánicas  

 

Los resultados de las pruebas de resistencia al corte y compresibilidad obtenidos de los ensayos de 

compresión triaxial UU, se resume en el Tabla No. 4.4. 

 

Tabla No. 4.4. Ensayo Triaxial UU 
 

SONDEO 

No. 

PROF. 

(m) 
m

(t/m
3
) 


(°) 

c 

(t/m²) 

Es 

(t/m²) 

S – 2 11.50 – 11.85 1.785 21 8.5 792 

S – 3 3.50 – 4.10 1.800 15 10.4 1441 

S – 3 10.00 – 10.60 1.932 6 3.0 323 

 

 

 

En el Anexo D-IV se presentan los reportes de laboratorio de estos ensayos. 

 

4.1.1.7.4   Propiedades Índice 

 

Los porcentajes de humedad natural, valores de límite líquido, límite plástico e índice de plasticidad, así 

como, los porcentajes de grava, arena y finos de los suelos investigados se presentan en los registros de 

perforación adjuntos en el Anexo D-II. 

 

4.1.1.8   ANÁLISIS DE ESTABILIDAD 

 

Con el objeto de analizar la estabilidad al deslizamiento de la ladera en las condiciones topográficas 

actuales se procedió a evaluar los factores de seguridad al deslizamiento, considerando la topografía 

actual de la zona y los parámetros geomecánicos de resistencia al esfuerzo cortante de los suelos 
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La geometría del talud se obtuvo de los perfiles B, D y E los cuales se muestran en el plano adjunto en el 

Anexo D-VIII. Los parámetros, geometría y resultados completos de éste análisis se incluyen en el Anexo 

D-III. 

 

4.1.1.8.1   Selección de los Parámetros de Cálculo 

 

Además de la geometría del talud, tres parámetros influyen en el análisis: los valores de resistencia al 

corte de los materiales, las condiciones del agua subterránea, y el coeficiente de aceleración sísmica 

utilizada en el análisis pseudoestático. A continuación se presenta un breve comentario de los criterios 

utilizados para seleccionar cada uno de los parámetros de cálculo. 

 

a) Resistencia al Esfuerzo Cortante 

 

El análisis pseudoestático no considera pérdida de resistencia al corte debido al incremento de presión de 

poros en el suelo a lo largo de la falla que se estima provocarán las cargas de origen sísmico. 

 

El análisis tiende a ser algo conservador cuando se trata de taludes con suelos en estados no saturados y 

parcialmente saturados, sin embargo, cuando los suelos del talud se encuentran saturados o pueden llegar 

a saturarse en algún momento, se espera que la pérdida de resistencia al corte afecte la estabilidad del 

talud. Por lo expuesto el análisis toma en cuenta esfuerzos totales. 

 

Para los diferentes análisis se utilizaron los valores de resistencia al esfuerzo cortante indicado en el 

Cuadro No.4, obtenido de los ensayos de compresión triaxial UU llevados a cabo con muestras 

inalteradas recuperadas durante la ejecución de los sondeos mecánicos. 

 

b) Aceleración Sísmica 

 

En los análisis del presente estudio se considera la acción sísmica. Se adoptaron valores de 0.1g, 0.15g y 

0.2g debido a la importancia de la obra que se encuentra en el pie del talud, pues, se trata de una de 
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autopista de seis carrilles que conforma el anillo vial de la ciudad, la misma que se encuentra actualmente 

en operación y une el suroriente del país con la región sierra. 

 

c) Posición de la superficie piezométrica (agua subterránea) 

 

Durante el análisis se tomó en cuenta la posición del agua subterránea a fin de evaluar los efectos que esta 

provoca en la estabilidad de la ladera. 

 

Durante el análisis se modeló el escenario en el cual se asume que la obra vial pudo haber afectado la 

estabilidad del sector asumiendo que la autopista eliminó el drenaje natural del agua. 

 

4.1.1.8.2   Cálculo de los Factores de Seguridad 

 

Utilizando el programa Gslope (Mitre Software) se procedió con 

el análisis de la estabilidad del talud en función de la geometría 

de los tres perfiles indicados en el numeral 4.1.1.6, las 

condiciones de carga y las propiedades mecánicas de los 

suelos. 

 

Se utilizaron las metodologías de análisis propuesta por Bishop, la cual supone falla curva pero y la 

metodología de Janbu para superficies específicas de falla no necesariamente circulares. 

 

El análisis permite obtener el menor factor de seguridad para cada caso asumiendo escenarios sin sismos 

y con aceleración por sismo.  

 

4.1.1.8.3 Factores de Seguridad obtenidos 
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Se analizaron los tres perfiles establecidos en sentido longitudinal al área de estudio. En los siguientes 

cuadros se muestran los valores de factor de seguridad obtenidos luego de los análisis de los perfiles 

generados en la zona motivo del presente estudio. 

 

 

Tabla No. 4.5. Factores de Seguridad (FOS) Calculados, Método de Bishop. 

   

 

 

 

 

Tabla No. 4.6. Factores de Seguridad (FOS) Calculados, Método de Janbu 

 

 

 

Con el propósito de conocer el grado de estabilidad de la ladera junto a la autopista se procedió a 

determinar, mediante el método de Janbu, sin tomar en cuenta la aceleración por sismo, el menor factor 

de seguridad al deslizamiento utilizando una superficie de falla específica. Los resultados de este análisis 

se muestran en el siguiente cuadro:  

 

Tabla No. 4.7. Factores de Seguridad (FOS) Calculados, estabilidad del talud junto a la 

Autopista 

Método de Janbu 
 

 

 

 

 

 

 

 

Para verificar si la construcción de la autopista afectó la estabilidad de la ladera se preparó y analizó un 

modelo el cual asume que la construcción de la autopista modificó las condiciones de subdrenaje y salida 

natural del agua. Los resultados de este análisis se presentan en el siguiente cuadro: 

PERFIL 
FACTOR DE SEGURIDAD 

SIN SISMO 0.1g 0.15g 0.2g 

B 1.170 0.925 0.835 0.759 

D 1.211 0.952 0.858 0.780 

E 1.370 1.058 0.948 0.858 

PERFIL 
FACTOR DE SEGURIDAD 

SIN SISMO 0.1g 0.15g 0.2g 

B 1.162 0.904 0.810 0.732 

D 1.213 0.977 0.888 0.812 

E 1.104 0.852 0.763 0.690 

PERFIL 
FOS 

SIN SISMO 

D 1.519 

E 1.661 
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Tabla No. 4.8. Factores de Seguridad (FOS) Calculados, estabilidad del talud sin 

drenaje junto a la Autopista 

Método de Janbu 
 

 

 

 

 

 

 
En el Anexo D-III se presentan figuras y esquemas con los resultados del análisis de estabilidad de los 

tres perfiles estudiados, para los escenarios de análisis arriba descritos. 

 

4.1.1.9   INSTRUMENTACION Y MONITOREO 

 

Factores tales como altura del nivel freático y movimientos 

superficiales que darían indicaciones de inestabilidad en el 

Sector de Guzho fueron medidos de manera directa por medio 

de instrumentación instalada en lugares seleccionados como 

representativos a través de toda la zona de estudio.  Esta 

instrumentación incluyó la instalación de puntos para control 

de movimientos  superficiales, la colocación de estaciones 

inclinométricas y piezométricas aprovechando las 

perforaciones, sondeos y los trabajos de topografía efectuados 

durante la ejecución del estudio. 

 

PERFIL 
FOS 

SIN SISMO 

D 1.506 

E 1.593 
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En total se instalaron 12 puntos de referencia para mediciones 

superficiales, dos inclinómetros denominados I2 e I3 y un 

piezómetro denominado P1.  Los puntos de referencia para 

mediciones superficiales consistieron de estacas de madera 

pintadas de  

rojo con un clavo de acero en la parte superior.  Los 

inclinómetros consistían de tubería específicamente 

manufacturada para efectuar mediciones de deformación 

lateral por Geokon (Manchester, NH) que fue instalada a 

profundidades de 23 y 19.5 metros para asegurar su 

empotramiento en el estrato estable.  El piezómetro consistió 

de tubería ranurada de PVC (tipo Casagrande) de 2 pulgadas de 

diámetro, instalada en la zona aledaña a la autopista, blanco de 

controversia respecto a un posible bloqueo del drenaje de la 

zona por la construcción de la vía. 

 

Es importante notar que los puntos instalados para mediciones 

superficiales se han perdido debido al vandalismo por lo que 

no ha sido posible tomar medidas adicionales luego de las 

mediciones iniciales.  Por esta razón no se incluye información 

referente de los puntos de medición superficial más de su 
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inclusión en el plano topográfico.  Tanto los inclinómetros 

como el piezómetro fueron instalados dentro de cajas de 

protección de acero empotrada en zapatas de hormigón y 

provista de un candado.  Detalles de instalación de esta 

instrumentación, los lugares donde fueron instaladas y los 

resultados de las mediciones están incluidos en los Anexos. 

 

Los datos obtenidos durante el monitoreo de las 

instrumentación instalada hasta el momento de preparación de 

este informe no indica la existencia de movimientos o 

deformación lateral significativa.  Puesto que el monitoreo no 

se ha efectuado durante un plazo de solo los dos meses 

propuestos en la ejecución del presente estudio, los datos 

obtenidos durante el monitoreo son obviamente insuficientes.  

Es factible que mayor número de lecturas presenten datos que 

puedan indicar deformación a largo plazo.  Las características 

físicas de la instrumentación permitirán su utilización por parte 

de un organismo seccional del Estado para efectuar un 

monitoreo a largo plazo. 
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El monitoreo de la instrumentación efectuado en la etapa de 

revisión del presente informe indica que no existen 

desplazamientos significativos.  Puesto que el periodo de 

monitoreo cubrió un período de 4 meses, estos resultados 

indican que el análisis de estabilidad global fue correcto. 

Los resultados del monitoreo se incluyen en el Anexo D-V. 

 

4.1.2   INESTABILIDAD SITIOS CRÍTICOS CARRETERA PLAN DE     MILAGRO – 

INDANZA - GUALAQUIZA 

 

4.1.2.1   ANTECEDENTES 

 

La carretera Troncal Amazónica une las principales ciudades de la región, en especial las capitales de 

Provincia; razón por lo que, de acuerdo a las políticas del Estado, es primordial  realizar estudios de 

Rectificación y Mejoramiento que permitan tener un corredor vial con características geométricas 

similares a las de la Panamericana en la Sierra y la Troncal en la Costa.  

 

Para cumplir con tales objetivos, el Estado a propuesto la realización de los Estudios para la Rectificación 

y Mejoramiento de la Carretera Plan de Milagro – Indanza – Gualaquiza, con una longitud de 80 Km, 

ubicada en la Provincia de Morona Santiago. 

 

4.1.2.2   IMPORTANCIA DE LA CARRETERA EN EL SISTEMA VIAL 

 

El proyecto de la carretera en estudio, está ligada a una red vial existente, la misma que desarrolla una 

estrategia de comunicación terrestre  nacional y local. En dicha red y desde el punto de vista nacional las 

poblaciones de Plan de Milagro y Gualaquiza, constituyen puntos intermedios o nodos por los cuales pasan  

carreteras estatales, definidas por el MOP como arteriales y colectoras, en la medida que prestan servicio a 

determinados volúmenes de tráfico. 
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La carretera en su conjunto bajo este esquema no solo tiene importancia local, sino que  adquiere relevancia 

en el contexto del transporte terrestre interregional entre el sur y norte de la región oriental.  

 

Al mejorar el proyecto pero sin causar daños irreparables 

logrará tener importancia, para la producción ganadera de 

Indanza – Pan de Azúcar – San  Juan Bosco – Bobonanza – 

Kalaglás – Tucumbatza – Túmbez – Los Cedros y Gualaquiza; 

además la siembra de plantas medicinales, turismo ecológico 

al cerro Pan de Azúcar, Cordillera de El Cóndor y construir los 

accesos a las centrales hidroeléctricas en el río Zamora (entre 

los ríos Kalaglás e Indanza) cuya fuente de energía será de 

mucha importancia en el futuro. 

 

Si queremos dar importancia a la Troncal Amazónica, es conveniente mejorar necesariamente las vías de 

entrada como Sigsig – Gualaquiza; Gualaceo -  Limón – Paute – Méndez; Riobamba – Macas. 

Conocemos que por ellas saldrán los oleoductos y gasoductos que transportarán los hidrocarburos de la 

parte tras Cutucú.   

 

4.1.2.3   CARACTERÍSTICAS GENERALES DEL SITIO DE ESTUDIO 

 

Con la información recopilada en el IGM se pudo conformar un mosaico de las siguientes cartas 

topográficas: Indanza, San Juan Bosco, Chigüinda y Gualaquiza, cuyo detalle se encuentra en la figura Nº 

01. 
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El  proyecto se encuentra ubicado al sur oriente del país como se indica en la figura Nº 02; y se desarrolla 

en las jurisdicciones de los cantones Limón-Indanza, San Juan Bosco y Gualaquiza,  de la Provincia de 

Morona Santiago con un recorrido norte-sur, cuyo origen del estudio es el sector denominado Plan de 

Milagro y termina en la parte urbana de la cabecera cantonal de Gualaquiza, como detalla la figura Nº 03. 

Las alturas sobre el nivel del mar de algunas poblaciones son: 

 

Plan de Milagro     1670m 

Indanza      1400m 

Pan de azúcar      1100m 

San Juan Bosco     1000m 

División de ríos Pan de Azúcar-Kalaglás  1700m 

Kalaglás      1200m 

Túmbez                                                                     1600m 

Los Cedros                                                                1400m 

Gualaquiza                                                                800m 

Los puntos de origen y destino tienen las siguientes coordenadas geográficas: 

 
Plan de Milagro                                                 Latitud     N  9’664.300 

                                                                           Longitud       E  780.273 

 

 

Gualaquiza                                                         Latitud     N  9’ 624. 700 

                                                                           Longitud   E   769. 250 

 
 

4.1.2.4   OBJETIVOS 

 

El estudio tiene como objetivos específicos los siguientes: 

 

 Determinar la naturaleza del subsuelo, por medio de la clasificación de los materiales encontrados y 

recuperados durante la ejecución de sondeos mecánicos a roto-percusión en los sitios considerados como 

más críticos. 
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 Conocer las condiciones físicas y propiedades índices del subsuelo en los sitios establecidos como 

críticos por medio de toma de muestras y ensayos de clasificación. 

 

 Analizar la estabilidad global de los taludes en las condiciones topográficas actuales a fin de conocer el 

factor de seguridad al deslizamiento en los sitios de inestabilidad. 

 

 Analizar la estabilidad global de los taludes bajo condiciones modificadas, mediante modelos que 

permitan mejorar sus características ante el deslizamiento. 

 

 Emitir conclusiones y recomendaciones respecto al tipo de obras de protección a fin de garantizar la 

estabilidad de los taludes 
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Figura No. 4.2. Mosaico de cartas topográficas.  

 

 

 

 
 



Generalidades                                                                             ESPE – Carrera de Ingeniería Civil - 2007 

- 146 - 
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Figura No. 4.3. Ubicación del proyecto en el Ecuador.  
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Figura No. 4.4. Ubicación regional del proyecto.  
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4.1.2.5   CARACTERÍSTICAS DEL PROYECTO 

 

A lo largo del proyecto se encuentran varios sitios en los cuales se han producido deslizamientos de los 

taludes y laderas, así como sectores en donde se observan hundimientos de la calzada, con la consecuente 

pérdida de serviciabilidad de la vía.  Estos movimientos de masas de suelo presentan dimensiones 

variables y algunos por su magnitud requieren de un análisis particular pues sus características pueden 

afectar a la vía y en determinadas circunstancias afectar a los usuarios. 

 

En el Tabla No. 4.9 se muestran los sitios en los cuales se han producido movimientos de masas tipo 

deslizamientos a lo largo del proyecto. 

 

 

Tabla No. 4.9. Ubicación de los deslizamientos. 

 

Sitio 

No. 
Abscisas 

Extensión 

(Ha) 

1 4+250 - 4+400 2.00 

2 11+405 – 11+460 0.10 

3 11+740 – 11+800 0.15 

4 23+180 – 23+240 2.00 

5 25+400 – 25+450 0.10 

6 31+100  

7 33+200 0.70 

8 36+800 1.50 

9 42+400 0.15 

10 43+380 2.00 

11 44+300 0.50 

12 45+200 0.70 

13 51+420-51+600 2.00 

14 0+800-1+000 T2 1.25 

15 12+800 T2  

16 16+400 T2 0.50 

 

 

De los sectores indicados en el Tabla No. 4.9 se seleccionaron para su análisis ocho sitios cuyas 

características causan mayor impacto y comprometen a la vía. Los ocho sitios más críticos se indican en 

el Tabla No. 4.10. 

 

 

Tabla No. 4.10. Sitios críticos. 

 

Sitio Crítico 

No. 
Abscisas 

Extensión 

(Ha) 

1 4+250 - 4+400 2.00 
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2 11+405 – 11+460 0.10 

3 23+180 – 23+240 2.00 

4 33+200 0.70 

5 43+380 2.00 

6 51+420 - 51+600 2.00 

7 0+800 - 1+000 T2 1.25 

8 12+800 T2  

 

 

Los sitios críticos indicados en el Tabla No. 4.10 fueron seleccionados durante recorridos de campo en los 

cuales se observó la magnitud de los deslizamientos, el grado de afectación a la vía y se definió el tipo y 

alcance de la investigación a realizar para su posterior análisis, (ver fotografías del Anexo D-I) 

 

4.1.2.6   TRABAJOS REALIZADOS 

 

4.1.2.6.1   Trabajos de Campo 

 

En los ocho sitios críticos, motivo del presente análisis, se llevaron a cabo investigaciones de campo 

cuyas actividades comprendieron: levantamientos topográficos de detalle; exploración geotécnica 

mediante sísmica de refracción, sondeos eléctricos verticales y en algunos sitios sondeos mecánicos a 

roto-percusión con toma de muestras, instalación de piezómetros abiertos del tipo “Casagrande” y 

tuberías empotradas en terreno firme, bajo el plano de deslizamiento para el monitoreo de movimientos 

laterales de las masas de suelo. Los registros de perforación se presentan en el Anexo D-II. 

 

4.1.2.6.2 Trabajos de Laboratorio 

 

Con las muestras de suelo recuperadas durante los sondeos mecánicos realizados en los sitios críticos No. 

1, 5 y 6 se realizaron ensayos de laboratorio consistentes en contenido de humedad, granulometría por 

lavado, límite líquido y límite plástico. Los resultados obtenidos en estos ensayos sirvieron para clasificar 

a los suelos de acuerdo al Sistema Unificado SUCS lo cual permitió conocer la secuencia estratigráfica 

del subsuelo. Los reportes de estos ensayos se adjuntan en el Anexo D-IV. 

 

 

4.1.2.6.3   Análisis de Estabilidad 
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4.1.2.6.3.1   Elaboración de Modelos 

 

Con el fin de analizar la estabilidad de los taludes en los sitios 

más críticos se procedió a elaborar modelos tomando en 

cuenta las condiciones topográficas actuales y asumiendo los 

parámetros geomecánicos de resistencia al corte de los suelos 

en base al tipo de suelos encontrados. Estos modelos se 

elaboraron utilizando la topografía auxiliar, el resultado de las 

investigaciones geotécnicas y de laboratorio.   Los modelos se 

prepararon y analizaron con el programa Gslope. 

 

4.1.2.6.3.2   Selección de los Parámetros de Cálculo 

 

Además de la geometría del talud, tres parámetros influyen en el análisis: los valores de resistencia al 

corte de los materiales, las condiciones del agua subterránea, y el coeficiente de aceleración sísmica 

utilizada en el análisis pseudoestático. 

 

A continuación se presenta un breve comentario de los criterios utilizados para seleccionar cada uno de 

los parámetros de cálculo. 

 

a) Resistencia al Esfuerzo Cortante 

 

El análisis pseudoestático no considera pérdida de resistencia al corte debido al incremento de presión 

hidrostática en el suelo a lo largo de la falla que se estima provocarán las cargas de origen sísmico. 
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El análisis tiende a ser algo conservador cuando se trata de taludes con suelos en estado saturado y 

parcialmente saturados, sin embargo, cuando los suelos del talud se encuentran saturados o pueden llegar 

a saturarse en algún momento, se espera que la pérdida de resistencia al corte afecte la estabilidad del 

talud. Por lo expuesto el análisis toma en cuenta esfuerzos totales. 

 

Para los diferentes análisis se utilizaron valores de los parámetros de resistencia al esfuerzo cortante tales 

como ángulo de fricción y cohesión obtenidos mediante relaciones y correlaciones tanto entre el número 

de golpes de las pruebas SPT así como con la velocidad de onda registradas en los diferentes materiales 

investigados. 

 

b) Aceleración Sísmica 

 

En los análisis del presente estudio se considera la acción sísmica. Se adoptó un coeficiente por sismo de 

0.2g debido a la importancia de la carretera que se encuentra al pie de los taludes, pues, se trata de una de 

una carretera de importancia económica y estratégica para la región sur-oriental del país. 

 

c) Posición de la Superficie Piezométrica (agua subterránea) 

 

Durante el análisis se tomó en cuenta la posición del agua subterránea a fin de evaluar los efectos que esta 

provoca en la estabilidad de los taludes. En los modelos se ubicó la superficie piezométrica cuya 

profundidad fue determinada durante las investigaciones de campo. 

 

4.1.2.6.3.3   Cálculo de los Factores de Seguridad 

 

Utilizando el programa GSlope se procedió con el análisis de la 

estabilidad del talud en función de la geometría de los sitios 

críticos, las condiciones de carga y las propiedades mecánicas 

de los suelos. El cálculo basado en la metodología de análisis 
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propuesta por Bishop, supone superficies de falla circulares y 

superficies de falla específicas no necesariamente circulares 

(análisis tipo Janbu). El análisis permite obtener el menor 

factor de seguridad para cada caso asumiendo escenarios 

(modelos) los cuales permite tomar en cuenta aceleración por 

sismo. 

 

Adicionalmente se calcularon los factores de seguridad mediante el análisis estático y con sismo de los 

modelos cuyas condiciones fueron modificadas mediante la adopción de medidas correctivas.  Esto 

permitió comprobar la estabilidad de los taludes una vez que se implementen las medidas propuestas 

 

4.1.2.7   ANALISIS DE ESTABILIDAD DE SITIOS CRÍTICOS 

 

En el presente numeral se presenta para cada sitio crítico: La descripción del sector, análisis de la 

información obtenida en las exploraciones realizadas, tipología del movimiento, causas probables para el 

deslizamiento, resultados del análisis de estabilidad en condiciones actuales, implementación de medidas 

de corrección y resultados del análisis de estabilidad con la implementación de  las medidas de 

estabilización. 

 

4.1.2.7.1   Sitio Critico No. 1;  KM 4+250 – KM 4+400 

 

a) Descripción 

 

En este sitio se observa un deslizamiento de tipo rotacional, con una superficie de falla que se extiende 

desde la parte alta del talud de corte hasta el pie del talud.  El deslizamiento está afectando la vía y cubre 

un área de 2Ha.  El talud en corte tiene una altura promedio de 70m, con una pendiente aproximada 
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2H:1V. En la actualidad se encuentra en equilibrio crítico, pues, su inclinación es similar a la pendiente 

natural el terreno. 

  

b) Investigaciones Realizadas 

 

En este sitio se llevaron a cabo investigaciones geotécnicas consistentes en exploración indirecta con 

sísmica de refracción, sondeos mecánicos con recuperación de muestras. 

 

El primer sondeo se localizó en la abscisa 4+285 y alcanzó una profundidad de 10.80m en este sitio se 

instaló un piezómetro para futuras mediciones de los niveles de agua subterránea. En la abscisa 4+480 se 

realizó una perforación hasta 12.50m de profundidad, en esta perforación se instaló tubería para futuros 

monitoreos con inclinómetros. Cabe señalar que en los dos sondeos se observó la pérdida notable de flujo 

de perforación a través de grietas y discontinuidades en el subsuelo.  Los registros de perforación  se 

presentan en el Anexo D-II. 

 

De acuerdo con los resultados de las investigaciones realizadas, en este sitio se presentan tres capas: 1) 

una superficial correspondiente al suelo residual constituido por limos y arcillas de color amarillo 

producto de la meteorización de la lutita subyacente, espesor variable, en promedio de 8 metros, con 

velocidades de onda de 557m/s; 2) la capa subyacente corresponde una lutita meteorizada, (V = 

1250m/s), de potencia variable cuyo espesor varía de nulo en la parte superior del talud hasta 14m en sus 

parte más potentes; 3) el estrato inferior conformado por una lutita densa  con velocidades de onda de 

2000m/S, (roca sana). 

 

c) Tipología del Movimiento 

 

El movimiento de masa de suelo observado tiene las características de un deslizamiento rotacional; en la 

parte alta se distingue la superficie de falla expuesta, con forma en planta semicircular, el suelo residual 

se ha deslizado sobre el contacto con la lutita meteorizada y llega al pie del talud, sin embargo, de 

acuerdo con las perforaciones realizadas se estima que la superficie de falla puede encontrarse bajo la 

calzada. 
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d) Causas 

 

La ausencia total de cunetas de coronación en la ladera que impiden controlar las aguas lluvias, las  

mismas que a más de saturar la capa de suelo superficial se infiltran a través de ella, provocando al 

pérdida de resistencia al esfuerzo cortante.  Los cortes  realizados para conformar la vía generaron una 

pendiente del orden 1H:1V, la cual contribuyó al deslizamiento de la masa de suelo. 

 

e) Factores de Seguridad en Condiciones Actuales 

 

Los factores de seguridad obtenidos de los análisis de estabilidad del talud en condiciones estáticas (sin 

sismo) y en condiciones dinámicas generadas por un coeficiente de aceleración  de 0.2g son: 

 

 Geometría actual sin sismo:  FS = 1.024 

 Geometría actual con sismo:  FS = 0.795 

 

Los resultados confirman que la superficie de falla se presenta en el contacto entre el suelo superficial 

(limos arcillosos) con el material lutita meteorizada. Los diagramas con los análisis se presentan en el 

Anexo D-III. 

 

f) Medidas de Corrección 

 

Con el fin de incrementar el factor de seguridad que presentan los taludes en este sitio bajo condiciones 

actuales, se analizaron varias alternativas. Las medidas correctivas que se indican a continuación son 

aquellas que garantizarán la estabilidad de acuerdo con las características de los suelos y las condiciones 

topográficas del sitio. Las medidas propuestas son: 

 

 Conformar el talud a media ladera con un a inclinación 2H:1V, construyendo una berma de 5m 

de ancho con sus respectivas cunetas. 
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 Contrafuerte con tierra armada de 5m de altura en el pie del talud, junto a la vía, utilizando 

refuerzo de geomalla estructural. Este contrafuerte de tierra armada deberá contar con drenes 

para al recolección de aguas y su respectiva conducción hacia las alcantarillas, 

 Cunetas de coronación con geomembrana, revestidas con piedra a fin de controlar el agua de 

escorrentía superficial. Se considera que las cunetas de geomembrana serán más efectivas al 

evitar fisuras a largo plazo a pesar de posibles problemas de vandalismo i.e. recubrimiento de 

piedra 

 Se deberán sellar las grietas con suelo del lugar y revegetar el talud con especies del sector. 

 

Se procedió a elaborar un modelo de análisis con las medidas antes anotadas a fin de verificar la 

estabilidad del talud e idoneidad de las soluciones propuestas. 

 

g) Factores de Seguridad en Condiciones Modificadas 

 

Una vez elaborado el modelo del talud con las medidas correctivas antes descritas se procedió a calcular 

los factores de seguridad en condición estática dinámica.  Los resultados de los análisis son los siguientes: 

 

 Geometría modificada sin sismo  FS = 1.739 

 Geometría modificada con sismo  FS = 1.085 

 

Los resultados muestran que el plano de falla modificado compromete un volumen menor de materiales 

potencialmente deslizables presentes en el cuerpo del talud, pues, el comportamiento del talud ante las 

solicitaciones por sismo es considerablemente mejor. 

  

En el Anexo D-VIII se presentan las memorias de cálculo de los factores de seguridad tomando en cuenta 

las condiciones modificadas por la implementación de las medidas de corrección. 

 

4.1.2.7.2   Sitio Critico No. 2;  KM 11+405 – KM 11+460 

 

a) Descripción 
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En este sitio la superficie de falla  se extiende desde la parte alta del talud de corte hasta el pie del mismo, 

en donde se encuentra la vía, compromete un área de 0.10Ha. El talud en corte tiene una altura promedio 

de 40m, con una pendiente aproximada 1.5H:1V. Se observa gran acumulación de agua en las capas 

superficiales de suelo debido a la presencia de zonas pantanosas especialmente en la parte superior del 

camino que conduce a Piamonte. 

  

b) Investigaciones Realizadas 

 

En este sitio se hicieron prospecciones del tipo sísmica de refracción y sondeos eléctricos verticales. Los 

registros de la exploración sísmica y sondeos eléctricos se presentan en los anexos. 

 

Según los resultados de las prospecciones sísmica y eléctrica, el subsuelo en este sitio presenta dos capas: 

1) la primera capa superficial correspondiente al suelo residual constituido por limos y arcillas no 

consolidadas de espesor variables entre 1.4m y 3m, con velocidades de onda de 337m/s; 2) una segunda 

capa subyacente a la anterior conformada por lutitas meteorizadas, con velocidades de onda registradas de 

1740m/s, con espesores mayores a 40m. 

 

c) Tipología del Movimiento 

 

El movimiento de masa de suelo observado tiene las características de un deslizamiento traslacional- 

rotacional; en la parte alta se distingue la superficie de falla expuesta mediante un escarpe con forma de 

parábola. El suelo residual se ha deslizado sobre el contacto con la lutita meteorizada. 

 

d) Causas 

 

La sobresaturación del suelo de cobertura incrementa el peso del suelo limo-arcilloso lo cual favorece al 

movimiento de la capa superficial. Adicionalmente el suelo arcilloso saturado que se encuentra en 

contacto con las lutitas poco meteorizadas forma una superficie deslizante sobre la cual se produce el 

movimiento. 



Generalidades                                                                             ESPE – Carrera de Ingeniería Civil - 2007 

- 157 - 

 

e) Factores de Seguridad en Condiciones Actuales 

 

Los factores de seguridad obtenidos de los análisis de estabilidad del talud en condiciones estáticas (sin 

sismo) y en condiciones dinámicas generadas por un coeficiente de aceleración  de 0.2g son: 

 

 Geometría actual sin sismo:  FS = 1.007 

 Geometría actual con sismo:  FS = 0.534 

 

Los resultados confirman que la superficie de falla se presenta en el contacto entre el suelo superficial 

(limos arcillosos) con el material lutita meteorizada. Los diagramas con los análisis se presentan en el 

Anexo D-III. 

 

f) Medidas de Corrección 

 

Con el fin de incrementar el factor de seguridad al deslizamiento que presentan los taludes en este sitio 

bajo, las condiciones actuales, se analizaron varias alternativas para la implementación de medidas de 

corrección. Las medidas correctivas que se indican a continuación son aquellas que garantizarán la 

estabilidad, de acuerdo con las características de los suelos y las condiciones topográficas del sitio. Las 

medidas propuestas son: 

 

 Un contrafuerte de tierra armada de 6m de altura en el pie del talud, junto a la vía, utilizando 

refuerzo de geomalla estructural. Este contrafuerte de tierra armada deberá contar con drenes 

para al recolección de aguas y su respectiva conducción hacia las alcantarillas. 

 Cunetas de coronación con geomembrana, revestidas con piedra a fin de controlar el agua de 

escorrentía superficial. 

 

Se procedió a elaborar un modelo de análisis con las medidas antes anotadas a fin de verificar la 

estabilidad del talud e idoneidad de las soluciones propuestas. 
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g) Factores de Seguridad en Condiciones Modificadas 

 

Una vez elaborado el modelo del talud con las medidas correctivas se procedió a calcular los factores de 

seguridad en condición estática y con aceleración por sismo.  Los resultados de los análisis son los 

siguientes: 

 

 Geometría modificada sin sismo  FS = 1.372 

 Geometría modificada con sismo  FS = 0.718 

 

Los resultados muestran que la posición del plano de falla es la misma que la obtenida en condiciones 

actuales del talud, sin embargo, con la modificación de las condiciones del talud a través de la 

implementación de las obras antes indicadas el factor de seguridad al deslizamiento es mayor y su 

respuesta es mejor ante las solicitaciones por sismo. A pesar de que la posibilidad de estabilizar el talud 

bajo condiciones dinámicas existe este tipo de estabilización no se ha propuesto porque implicaría 

medidas estructurales prohibitivas en cuanto a corte. 

 

En los Anexo D-VIII se presentan las memorias de cálculo de los factores de seguridad tomando en 

cuenta las condiciones modificadas por la implementación de las medidas de corrección. 

 

4.1.2.7.3   Sitio Crítico No. 3;  KM 23+180 – 23+240 

 

a) Descripción 

 

En este sitio el deslizamiento presenta una superficie de falla que se extiende desde la parte alta del talud 

(línea de agua) hasta el nivel de la vía, compromete un área de 2Ha. El talud en corte tiene una altura 

promedio de 50m, con pendientes variables. Se observa retención de agua en las capas superficiales de 

suelo. 

  

b) Investigaciones Realizadas 
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En este sitio se realizaron investigaciones del tipo sísmica de refracción y sondeos eléctricos verticales. 

Los registros de la exploración sísmica y sondeos eléctricos se presentan en los anexos. 

 

Según los resultados de las prospecciones sísmica y eléctrica, el subsuelo en este sitio presenta dos capas: 

1) la primera capa superficial correspondiente al suelo residual constituido por limos y arcillas no 

consolidadas, alteradas, cuyo espesor varía entre 2.5m y 5m, con velocidades de onda de 260m/s; 2) una 

segunda capa subyacente a la anterior conformada por lutitas meteorizadas (roca metamórfica) en la cual 

se registraron velocidades de onda de 2350 m/s, cuyo espesor supera los 40m. 

 

c) Tipología del Movimiento 

 

De acuerdo con los escarpes observados a diferentes alturas y posiciones del cuerpo del deslizamiento se 

estima que el movimiento de tipo rotacional se produce por efectos de la pendiente conformada en los 

taludes como resultado del movimiento de tierras durante la construcción de la vía, especialmente en el 

sector de la curva horizontal que hace la vía en la abscisa 23+200. 

 

Las características del suelo de cobertura han contribuido al deslizamiento, pues, los suelos arcillosos 

saturados estos se deslizan a través de un plano de falla rotacional el cual afecta hasta una altura de 18m 

sobre la vía. 

La presencia del río Pan de Azúcar en al cota 953 aproximadamente puede influir en la estabilidad del 

talud en este sitio, pues, se observaron signos de erosión en el pie de la ladera. 

d) Causas 

 

Los taludes con pendientes H:1-V:1 favorecen al movimiento de los limos arcillosos saturados debido a la 

falta de cunetas de coronación y al acumulamiento de agua lluvias las mismas que por infiltración saturan 

a toda la masa de suelo potencialmente deslizable. 

 

e) Factores de Seguridad en Condiciones Actuales 
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Los factores de seguridad obtenidos de los análisis de estabilidad del talud en condiciones estáticas (sin 

sismo) y en condiciones dinámicas generadas por un coeficiente de aceleración  de 0.2g son: 

 

 Geometría actual sin sismo:  FS = 1.013 

 Geometría actual con sismo:  FS = 0.754 

 

Los resultados muestran que la posición de la superficie de falla tiende al contacto entre el suelo 

superficial (limos arcillosos) con el material lutita meteorizada. Los diagramas con los análisis se 

presentan en el Anexo D-III. 

 

f) Medidas de Corrección 

 

Con el fin de incrementar el factor de seguridad al deslizamiento que presentan los taludes en este sitio 

bajo las condiciones actuales se analizaron varias alternativas para la implementación de medidas de 

corrección. Las medidas correctivas que se indican a continuación son aquellas que garantizarán la 

estabilidad, de acuerdo con las características de los suelos y las condiciones topográficas del sitio. Las 

medidas propuestas son: 

 

 Conformar taludes con bermas intermedias e 5m de ancho e inclinación 2H:1V, con sus 

respectivas cunetas para control de agua de escorrentía. 

 Cunetas de coronación con geomembrana, revestidas con piedra a fin de controlar el agua de 

escorrentía superficial. 

 Revegetación de taludes conformados con especies vegetales de la zona. 

 

Se procedió a elaborar un modelo de análisis con las medidas antes anotadas a fin de verificar la 

estabilidad del talud e idoneidad de las soluciones propuestas. 

 

g) Factores de Seguridad en Condiciones Modificadas 
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Una vez elaborado el modelo del talud con las medidas correctivas antes descritas se procedió a calcular 

los factores de seguridad en condición estática y con aceleración por sismo.  Los resultados de los análisis 

son los siguientes: 

 

 Geometría modificada sin sismo  FS = 1.674 

 Geometría modificada con sismo  FS = 1.130 

 

Los resultados muestran que el plano de falla modificado para la condición estática sin sismo compromete 

un volumen menor de materiales potencialmente deslizables presentes en el cuerpo del talud. Para el caso 

del análisis de las condiciones modificadas con solicitaciones por sismo, el nuevo plano de falla 

modificado afectaría al material conformado por lutitas meteorizadas. 

  

En los Anexos D-VIII se presentan las memorias de cálculo de los factores de seguridad tomando en 

cuenta las condiciones modificadas por la implementación de las medidas de corrección. 

 

4.1.2.7.4   Sitio Crítico No. 4;  KM 33+200 

 

a) Descripción 

 

El deslizamiento presenta en planta una forma parabólica cuya área compromete 0.7Ha. El deslizamiento 

propiamente dicho se extiende desde la parte superior del talud, es decir a unos 35m de altura medidos 

desde el nivel de la vía hasta la parte baja en la cual se han depositado los materiales deslizados. Se 

observa movimiento de tipo traslacional y rotacional el cual ha afectado a la obra básica generando 

deformaciones en la vía y pérdida de por lo menos la mitad de la carretera en una longitud de 80m 

  

b) Investigaciones Realizadas 

 

Las investigaciones geotécnicas llevadas a cabo en este sitio comprendieron dos perforaciones mecánicas 

con toma de muestras, investigación sísmica y sondeos eléctricos verticales. Los registros de las 
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perforaciones así como los resultados de la exploración sísmica y sondeos eléctricos se presentan en los 

anexos. 

 

En este sitio se realizaron dos perforaciones hasta 15m de profundidad cada una ubicada en la abscisa 

33+282 la primera y la segunda en la abscisa 33+346. En la primera perforación se instaló un piezómetro 

a 8.6m de profundidad, detectándose agua subterránea a 2.4m. En el segundo sondeo se instaló tubería 

para monitoreo con inclinómetro a 15m de profundidad. 

 

Según los resultados de las prospecciones geotécnicas, el subsuelo en este sitio presenta dos capas: 1) una 

capa superficial correspondiente al suelo residual constituido por limos y arcillas no consolidadas, poco 

consistentes cuyo espesor varía entre 3.4m y 7m, con velocidades de onda de 310m/s; 2) una segunda 

capa subyacente a la anterior conformada por lutitas meteorizadas en la cual se registraron velocidades de 

onda de 2220 m/s, cuyo espesor supera los 40m. 

 

c) Tipología del Movimiento 

 

De acuerdo con las características del movimiento observadas durante los recorridos de campo  se estima 

que el movimiento de la masa de suelo es del tipo rotacional del estrato de suelo superior, es decir de los 

limos arcilloso saturados. Adicionalmente la pérdida de masa de suelo al producirse los movimientos han 

afectado a  la vía debido a la falta de sustentación sobre suelos deformables. 

 

d) Causas 

 

La topografía de la zona conjugada con las obras de construcción, la baja resistencia al esfuerzo cortante 

de los suelos de los suelos y la excesiva presencia de lluvias han generado un escenario para que los 

suelos limo-arcillosos superficiales saturados se deslicen a través del contacto de suelos más competentes. 

 

e) Factores de Seguridad en Condiciones Actuales 
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Los factores de seguridad obtenidos de los análisis de estabilidad del talud en condiciones estáticas (sin 

sismo) y en condiciones dinámicas generadas por un coeficiente de aceleración  de 0.2g son: 

 

 Geometría actual sin sismo:  FS = 1.019 

 Geometría actual con sismo:  FS = 0.704 

 

Los resultados muestran que la posición de la superficie de falla se localiza en el contacto entre en el 

suelo superficial (limos arcillosos) con el material lutita meteorizada. Los diagramas con los análisis se 

presentan en el Anexo D-III. 

 

f) Medidas de Corrección 

 

Con el fin de incrementar el factor de seguridad al deslizamiento que presentan los taludes en este sitio 

bajo, las condiciones actuales, se analizaron varias alternativas para la implementación de medidas de 

corrección. Las medidas correctivas que se indican a continuación son aquellas que garantizarán la 

estabilidad, de acuerdo con las características de los suelos y las condiciones topográficas del sitio. Las 

medidas propuestas son: 

 

 Conformar taludes con bermas intermedias de 5m de ancho e inclinaciones 2H:1V, con sus 

respectivas cunetas para recolección y control del agua de escorrentía. 

 Cunetas de coronación con geomembrana, revestidas con piedra a fin de controlar el agua de 

escorrentía superficial. 

 Revegetación de los taludes conformados con especies de la zona. 

 

Se procedió a elaborar un modelo de análisis con las medidas antes anotadas a fin de verificar la 

estabilidad del talud e idoneidad de las soluciones propuestas. 

 

g) Factores de Seguridad en Condiciones Modificadas 
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Una vez elaborado el modelo del talud con las medidas correctivas antes descritas se procedió a calcular 

los factores de seguridad en condición estática y con aceleración por sismo.  Los resultados de los análisis 

son los siguientes: 

 

 Geometría modificada sin sismo  FS = 1.386 

 Geometría modificada con sismo  FS = 0.930 

 

Los resultados muestran que el plano de falla modificado tanto para la condición estática como para el 

análisis con sismo compromete un volumen menor de materiales potencialmente deslizables presentes en 

el cuerpo del talud.  

  

En los Anexo D-VIII se presentan las memorias de cálculo de los factores de seguridad tomando en 

cuenta las condiciones modificadas por la implementación de las medidas de corrección. 

 

4.1.2.7.5   Sitio Crítico No. 5;  KM 43+380 

 

a) Descripción 

 

Este sitio de deslizamiento es el más importante debido a las características del movimiento, el mismo 

que en planta presenta una forma semicircular y compromete un área de 2Ha. El deslizamiento es antiguo 

y actualmente se encuentran en movimiento masas de suelo saturado con pendientes pequeñas las cuales 

afectan a la vía, la misma que se encuentra dentro del deslizamiento.  

 

b) Investigaciones Realizadas 

 

Las investigaciones geotécnicas llevadas a cabo en este sitio comprendieron dos perforaciones mecánicas 

con toma de muestras, investigación sísmica y sondeos eléctricos verticales. Los registros de las 

perforaciones así como los resultados de la exploración sísmica y sondeos eléctricos se presentan en los 

anexos. 
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En este sitio se realizaron dos perforaciones hasta 15m de profundidad cada una ubicada en la abscisa 

43+423 la primera y la segunda en la abscisa 43+450. En la primera perforación se instalaron facilidades 

para mediciones futuras con inclinómetro; en la segunda perforación se detectó la presencia de gran 

cantidad de agua a una profundidad de 5.6m. En este sondeo se instaló un piezómetro a 6m de 

profundidad. 

  

Según los resultados de las prospecciones geotécnicas, el subsuelo en este sitio presenta tres capas: 1) un 

estrato de suelo superficial, el cual incluye la capa vegetal, suelo residual constituido por limos y arcillas 

cuyo espesor varía entre 1.6m y 4.5m, con velocidades de onda de 440m/s; 2) la segunda capa 

conformada por lutitas meteorizadas saturadas con presencia de arcillas plásticas en su mayoría, con 

velocidades de traspaso de onda de 1740m/s con espesores variables entre 5m y 12m; 3) la tercera capa, 

subyacente a la anterior a profundidades de 6m, 15m y 17m a lo largo del perfil de análisis compuesta por 

areniscas competentes (roca sana), con velocidades de traspaso de onda de 3380m/s. 

 

c) Tipología del Movimiento 

 

El movimiento observado en este sitio es de tipo traslacional debido al avance de la masa de suelo 

saturado hacia la vía ocasionando deformaciones. Bajo la vía se estima que el plano de falla es rotacional. 

 

d) Causas 

 

En base a las observaciones y a la topografía de detalle el movimiento se produce debido a la gran 

acumulación de agua en el suelo superficial contenido en una antigua línea colectora natural de aguas. El 

suelo se encuentra totalmente saturado inclusive el estrato intermedio conformado por arcillas plásticas 

con fragmentos de lutitas meteorizadas, debido al incremento de peso del suelo y la presión de poros 

generada por el agua, siendo esta la principal causa para el deslizamiento. 

 

e) Factores de Seguridad en Condiciones Actuales 
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Los factores de seguridad obtenidos de los análisis de estabilidad del talud en condiciones estáticas (sin 

sismo) y en condiciones dinámicas generadas por un coeficiente de aceleración  de 0.2g son: 

 

 Geometría actual sin sismo:  FS = 1.021 

 Geometría actual con sismo:  FS = 0.555 

 

Los resultados muestran que la posición de la superficie de falla se localiza en el contacto entre en el 

estrato de arcillas plásticas saturadas con la roca sana competente (arenisca). Los diagramas con los 

análisis se presentan en el Anexo D-III. 

 

f) Medidas de Corrección 

 

Con el fin de incrementar el factor de seguridad al deslizamiento que presentan los taludes en este sitio 

bajo, las condiciones actuales, se analizaron varias alternativas para la implementación de medidas de 

corrección. Las medidas correctivas que se indican a continuación son aquellas que garantizarán la 

estabilidad, de acuerdo con las características de los suelos y las condiciones topográficas del sitio. Las 

medidas propuestas son: 

 

 Un sistema de pantallas de hormigón ancladas utilizando anclajes mecánicos de 20m de 

longitud. 

 Un sistema de subdrenes de grava tipo “espina de pescado”. La grava irá encapsulada con 

geotextil tipo no tejido, dentro de zanjas cuya profundidad variará entre 1.2m y 1.6m. El sistema 

de subdrenes se conectará al sistema de drenaje de la vía y a obras de arte menor (cunetones) que 

se construirán junto a la vía.  Sobre los subdrenes se conformarán cunetas utilizando 

geomembrana la cual será revestida con piedras cuyo diámetro varíe entre 10 y 15 cm a fin de 

controlar el exceos de agua superficial en la zona. 

 Instalación de drenes horizontales de 45 m. de longitud para abatimiento del nivel freático en la 

zona de la vía. 

 Cunetas de coronación con geomembrana, revestidas con piedraa fin de controlar el agua de 

escorrentía superficial. 
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 Revegetación de  los taludes conformados con especies vegetales de la zona. 

 

Se procedió a elaborar un modelo de análisis con las medidas antes anotadas a fin de verificar la 

estabilidad del talud e idoneidad de las soluciones propuestas. 

 

g) Factores de Seguridad en Condiciones Modificadas 

 

Una vez elaborado el modelo del talud con las medidas correctivas antes descritas se procedió a calcular 

los factores de seguridad en condición estática y con aceleración por sismo.  Los resultados de los análisis 

son los siguientes: 

 

 Geometría modificada sin sismo  FS = 1.395 

 Geometría modificada con sismo  FS = 0.748 

 

Los resultados muestran que el plano de falla modificado tanto para la condición estática como para el 

análisis con sismo comprometen un volumen menor de materiales potencialmente deslizables presentes 

en el cuerpo del talud, demostrando que la construcción de pantallas ancladas incrementan el factor de 

seguridad considerablemente.  

  

En los Anexos D-VIII se presentan las memorias de cálculo de los factores de seguridad tomando en 

cuenta las condiciones modificadas por la implementación de las medidas de corrección. 

 

4.1.2.7.6   Sitio Crítico No. 6;  KM 51+420 – 51+600 

 

a) Descripción 

 

Este sitio compromete un área de 2Ha en la cual se observan escarpes ubicados a diferentes alturas en 

donde se aprecian troncos de árboles deformados e inclinados. El movimiento de la masa de suelo afecta 

al trazado de la carretera, pues, se observan deformaciones de magnitud considerable en la geometría de 
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la vía. En algunos sectores se encuentra vegetación propia de sitios en los cuales se acumula el agua. Se 

observa actividad en este sitio una vez que inicia la temporada de lluvias. 

 

b) Investigaciones Realizadas 

 

Las investigaciones geotécnicas llevadas a cabo en este sitio comprendieron dos perforaciones mecánicas 

con toma de muestras, investigación sísmica y sondeos eléctricos verticales. Los registros de las 

perforaciones así como los resultados de la exploración sísmica y sondeos eléctricos se presentan en los 

anexos. 

 

En este sitio se realizaron dos perforaciones hasta 15m de profundidad cada una ubicada en la abscisa 

51+460 la primera y la segunda en la abscisa 51+480. En la primera perforación se instalaron facilidades 

para mediciones futuras con inclinómetro; en la segunda perforación se instaló un piezómetro a 6m de 

profundidad. Durante la ejecución de los dos sondeos se detectó al presencia de nivel freático a 0.2m en el 

primero y a 0.45m en el segundo sondeo. Una vez instalado el piezómetro del segundo sondeo el nivel 

freático se ubicó en 2m de profundidad. 

  

Según los resultados de las prospecciones geotécnicas, el subsuelo en este sitio presenta tres capas: 1) un 

estrato de suelo superficial, suelo residual constituido por limos y arcillas cuyo espesor varía entre 1.2m y 

2.2m, con velocidades de onda de 270m/s; 2) una segunda capa conformada por lutitas meteorizadas, con 

velocidades de traspaso de onda de 1537m/s con espesores variables entre 15.7m y 32m; 3) la tercera 

capa, subyacente a la anterior compuesta por roca sana y dura, con velocidades de traspaso de onda muy 

alta de 4600m/s. 

 

c) Tipología del Movimiento 

 

El movimiento observado en este sitio es de tipo rotacional desde la parte alta del talud hasta unos 10 m 

sobre la vía. El deslizamiento de geometría semicircular delimitado por escarpes indica la trayectoria del 

movimiento a lo largo del tiempo. El movimiento de la capa superficial o suelo de cobertura es de tipo 

traslacional. 
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d) Causas 

 

Las causa fundamentales para el movimiento de los taludes en este sitio son las características mecánicas 

de los suelos, es decir, la poca o nula resistencia al esfuerzo cortante, la falta de elementos de drenaje 

superficial para control de agua de escorrentía lo cual ocasiona el acumulamiento de agua en la parte baja 

del talud, junto a la vía y la sobresaturación del suelo arcilloso. 

 

e) Factores de Seguridad en Condiciones Actuales 

 

Los factores de seguridad obtenidos de los análisis de estabilidad del talud en condiciones estáticas (sin 

sismo) y en condiciones dinámicas generadas por un coeficiente de aceleración  de 0.2g son: 

 

 Geometría actual sin sismo:  FS = 1.077 

 Geometría actual con sismo:  FS = 0.790 

 

Los resultados muestran que la posición de la superficie de falla se localiza en el estrato conformado por 

lutitas meteorizadas.  Los diagramas con los análisis se presentan en el Anexo D-III. 

 

f) Medidas de Corrección 

 

Con el fin de incrementar el factor de seguridad al deslizamiento que presentan los taludes en este sitio 

bajo, las condiciones actuales, se analizaron varias alternativas para la implementación de medidas de 

corrección. Las medidas correctivas que se indican a continuación son aquellas que garantizarán la 

estabilidad, de acuerdo con las características de los suelos y las condiciones topográficas del sitio. Las 

medidas propuestas son: 

 

 Conformar taludes con bermas intermedias de 5m de ancho e inclinaciones 2H:1V con sus 

respectivas cunetas para recolección y control del agua de escorrentía. 
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 Cunetas de coronación con geomembrana, revestidas con piedra a fin de controlar el agua de 

escorrentía superficial. 

 Revegetación de los taludes conformados con especies de la zona. 

 

Se procedió a elaborar un modelo de análisis con las medidas antes anotadas a fin de verificar la 

estabilidad del talud e idoneidad de las soluciones propuestas. 

 

g) Factores de Seguridad en Condiciones Modificadas 

 

Una vez elaborado el modelo del talud con las medidas correctivas antes descritas se procedió a calcular 

los factores de seguridad en condición estática y con aceleración por sismo.  Los resultados de los análisis 

son los siguientes: 

 

 Geometría modificada sin sismo  FS = 1.245 

 Geometría modificada con sismo  FS = 0.781 

 

Los resultados muestran que el plano de falla modificado para la condición estática compromete un 

menor volumen de material el cual no afecta a la vía, pues, el deslizamiento, en caso de ocurrir, se 

produciría en la parte superior del talud. 

 

Bajo solicitaciones de sismo el talud se vería afectado debido al deslizamiento de una masa de suelo de 

magnitud considerable. 

 

En los Anexos D-VIII se presentan las memorias de cálculo de los factores de seguridad tomando en 

cuenta las condiciones modificadas por la implementación de las medidas de corrección. 

 

4.1.2.7.7   Sitio Crítico No. 7;  KM 0+800 – 1+000; Tramo 2 

 

a) Descripción 
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El deslizamiento afecta un área de 1.25Ha cuya geometría en planta semicircular compromete a la 

carretera debido a las deformaciones del trazado horizontal y a los hundimientos de la obra básica en al 

menos tres sitios. El deslizamiento se encuentra activo. 

 

b) Investigaciones Realizadas 

 

En este sitio se llevó a cabo la investigación geotécnica mediante sísmica de refracción y sondeos 

eléctricos verticales. Los registros de la exploración sísmica y sondeos eléctricos se presentan en los 

anexos. 

 

Según los resultados de las prospecciones geotécnicas, el subsuelo en este sitio presenta tres capas: 1) un 

estrato de suelo superficial, suelo residual constituido por limos y arcillas cuyo espesor varía entre 2m y 

2.9m, con velocidades de onda de 320m/s; 2) una segunda capa conformada por lutitas meteorizadas 

duras, con velocidades de traspaso de onda de 1537m/s con espesores variables entre 2.2m y 33m; 3) la 

tercera capa, subyacente a la anterior compuesta por roca sana y dura, con velocidades de traspaso de 

onda muy alta de 4600m/s. 

 

c) Tipología del Movimiento 

 

El movimiento observado en este sitio es de tipo rotacional desde la parte alta del talud hasta unos 10 m 

sobre la vía. El deslizamiento de geometría semicircular en planta está delimitado por escarpes que 

indican la trayectoria del movimiento a lo largo del tiempo. El movimiento de la capa superficial o suelo 

de cobertura es de tipo traslacional. 

 

d) Causas 

 

Las causas fundamentales para el movimiento de los taludes en este sitio son las características mecánicas 

de los suelos, es decir, la poca o nula resistencia al esfuerzo cortante, la falta de elementos de drenaje 

superficial para control de agua de escorrentía lo cual ocasiona el acumulamiento de agua y la 

sobresaturación del suelo arcilloso. 
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e) Factores de Seguridad en Condiciones Actuales 

 

Los factores de seguridad obtenidos de los análisis de estabilidad del talud en condiciones estáticas (sin 

sismo) y en condiciones dinámicas generadas por un coeficiente de aceleración  de 0.2g son: 

 

 Geometría actual sin sismo:  FS = 1.061 

 Geometría actual con sismo:  FS = 0.670 

 

Los resultados muestran que la posición de la superficie de falla se localiza en el contacto entre la capa de 

suelos arcillosos saturado y el estrato de lutita meteorizada.  Los diagramas con los análisis se presentan 

en el Anexo D-III. 

 

f) Medidas de Corrección 

 

Con el fin de incrementar el factor de seguridad al deslizamiento que presentan los taludes en este sitio 

bajo, las condiciones actuales, se analizaron varias alternativas para la implementación de medidas de 

corrección. Las medidas correctivas que se indican a continuación son aquellas que garantizarán la 

estabilidad, de acuerdo con las características de los suelos y las condiciones topográficas del sitio. Las 

medidas propuestas son: 

 

 Conformar taludes con bermas intermedias de 5m de ancho e inclinaciones 2H:1V con sus 

respectivas cunetas para recolección y control del agua de escorrentía. 

 Cunetas de coronación con geomembrana, revestidas con piedra a fin de controlar el agua de 

escorrentía superficial. 

 Revegetación de los taludes conformados con especies de la zona. 

 

Se procedió a elaborar un modelo de análisis con las medidas antes anotadas a fin de verificar la 

estabilidad del talud e idoneidad de las soluciones propuestas. 
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g) Factores de Seguridad en Condiciones Modificadas 

 

Una vez elaborado el modelo del talud con las medidas correctivas antes descritas se procedió a calcular 

los factores de seguridad en condición estática y con aceleración por sismo.  Los resultados de los análisis 

son los siguientes: 

 

 Geometría modificada sin sismo  FS = 1.286 

 Geometría modificada con sismo  FS = 0.837 

Los resultados muestran que el plano de falla modificado tanto para la condición estática como para el 

modelo analizado bajo solicitaciones de sismo compromete un menor volumen de material el cual no 

afecta a la vía, pues, el deslizamiento, en caso de ocurrir, se produciría en la parte superior del talud. 

 

En los Anexos D-VIII se presentan las memorias de cálculo de los factores de seguridad tomando en 

cuenta las condiciones modificadas por la implementación de las medidas de corrección. 

 

4.1.2.7.8   Sitio Crítico No. 8;  KM 12+800; Tramo 2 

 

a) Descripción 

 

Este deslizamiento es de pequeñas proporciones y de tipo superficial, afecta a un área pequeña del sector 

adyacente a la vía. El área de estudio presenta gran acumulación de agua en el suelo superficial de 

cobertura, lo cual origina le movimiento a pesar de que el terreno casi no presenta inclinación en algunos 

sitios y en otros su pendiente es moderada. 

 

b) Investigaciones Realizadas 

 

En este sitio se llevó a cabo la investigación geotécnica mediante sísmica de refracción y sondeos 

eléctricos verticales. Los registros de la exploración sísmica y sondeos eléctricos se presentan en los 

anexos. 
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Según los resultados de las prospecciones geotécnicas, el subsuelo en este sitio presenta tres capas: 1) un 

estrato de suelo superficial, suelo residual saturado constituido por limos y arcillas incluyendo el 

horizonte del suelo vegetal cuyo espesor varía entre 2.1m y 4.2m, con velocidades de onda de 380m/s; 2) 

una segunda capa conformada por lutitas en estado medianamente meteorizado, con velocidades de 

traspaso de onda de 2350m/s. 

 

c) Tipología del Movimiento 

 

El movimiento observado en este sitio es de tipo traslacional - rotacional en la parte de más inclinada del 

talud, cuya pendiente es del orden de 2.5H:1V. 

  

d) Causas 

 

El movimiento de la masa de suelo a pesar de la poca inclinación del talud se debe a la sobresaturación 

del suelo superficial provocada por la ausencia de cunetas o elementos para control de drenaje del agua de 

escorrentía.. 

  

e) Factores de Seguridad en Condiciones Actuales 

 

Los factores de seguridad obtenidos de los análisis de estabilidad del talud en condiciones estáticas (sin 

sismo) y en condiciones dinámicas generadas por un coeficiente de aceleración  de 0.2g son: 

 

 Geometría actual sin sismo:  FS = 2.082 

 Geometría actual con sismo:  FS = 1.220 

 

Los resultados ratifican que la posición de la superficie de falla se localiza en el contacto entre la capa de 

suelos arcillosos saturados y el estrato de lutita meteorizada, a pesar de que los valores de factor se de 

seguridad al deslizamiento en condición estática y con sismo son altos.  

 

f) Medidas de Corrección 
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En este sitio las medidas de corrección se limitan a la reconformación del suelo del talud, sin modificar la 

pendiente del mismo y la construcción de cunetas de coronación utilizando geomembrana y revistiéndolas 

de piedras cuyos diámetros varíen entre 10 y 15cm. 

 

Tomando en cuenta los resultados del análisis de estabilidad del talud en condiciones actuales en este 

sitio, cuyos valores de factor de seguridad al deslizamiento son altos, no se requirió analizar el modelo 

con medidas de corrección. 

 

 

 

4.1.2.8   RESUMEN DE RESULTADOS 

 

En el Cuadro No. 3 se presenta un resumen con los factores de seguridad al deslizamiento obtenidos de 

los numerosos análisis llevados a cabo tanto para determinar el factor de seguridad al deslizamiento 

remanente en condiciones actuales como para demostrar que las recomendaciones emitidas en el literal f) 

“Medidas de Corrección” de los numerales 4.1.2.7.1 a 4.1.2.7.8 son las más adecuadas para garantizar la 

estabilidad de las laderas. 

 

 

 

 

 

 

Tabla No. 4.11. Resultados del análisis de estabilidad de taludes. 

 

Sitio 

Crítico 

No. 

Abscisas 

Factores de Seguridad (FOS) 

Condiciones Actuales Condiciones Modificadas 

Sin sismo 
Con sismo 

(0.2g) 
Sin sismo 

Con sismo 

(0.2g) 

1 4+250 - 4+400 1.024 0.795 1.739 1.085 

2 11+405 – 11+460 1.007 0.534 1.372 0.718 

3 23+180 – 23+240 1.013 0.754 1.674 1.130 

4 33+200 1.019 0.704 1.386 0.930 

5 43+380 1.021 0.555 1.395 0.748 

6 51+420 - 51+600 1.077 0.790 1.245 0.781 

7 0+800 - 1+000 (T2) 1.061 0.670 1.286 0.837 

8 12+800 (T2) 2.082 1.220 N.A. N.A. 
 (T2): Tramo 2 

 N.A.: No aplicable; Ver Numeral 4.1.2.7.8, literal f) 
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En los Anexo D-VIII se presentan los resultados de los análisis de estabilidad de taludes tanto en 

condiciones actuales como en condiciones modificadas. 

 

En el Anexo D-II se presentan planos con la ubicación en planta de las soluciones propuestas y esquemas. 

 

 

 

 

 

 

 

 

 

 

 

 

CAPÍTULO V 

CONCLUSIONES Y RECOMENDACIONES  

 

 

5.1 CONCLUSIONES 

 

5.1.1 INESTABILIDAD SECTOR GUZHO AUTOPISTA CUENCA – AZOGUES 

 

 El área de estudio se desarrolla la formación Turi, de edad Pleistocénica, conformada por la sucesión 

de estratos de tobas, conglomerados y en pequeña proporción de arcillas y areniscas.  

Geomorfológicamente el deslizamiento se desarrolla dentro de un relieve de montaña baja.   
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 El área se encuentra en una zona sísmicamente activa. 

 

 La principal fuente de recarga, que produce la saturación de los estratos indicados son las 

precipitaciones que ocurren con mayor frecuencia e intensidad en los meses de invierno. La 

infiltración  se ve favorecida por las rocas aflorantes en la parte superior del área de estudio que 

conducen el agua y recargan la zona baja. 

 

 Del reconocimiento hidrogeológico, se desprende que los terrenos aflorantes en la parte superior de 

la zona de estudio corresponde a una toba areno limosa de color café altamente diaclasada y 

meteorizada 

 

 La acequia ubicada en la parte superior del deslizamiento, no cumple con el fin propuesto,  ya que no 

permite la evacuación del agua lluvia, lo que ha ocasionado  estancamiento, favoreciendo la 

infiltración vertical lenta y continúa hacia estratos  aportando positivamente a la saturación de los 

suelos.      

 

 De las comprobaciones realizadas in situ, se concluye que 

en el la zona de estudio no se encuentra afloramientos de 

agua subterránea, (vertientes o manantiales), que indiquen 

la existencia de un de un acuífero.  

 

 El subsuelo del área afectada por el deslizamiento está conformado arcillas de baja plasticidad (CL), 

arcillas de alta plasticidad (CH), limos inorgánicos de alta compresibilidad (MH), limos inorgánicos 

de baja compresibilidad (ML), arenas limosas de plasticidad baja a nula (SM), cohesivos, con grumos 

de suelo densos, presencia de partículas de gravas dispersas y arena de grana medio a grueso. 

 

 En el sector de la trinchera T-1 se observa la presencia de un relleno mal conformado compuesto por 

suelos limosos y escombros de construcción.  Hacia el sector de la trinchera T-2 a 4 m de 
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profundidad se observa suelo limoso duro, muy competente, el cual actuó como protección ante el 

deslizamiento de la masa de suelo a la iglesia y a muy pocas edificaciones localizadas en al parte 

posterior del templo. 

 

 De acuerdo con los valores de “N” registrados en las pruebas SPT realizadas a diferentes 

profundidades así como con la toma de muestras se observa que tanto en el sondeo S-2 entre 7.8 m y 

9.5 m como en el sondeo S-3 entre 8.5 y 11 m de profundidad la presencia de un estrato de suelo 

limo arcilloso muy blando, saturado, el cual descansa sobre suelos mas competentes. Este estrato de 

suelo blando saturado forma una interfase entre los suelos blandos superficiales y las areniscas 

consolidadas densas inferiores y posiblemente constituyó el estrato sobre el cual se formó el plano de 

falla. 

 

 El análisis de estabilidad global indica que la masa de suelo superficial se desliza a través del estrato 

de suelos blandos saturados que forman el interfase entre el estrato superior y el estrato inferior de 

suelos competentes. 

 

 Los resultados obtenidos en el análisis de estabilidad global utilizando para el efecto tres perfiles del 

terreno indican que en las condiciones actuales la ladera es estable, sin tomar en cuenta los efectos de 

sismo, pues se obtuvieron valores de factor de seguridad mayores a 1.1.  

 

 Del análisis de estabilidad tomando en cuenta valores de aceleración de sismo del orden de 0.1g, 

0.15g y 0.2g, se concluye que la ladera es inestable, pues se obtuvieron valores de factor de seguridad 

menores a 1.  

 

 Las condiciones actuales del talud junto a la autopista no presentan signos de inestabilidad, pues, los 

resultados del análisis arrojan valores de factor de seguridad mayores a 1.5 

 

 La construcción de la autopista en este sector no afectó la estabilidad general de la ladera, pues, los 

valores de factor de seguridad obtenidos del análisis del modelo que asume que la vía tapó el drenaje 

natural de la ladera, son mayores a 1.5 
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 Según el análisis de movimiento del agua en el suelo se 

determinó que el caudal de agua que se mueve en su interior 

es de apenas 0.02 l/seg.  El mismo que convenientemente va 

a ser eliminado por el subdren que corre paralelo a la 

autopista. 

 

 De acuerdo a información proporcionada por la 

Subsecretaría del Azuay-MOP, se instaló un dren francés a 

lo largo del borde sur de la autopista en este sector.  Tanto 

las características (ie. con geotextil, tubería ranurada, etc.) 

como la extensión de esta estructura de drenaje no han 

podido ser verificados. 

 

 Observaciones directas de la autopista en las inmediaciones 

de Guzho indican que no existen daños en la carpeta 

asfáltica por exceso de humedad o saturación de la 

subbase. 

 
 

 

5.1.2 INESTABILIDAD SITIOS CRÍTICOS CARRETERA PLAN DE MILAGRO – INDANZA 

- GUALAQUIZA  
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 En general los deslizamientos se han producido en la capa expuesta y meteorizada, conformada por 

suelos de naturaleza limo arcilloso debido a la sobresaturación por acción de las precipitaciones 

durante el período de lluvias, el cual se extiende entre Abril y Julio. 

 

 De acuerdo con los resultados obtenidos en los diferentes análisis y corridas realizadas con el 

programa GSlope se observa que el deslizamiento de los suelos superficiales se produce a lo largo de 

una interfase entre este primer estrato conformado por suelos saturados y el segundo estrato 

conformado por lutitas medianamente sanas, la cual presenta mejores características mecánicas. 

 

 Las variaciones en el contenido de humedad de los suelos limo-arcillosos provoca cambios en sus 

propiedades índices y mecánicas ya sea por incremento en la presión de poros o debido a la pérdida 

de resistencia al esfuerzo cortante. Lo expuesto induce a que los suelos superficiales tiendan a 

deslizarse. 

 

 El origen de algunos de los problemas de inestabilidad se debe a la sobresaturación debido a la falta 

de control del agua por la ausencia de cunetas de coronación y elementos para control de drenaje 

superficial y subsuperficial de aguas lluvias. 

 

 Las medidas de corrección propuestas son las más económicas e idóneas para garantizar la 

estabilidad de las laderas. A pesar de esto, varias de las medidas correctivas no proveen de suficiente 

incremento en el factor de seguridad bajo condiciones dinámicas. Sin embargo, no se ha propuesto 

medidas correctivas que promuevan estabilidad bajo condiciones sísmicas debido a que estas 

medidas serían excesivamente costosas. 
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5.2 RECOMENDACIONES 

 

5.2.1 INESTABILIDAD SECTOR GUZHO AUTOPISTA CUENCA – AZOGUES 

 

 Realizar obras de reconformación del terreno alrededor de la pequeña laguna existente rellenando 

con movimientos de tierra de bajo volumen, a fin de eliminar los sitios de empozamiento y retención 

de agua superficial facilitando la evacuación de la escorrentía superficial. 

 

 Revegetación por medio de siembra de especies vegetales con raíces profundas a fin de que el exceso 

de agua sea absorbido del suelo e impedir la infiltración hacia los estratos de suelos arcillosos 

blandos.  

 

 Debido a que la ladera es inestable en caso de suscitarse un eventual movimiento 

sísmico se recomienda  la expropiación de viviendas existentes y evitar la 

reconstrucción y construcción de viviendas en la zona que sería afectada por un 

futuro deslizamiento.  

 

 Puesto que Guzho está en una zona activa sísmicamente y que sismos de baja 

intensidad causarían nuevos deslizamientos, se recomienda la expropiación de la 

zona y la creación de un parque para la ciudad.  Esto estaría en conjunto con la 

recomendación de revegetación expuesta anteriormente. 

 

 

 

5.2.2 INESTABILIDAD SITIOS CRÍTICOS CARRETERA PLAN DE MILAGRO – INDANZA 

- GUALAQUIZA  
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 En el sector se recomiendan cambios de la geometría del 

talud, incluyendo a media ladera una terraza de ancho cinco 

metros y tendiendo los taludes a inclinación 1.5 H :1V, que 

se va ha conseguir con la limpieza de los materiales sueltos. 

 

 Es necesario mejorar el drenaje superficial, para lo cual se 

recomienda la construcción de cunetas de coronación que 

bordeen el escarpe del deslizamiento y descarguen en las 

depresiones naturales adyacentes. 

 

 Para evitar la infiltración de las aguas superficiales se 

recomienda sellar las grietas y proteger la superficie del 

talud con vegetación del lugar. 
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FS.- Factor de seguridad. 

Cv.- Coeficiente de consolidación. 

Mr.- Sumatoria de momentos de las fuerzas resistentes. 

Ma.- Sumatoria de momentos de las fuerzas activas. 

Fr.- Sumatoria de fuerzas resistentes. 

Fa.- Sumatoria de fuerzas activas. 

FSadm.- Factor de seguridad admisible. 

c’.- Cohesión efectiva.  

’.- Ángulo de fricción efectivo.  

Su.- Resistencia no drenada. 

Lw.- Línea freática. 

Angulo del radio y la vertical en cada dovela. 

W.- Peso total de cada dovela. 

u.- Presión de poros en la base de cada dovela. 

w.- Peso específico del agua. 

wh .- Altura de la napa de agua o nivel freático (N.F). 

b.- Ancho de la Dovela. 

Pr.- Probabilidad de rotura. 

Kh, Kv.- Coeficientes símicos. 

Tallowable.- Tensión permisible. 

SUCS.- Sistema unificado de clasificación de suelos. 

SPT.- Ensayo de penetración estándar. 

IGM.- Instituto Geográfico Militar. 

 

 

 

 

 

 

 

LISTADO DE PLANOS 
 

 
 Topografía y localización de exploraciones geotécnicas del sector de Guzho. 

 Localización de sondeos y perfiles geotécnicos del sector de Guzho. 

 Perfil geotécnico del sector de Guzho. 

 Estabilización de sitios críticos de la carretera Plan de Milagro – Indanza – Gualaquiza. 

 Detalles típicos de los sitios de estabilización de la carretera Plan de Milagro – Indanza – Gualaquiza. 
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